
 
Introduction 

Thank you very much for selecting the Bluetooth Utility.  
This Help facility will show you how to use the Bluetooth Utility for configuring 
Bluetooth devices and how it can be used in other convenient ways.  
We hope that the Help facility will enable you to be able to make full use of the 
Bluetooth Utility. 

• What is Bluetooth? 
• What you need to know about using Bluetooth 
• Varieties of Bluetooth devices you can use 
• Contents of the Bluetooth Utility  
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 What is Bluetooth? 
Bluetooth is a global standard telecommunications method that enables data to be 
exchanged wirelessly between personal computers, peripheral components, mobile 
telephones and other electronic devices.  
Data can be readily exchanged between Bluetooth devices if they have been 
registered as components able to communicate with each other.  

 



A maximum of seven Bluetooth devices may be connected together. By using 
Bluetooth to connect to a mouse, keyboard, modem, printer, or other device, you can 
do away with messy cabling and not have to be concerned about space restrictions, 
which will allow you to work more comfortably.  
 
 

 
 

 

 
What you need to know about using 
Bluetooth 

Bluetooth exchanges data using radio waves.  
The following points are critical in order to configure and use Bluetooth devices 
correctly.  

• The devices must be Bluetooth-compatible 
• The Bluetooth devices must be close enough to be able to 

communicate 
• The devices must be in a connectable state 
• No other radio wave-emitting devices should be operated nearby 
• The Bluetooth devices must be turned on 

 The devices must be Bluetooth-compatible 
The hardware and software used in your PC and other components must be 
Bluetooth-compatible.  
Bluetooth-compatible products normally bear the following logo:  
 
 

 
 
 
For further details, please refer to your local retailer or consult the product 
instruction manual.  

 Note 

• A Bluetooth communication card, adapter, or other similar device (not 
included) needs to be installed in PCs or PDAs (personal digital 
assistants) that do not have Bluetooth built in. 

 The Bluetooth devices must be close enough to be able to communicate 
Bluetooth devices situated in places beyond the reach of the radio waves will not 
recognize each other, making communication impossible.  
In particular, please ensure that your Bluetooth devices can communicate with each 
other before you register and configure them for the first time.  



 

 Note 

• PCs have a communication distance restriction of ten meters. Please 
refer to the instruction manuals for information on the 
communication distance restrictions specific to each device. 

• Communication interference may occur if any obstructions are located 
between the devices. Devices may not communicate properly if they 
have been located, for example, on the ground and first floors of a 
residence, despite their being within the acceptable distance.  

 The devices must be in a connectable 
state 

The Bluetooth devices must recognize each other in order to be connectable for use.  
In certain devices, simply turning on the power will not produce a connectable state. 
Moreover, the energy-saving feature may come into effect after a certain amount of 
time, which will prevent the devices from being detected. Please refer to the specific 
product instruction manual for further details.  

 No other radio wave-emitting devices should be operated 
nearby 

Microwave ovens, wireless LANs and other radio wave-emitting devices located 
nearby may affect Bluetooth communication.  
Please ensure that your devices have been accordingly situated, and that the above 
devices are not in use when you are operating your Bluetooth device. 

 The Bluetooth devices must be turned 
on 

Bluetooth cannot be used if the devices have not been turned on.  
Some PCs and other components have a Bluetooth communication switch that 
operates independently of the main power. Bluetooth cannot function if this switch 
has been turned off.  

• Using PCs with Bluetooth built in   
• When using a Bluetooth USB adapter or SD card 

 
 

 
 

 

 Varieties of Bluetooth devices you can use 



It is important to understand the concepts of "services" and "profiles" in order to 
determine whether an intended function can be properly utilized when you use a 
Bluetooth device.  

 What is a 
"profile"? 

Examples of Bluetooth devices include mice and keyboards (input devices), printers 
(output devices) and wireless modems (communication devices). Functions that can 
be utilized by such devices are called "services."  
In order for these services to be used reliably, Bluetooth devices are provided with 
common specifications known as "profiles."  
For example, when a PC makes a connection to a Bluetooth device, it obtains the 
profile of the corresponding device and thereby ascertains which functions (services) 
the device offers.  
As an example, imagine someone who travels overseas.  
The traveller is only able to converse properly with their counterpart if both speak a 
language (English, Japanese, Chinese, etc.) they both understand. 

 
However, no dialogue will occur if they do not share a common language. 

 
In the above example, the traveller and his/her counterpart correspond to the devices, 
the languages to the profiles, and the dialogues between the two people to the 
services. The former example refers to a situation where a service can be performed 
because the devices support a common profile, whereas the latter example refers to a 
situation where a service cannot be performed because a common profile is not 
supported.  
In other words, you will be able to use Bluetooth devices that have a profile 
supported by a PC (the Bluetooth Utility in this case).  



If the profiles belonging to the device are not supported by the PC, the functions 
corresponding to those profiles will not be able to be utilized. Also, a device can 
only be used if its profiles are supported by the PC.  

 Types of 
profiles 

The following profiles are supported by the Bluetooth Utility:  

Term Definition 

DUN 
Dial-Up Networking  
Enables you to establish a dial-up Bluetooth connection to the 
Internet or other networks with a wireless modem station, mobile 
telephone, or similar device. 

FAX 
FAX  
Enables you to establish a Bluetooth connection with a wireless 
modem station, mobile telephone, or similar device to send or 
receive a fax.  

LAP 
LAN Access Profile  
Enables you to establish a Bluetooth connection with a LAN 
access point to access the services of a LAN using PPP. 

SPP 

Serial Port Profile  
Enables communication with a device through a virtual serial port 
configured for a Bluetooth connection. This can be used for 
printers and printer adapters with PDAs, using a different method 
from HCRP or ActiveSync. 

HID 
Human Interface Device Profile  
Allows connections to wireless mice, keyboards and other input 
devices. 

HCRP Hardcopy Cable Replacement Profile  
Enables printing with a printer driver. 

FTP 
File Transfer Profile  
Enables you to browse folders on a wireless device and transfer 
files to and from the local device. 

OPP Object Push Profile  
Allows business card data to be exchanged with a wireless device. 

A2DP 
Advanced Audio Distribution Profile  
Allows audio data to be exchanged between wireless headsets and 
other audio devices, as well as allowing high-quality music 
playback. 

AVRCP 
Audio/Video Remote Control Profile  
A/V remote control functions such as play and stop. The 
Bluetooth Utility supports remote control operation. 

GAVDP Generic Audio/Video Distribution Profile  
Basic profile used to support A2DP, AVRCP and other protocols. 

HSP 
Head Set Profile  
Profile used for headsets.  
Allows you to connect to a PC and communicate as well as 
connect to a mobile telephone. 



PAN 
Personal Area Networking Profile  
Supports IP base network. Allows connection to an ad-hoc or 
wired network via an access point. 

BIP 

Basic Imaging Profile  
Allows image files to be sent and received after having been 
converted to a size suitable for the destination. In addition to 
being able to transfer image files, the Bluetooth Utility allows 
camera shutters to be operated by remote control, as well as other 
offering other functionalities. 

 
 

 
 
 

 

 Contents of the Bluetooth Utility 
The Bluetooth Utility is a software tool used to configure a variety of settings once a 
connection has been established between the PC and the Bluetooth device. It also 
facilitates the exchange of files between Bluetooth devices. 
The Bluetooth Utility comprises the following six tools. Descriptions are provided 
for the functions and the supported profiles for the respective tools.  

• Bluetooth Settings 
• Bluetooth Manager 
• Bluetooth Information Exchanger 
• Remote Camera 
• Bluetooth Local COM 
• Wireless File Transfer 

 Bluetooth Settings 
This program enables you to easily configure settings when you connect to a 
Bluetooth device for the first time. The function of a configured and registered 
device is displayed on the main window as a connection icon.  
As a rule, the Bluetooth device will be connected automatically after having been set 
up; however, a shortcut can be created for a manual connection, if so required.  



 

 Bluetooth Manager 
This program, which appears as a Taskbar icon, monitors and controls the power 
and operating status of Bluetooth devices. It can be used to start the Bluetooth Setup 
Utility, add a new connection, disconnect from a remote device, and perform other 
tasks. 

 
 Bluetooth Information 

Exchanger 
This program enables you to easily transfer files and images to or exchange business 
card data with a wireless device by selecting the icon of the counterpart device, or 
using the right-click menu in Explorer. The wireless devices to which you are 
connecting must also support the same service functions (FTP and OPP).  



 
Related topics  
"Exchanging files with PCs and PDAs"  
"Sending images to mobile telephones"  
"Sending images to PCs or PDAs"  
"Exchanging business card data with PCs and PDAs" 

 Remote Camera 
Connecting to a Bluetooth-compatible digital camera allows the device to be 
operated from the PC side, and captured images to be sent to the PC. 

 
Related topics  
"Using a Bluetooth-compatible camera" 

 Bluetooth Local COM 

This program, which is registered in the Control Panel, can create a virtual COM 
port for use with the Bluetooth Utility. If you need to create a client COM port with 



the Bluetooth Setup Utility, it can be created automatically without having to start 
the program. 

 
 
 
 
 
 

 
Related topics  
"Manually creating a virtual Bluetooth COM port"  

 Wireless File Transfer 

You can send a file wirelessly to another device by right-clicking on the intended 
file and using the "Sending to Bluetooth Device" menu that appears.  
 



 

 
Related topics  
"Exchanging files with PCs and PDAs" 
  
 
 

 
Using the Bluetooth Utility 
Actual examples of how to establish a connection to a Bluetooth device using the 
Bluetooth Utility are described in this section.  
 
 
Descriptions of more convenient methods and detailed information on the Bluetooth 
Utility functions are also provided. 

• Flow of operation 
• Basic settings 
• Making the most of your Bluetooth device 
• Using the features more effectively  
• Bluetooth Utility functions in detail 

 Note 



• The Bluetooth Utility operates under Windows XP and Windows 
2000.  
The descriptions in the examples mainly pertain to operation under 
Windows XP.  
 
 
Windows XP: Microsoft® Windows® XP Operating System  
Windows 2000: Microsoft® Windows® 2000 Operating System  

  
 
 

 
 

 

 Flow of operation 
The procedure below is used to set up Bluetooth devices using the Bluetooth Utility.  

 Note 

• It is assumed that the set-up is performed from the [Bluetooth Settings] 
window. 



      
 

 
: Enter Bluetooth passkey (PIN code), if required by the 

device. 

  : During these stages of the set-up process, the Bluetooth 
device must be set to Connectability mode. 

   * Simply turning the power on will activate Connectability 
mode in certain devices. Please refer to the device instruction 
manual for further details. 

  
 
 

 
 

 



 
Basic 
settings 

Methods for registering new devices using the Bluetooth Utility shall now be 
described.  
A Bluetooth mouse shall be connected and set up using [Bluetooth Settings] as an 
example. 
[Bluetooth Settings] provides two set-up methods: "Express Mode" and "Custom 
Mode." 

• Express Mode  
[Bluetooth Settings] will automatically detect and register services. If 
several services (profiles) are supported by the device, the service 
that has been set to the highest priority shall be selected and 
registered.  
Express Mode is normally recommended for device set-up. 

• Custom Mode  
After having been detected, the services supported by the device are 
displayed as a list, from which you can select the desired function(s).  
Custom Mode must be used to set up a device if, for example, you 
wish to use a modem station to send a fax (because in Express Mode, 
the DUN profile will be automatically selected since it has a higher 
priority than the FAX profile). 

The differences between setting up the same device (a Bluetooth mouse) using 
Express Mode and Custom Mode are described on the following pages. 

• Express Mode Set-up 
• Custom Mode Set-up 

 
 

 
 

 

 Express Mode Set-up 
The procedure for setting up the device using Express Mode shall now be described. 

 
 Starting Bluetooth 
Settings 

    
 
 



 Procedure 
1. Click [Start]->[All Programs]->[Bluetooth]->[Bluetooth Settings].  

(Under Windows 2000, click [Start]->[Programs]->[Bluetooth]-
>[Bluetooth Settings].)  

 Note 

o The same result can be achieved by right-clicking on 
the Bluetooth icon in the task tray and selecting 
[Bluetooth Settings] from the menu that appears.  
 
 

 
The [Bluetooth Settings] window below will appear when other devices have 
already been registered.  
 
 

 
 
 
Please click the [New Connection] button to open the [Add New Connection 
Wizard] window. If no devices have been registered yet, please proceed 
directly to "Detecting Bluetooth Devices."  

(continued in "Detecting Bluetooth Devices"...)  



 
 

 
 
 

 
 Detecting Bluetooth 
devices 

 

 
 
 
 
 

 Procedure 
 
(...continued from previous step)  
The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
window will appear. 

1. Switch the mouse power ON to make it connectable via Bluetooth.  
Please refer to the mouse instruction manual for details on this 
procedure. 

2. Confirm that [Express Mode] has been selected in the [Add New 
Connection Wizard (Welcome to the Add New Connection 
Wizard)] window, and click on the [Next] button.  
 
 



 
 
 
Searching for Bluetooth devices will start.  
 
 

 
 
 
When the mouse has been detected, the name and address of the 
device will appear in the [Add New Connection Wizard (Select 
Device)] window.  
 



 

 

 Note 
o If no device is found, please confirm that the device has been 

made connectable via Bluetooth, and click on the [Update] button.  
A further device search will be performed. 

 
 
 
 
( continued in [Detecting Services]...)  

 
 

 
 

 
 Detecting services 

 

 
 
 
 
 



 
 

 Procedure 
  
(...continued from previous step)  
When the mouse has been detected, the name and address of the device will appear 
in the [Add New Connection Wizard (Select Device)] window. 

1. Select the mouse device name from [Device List] and click on the 
[Next] button.  
 
 

 
 
 
Bluetooth device detection will commence.  
 



 

 

 Note 

o If several services (profiles) are supported by the 
device, the service that has been set to the highest 
priority shall be automatically selected and set up in 
Express Mode.  
Please use Custom Mode if you wish to select desired 
services manually.  

o When a service has been detected, a window 
prompting you to enter the Bluetooth passkey (PIN 
code) may appear. Please enter the passkey and click 
on the [OK] button.  
Please refer to your device instruction manual for 
information on which passkey to use.  
 
 

 
o If you have not entered your Bluetooth passkey after a 

certain amount of time has passed, the connection 
process will be cancelled for security reasons. Please 
perform the passkey entry process again. 

A message will appear prompting you to prepare the device for connection. 



2. Click on the [OK] button  
 
 

 

 Note 

o When the settings information has been registered, a 
window prompting you to enter your Bluetooth 
passkey (PIN code) may appear. Please enter your 
passkey and click on the [OK] button.  
Please refer to your device instruction manual for 
information on which passkey to use.  
 
 

 
o If you have not entered your Bluetooth passkey after a 

certain amount of time has passed, the connection 
process will be cancelled for security reasons. Please 
perform the passkey entry process again. 

The [Add New Connection Wizard (Connection Name Setup)] window will 
appear if a service has been properly detected.  

3. Select the type and name of the icon to be displayed once the 
device has been registered, and click on the [Next] button.  
 



 

 

 Note 

o If you wish to change the icon, please click on the 
[Change Icon] button and select your preferred icon 
from the list that appears.  
 
 

 
( continued in [Registering Settings Information]...)  

 
 
 

 
 

 



 
Registering settings 
information 

 

 
 
 
 
 
 
 

 Procedure 
 
(...continued from previous step)  
The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
window will appear.  

1. Click on the [Finish] button  
 
 

 
 
 
The [Bluetooth Settings] window will appear.  
The icons of the registered devices will appear, and the devices will 
be ready to use.  
 



 

 

 Note 

• The connection icons and icon names can be changed.  
Changing a connection icon name  
Changing a connection icon 

 
 
 
 

 
 

 

 Custom Mode Set-up 
The procedure for setting up the device using Custom Mode shall now be described. 

 
 Starting Bluetooth 
Settings 

    
 
 

 Procedure 



1. Click [Start]->[All Programs]->[Bluetooth]->[Bluetooth Settings].  
(Under Windows 2000, click [Start] -> [Programs] -> [Bluetooth] -> 
[Bluetooth Settings]. 

 Note 

o The same result can be achieved by right-clicking on 
the Bluetooth icon in the task tray and selecting 
[Bluetooth Settings] from the menu that appears.  
 
 

 
The [Bluetooth Settings] window below will appear when other devices have 
already been registered.  
 
 

 
 
 
Please click the [New Connection] button to open the [Add New Connection 
Wizard] window. If no devices have been registered yet, please proceed 
directly to "Detecting Bluetooth Devices".  

(continued in "Detecting Bluetooth Devices"...)  
  



 
 

 
 

 
 Detecting Bluetooth 
devices 

 

 
 
 
 
 

 Procedure 
 
(...continued from previous step)  
The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
window will appear.  

1. Switch the mouse power ON to make it connectable via Bluetooth.  
Please refer to the mouse instruction manual for details on this 
procedure. 

2. Confirm that [Custom Mode] has been selected in the [Add New 
Connection Wizard (Welcome to the Add New Connection 
Wizard)] window, and click on the [Next] button.  
 
 



 
 
 
Searching for Bluetooth devices will start.  
 
 

 
 
 
When the mouse has been detected, the name and address of the 
device will appear in the [Add New Connection Wizard (Select 
Device)] window.  
 



 

 

 Note 
o If no device is found, please confirm that the device has been 

made connectable via Bluetooth, and click on the [Update] button.  
A further device search will be performed. 

 
 
 
 
( continued in [Detecting Services]...)  
  

 
 

 
 
 

 
 Detecting services 

 

 
 
 
 



 
 
 

 Procedure 
(...continued from previous step)  
When the mouse has been detected, the name and address of the device will appear 
in the [Add New Connection Wizard (Select Device)] window. 

1. Select the mouse device name from [Device List] and click on the 
[Next] button  
 
 

 
 
 
Bluetooth device detection will commence.  
 



 

 

 Note 

o When a service has been detected, a window 
prompting you to enter the Bluetooth passkey (PIN 
code) may appear. Please enter the passkey and click 
on the [OK] button.  
Please refer to your device instruction manual for 
information on which passkey to use.  
   

 
o If you have not entered your Bluetooth passkey after a 

certain amount of time has passed, the connection 
process will be cancelled for security reasons. Please 
perform the passkey entry process again. 

o If you try to register a device that has already been 
registered, the following message will appear, and you 
will not be able to proceed with further operation.  
Please click on the [OK] button to close the message.  
 



 

 
The services supported by the device will be displayed. 

2. Select the desired service and click on the [Next] button  
 
 

 

 Note 

o When a device supports several services  
If the device supports several services, you can use 
Custom Mode to manually select the services (profiles) 
you wish to use from the list that appears under 
[Select Services].  
 
 
Example: List of wireless modem station services  
 

  
 
 
If Express Mode is used to perform the set-up, the 



highest-priority service in the device will be 
automatically selected and configured.  

3. Click on the [OK] button.  

 

 Note 

o When the settings information has been registered, a 
window prompting you to enter the Bluetooth passkey 
(PIN code) may appear. Please enter the passkey and 
click on the [OK] button.  
Please refer to your device instruction manual for 
information on which passkey to use.  
 
 

 
o If you have not entered your Bluetooth passkey after a 

certain amount of time has passed, the connection 
process will be cancelled for security reasons. Please 
perform the passkey entry process again. 

The [Add New Connection Wizard (Connection Name Setup)] window will 
appear if a service has been properly detected. 

4. Select the type and name of the icon to be displayed once the 
device has been registered, and click on the [Next] button.  
 



 

 

 Note 

o If you wish to change the icon, please click on the 
[Change Icon] button and select your preferred icon 
from the list that appears.  
 
 

 
( continued in [Registering Settings Information]...) 

 
 
 

 
 

 



 Registering settings 
information 

 

 
 
 
 
 
 
 

 Procedure 
 
(...continued from previous step)  
The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
window will appear.  

1. Click on the [Finish] button  
 
 

 
 
 
The [Bluetooth Settings] window will appear.  
The icons of the registered devices will appear, and the devices will 
be ready to use.  
 



 

 

 Note 

o The connection icons and icon names can be changed.  
Changing a connection icon name  
Changing a connection icon 

 
 

 
 

 

 Connecting to the Internet using a modem station [DUN] 
You can use a Bluetooth wireless modem to connect to the Internet via a telephone 
line.  

 
 

 
Setting up the modem station  
Connecting to the Internet  

 Important 
• In order to connect to the Internet, you must have already signed up 

with a provider and obtained a connection ID and password. Please 



ensure you have confirmed the ID, password and telephone number 
of your provider's access point before you begin the set-up process. 

• Please refer to your instruction manual for information on connecting 
the modem station to a telephone line.  

• A Bluetooth passkey (PIN code) is required for you to connect to the 
modem station. Please make a note of your Bluetooth passkey before 
you start the set-up process. 

 Setting up the modem station 
 

 Procedure 
1. Turn on the wireless modem station 

2. Right-click the Bluetooth icon in the task tray, and then click on 
[Add New Connection]  
 
 

 

 Note 

o Alternatively, click [Start] -> [All Programs] -> 
[Bluetooth] -> [Bluetooth Settings], and then click on 
[New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] window will appear.  

3. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  
 
 

 
4. Select the device name of the wireless modem station from [Device 

List], and then click on the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 

 
 
 
Once a service has been detected successfully, connection to the 
device and COM port creation will be performed automatically, after 
which the [Add New Connection Wizard (Modem Settings)] window 
will appear.  

5. If you are connecting to a wireless modem station for the first 
time, enter the passkey for the modem station under [Bluetooth 
Passkey (PIN code)], and then click on the [OK] button  
 



 

 
 
 
Once the program has finished searching for the devices, the [Add 
New Connection Wizard (Device Selection)] window will appear. 

6. Click on the [Next] button  
 
 

 
 
 
Certain modems require you to configure initialization commands 
separately.  
Please click on the [Additional initialization Command Settings] 
button, enter the initialization commands in the following window, 
and then click on the [OK] button.  
 



 

 

 Note 

o Please refer to the modem or mobile phone instruction 
manual for further details on the initialization 
commands. 

7. Enter the connection name (optional), telephone number (of your 
provider's access point), user name and password (as issued by 
your provider), and then click on the [Finish] button.  
 
 

 
 Important 

o The sample entries shown in the window are provided 
solely for purpose of explanation. Please use your own 
telephone number, ID and password according to the 
arrangement with your provider. 



 
 
The settings will be registered, and an icon will appear in the [Bluetooth 
Settings] window.  
 
 

 
 Connecting to the Internet 

You can connect to the Internet by following the procedure below if the connection 
destination registered when you configured the wireless modem has been set as the 
default connection destination.  

1. Start your browser, e-mail application or other application  

 Important 
o Please enter the e-mail settings separately if you are 

going to use e-mail (the set-up method will vary with 
the application). 

2. Enter the URL of the Web page you wish to display and then 
press the [Enter] key, or use the e-mail tool to send/receive items 
or perform other activities.  
 
 
The [Dial-up Connection] window will appear. 

3. Click on the [Connect] button  
 
 

 

 Important 
o A connection will be automatically established with the 

modem station if COM Auto Connect is available. If 



COM Auto Connect is not available, please manually 
connect to the modem station. 

The following message will appear once you have connected to the Internet.  
 
 

 

4. End the connection  
The window below will appear if you double-click on the icon in 
the task bar.  
 
 

 
 
 
Please click on the [Disconnect] button when you want to disconnect 
from the Internet.  
Alternatively, please right-click on the icon, and then click on 
[Disconnect].  
 
 

 

 Note 

• You can start an application to make an automatic connection to the 
Internet, but you can also make a manual connection using the 
connection destination icon.  
The procedure is described below. 



1. From the [Bluetooth Settings] window, right-click on the 
connection destination icon, and then click on [Connect] from the 
menu that appears  
 
 

 
 
 
A window indicating that the connection is being established will 
appear.  
 
 

 
 
 
If the connection has been established successfully, the connection 
icon and task tray will appear as shown below.  
 
 



      
 
 
You will be able to browse Web pages using your browser and send 
and receive e-mail.   

 Important 
o Please enter the e-mail settings separately if you are 

going to use e-mail (the set-up method will vary with 
the application). 

2. End the connection  
Right-click on the icon, and then click [Disconnect] to end the 
connection.  
 
 

 
 
 
The following message will appear. Click on the [Yes] button.  
 
 

 
 
 
When the icon appears as shown below, the connection will have 
ended.  
 



 

 
 
 

 
 

 

 
Connecting to the Internet using a mobile telephone 
[DUN] 

This section describes how to connect to the Internet via a telephone line, using a 
mobile telephone.   

 
 

 
Configuring a mobile telephone for use as a modem  
Connecting to the Internet  

 Important 
• In order to connect to the Internet, you must have already signed up 

with a provider and obtained a connection ID and password. Please 
ensure you have confirmed the ID, password and telephone number 
of your provider's access point before you begin the set-up process. 

• A Bluetooth passkey (PIN code) is required for you to connect to the 
mobile telephone. Please make a note of your Bluetooth passkey 
before you start the set-up process. 

 Configuring a mobile telephone for use as a 
modem 

 

 Procedure 
1. Turn on the mobile telephone, and set it to be connectable via 

Bluetooth 

 Note 

o Please refer to the mobile telephone instruction manual 
for information on how to operate the device. 

 



2. Right-click on the Bluetooth icon in the task tray, and then click 
on [Add New Connection]  
 
 

 

 Note 

o Alternatively, click [Start] -> [All Programs] -> 
[Bluetooth] -> [Bluetooth Settings], and then click on 
[New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] window will appear. 

3. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  
 



 

 

4. Select the device name of the mobile telephone from [Device List], 
and then click on the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 



 
 
 
Once a service has been detected successfully, connection to the 
device and COM port creation will be performed automatically, after 
which the [Add New Connection Wizard (Modem Settings)] window 
will appear.  

5. If you are connecting to a mobile telephone for the first time, 
enter the passkey for the wireless modem station under 
[Bluetooth Passkey (PIN code)], and then click on the [OK] 
button  
 
 

 
 
 
Once the program has finished searching for the devices, the [Add 
New Connection Wizard (Device Selection)] window will appear. 

6. Click on the [Next] button  
 
 



 
 
 
Certain modems require you to configure initialization commands 
separately.  
Please click on the [Additional Initialization Command Settings] 
button, enter the initialization commands in the following window, 
and then click on the [OK] button.  
 
 

 

 Note 

o Please refer to the modem or mobile phone instruction 
manual for further details on the initialization 
commands. 

7. Enter the connection name (optional), telephone number (of your 
provider's access point), user name and password (as issued by 
your provider), and then click on the [Finish] button.  
 



 

 

 Important 
o The sample entries shown in the window are provided 

solely for purpose of explanation. Please use your own 
telephone number, ID and password according to the 
arrangement with your provider. 

 
 
The settings will be registered, and an icon will appear in the [Bluetooth 
Settings] window.  
 
 

 
 Connecting to the Internet 

You can connect to the Internet by following the procedure below if the connection 
destination registered when you configured the mobile telephone has been set as the 
default connection destination.  

1. Start your browser, e-mail application or other application  

 Important 
o Please enter the e-mail settings separately if you are 

going to use e-mail (the set-up method will vary with 
the application). 

2. Enter the URL of the Web page you wish to display and then 
press the [Enter] key, or use the e-mail tool to send/receive items 
or perform other activities.  
 



 
The [Dial-up Connection] window will appear. 

3. Click on the [Connect] button  
 
 

 
 Important 

o A connection will be automatically established with the 
mobile telephone if COM Auto Connect is available. 
If COM Auto Connect is not available, please 
manually connect to the mobile telephone. 

The following message will appear once you have connected to the Internet.  
 
 

 

4. End the connection  
The window below will appear if you double-click on the icon in 
the task bar.  
 
 



 
 
 
Please click on the [Disconnect] button when you want to disconnect 
from the Internet.  
Alternatively, please right-click on the icon, and then click on 
[Disconnect].  
 
 

 

 Note 

• You can start an application to make an automatic connection to the 
Internet, but you can also make a manual connection using the 
connection destination icon.  
The procedure is described below. 

1. From the [Bluetooth Settings] window, right-click on the 
connection destination icon, and then click on [Connect] from the 
menu that appears  
 
 



 
 
 
A window indicating that the connection is being established will 
appear.  
 
 

 
 
 
If the connection has been established successfully, the connection 
icon and task tray will appear as shown below.  
 
 

      
 



 
You will be able to browse Web pages using your browser and send 
and receive e-mail.  

 Important 
o Please enter the e-mail settings separately if you are 

going to use e-mail (the set-up method will vary with 
the application). 

2. End the connection  
Right-click on the icon, and then click [Disconnect] to end a 
connection.  
 
 

 
 
 
The following message will appear. Click on the [Yes] button.  
 
 

 
 
 
When the icon appears as shown below, the connection will have 
been ended.  
 
 

 



 
 

 
 

 

 
Connecting to a LAN using an access point (LAP) 
[LAP] 

This section describes how to connect to a network (for example, a company LAN 
or a personal home network) using a LAP profile-compatible access point.  
Please refer to "Using an access point (PAN) to connect to a LAN if you are using a 
PAN profile-compatible access point. 

 
 

 
 
 
Setting up the access point  
Connecting to a LAN (LAP)  

 Important 
• The access point must have been started and a normal connection 

already established to the network before the access point is set up. 
Please refer to the access point instruction manual for information on 
how to set up the access point. 

• A Bluetooth passkey (PIN code) is required for you to connect to the 
access point. Please make a note of your Bluetooth passkey before 
you start the set-up process. 

 Setting up the access point 
 

 Procedure 
1. Turn on the access point, and confirm that a connection has been 

established with the network  

2. Right-click the Bluetooth icon in the task tray, and then click on 
[Add New Connection]  
 



 

 

 Note 

o Alternatively, click [Start] -> [All Programs] -> 
[Bluetooth] -> [Bluetooth Settings], and then click on 
[New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
window will appear.  

3. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 

 
The [Add New Connection Wizard (Searching for Bluetooth devices)] window will 
appear. 



 
 
 
Once the program has finished searching for the devices, the [Add New Connection 
Wizard (Device Selection)] window will appear.   

4. Select the device name of the access point from [Device List], and 
then click on the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 



 
 
 
You will be asked for the Bluetooth passkey in the window that 
appears. 

5. Enter the passkey under [Bluetooth Passkey (PIN code)], and then 
click on the [OK] button  
 
 

 
 
 
Service detection and COM port creation will be performed 
automatically.  
The [Add New Connection Wizard (Create Connection Destination)] 
window will appear. 

6. Enter the connection name, user name and password, then click 
on the [Next] button  
 



 

 

 Note 

o The user name and password are entered here to allow 
you to connect to the access point. 

The [Add New Connection Wizard (Confirm Dial-up Settings)] window will 
appear.  

7. Click on the [Confirm Settings] button  
 
 

 
 
 
 
 
The [Internet Options] window will appear. 



8. Configure the connection method, and then click on the [OK] 
button  
Set the connection destination used for the LAN connection set up in 
(6) above as the default connection destination, and then select 
"Always dial my default connection."  
 
 

 

9. Click on the [Next] button  
 
 

 
 
 



The [Add New Connection Wizard (Connection Name Settings)] 
window will appear.  

10. Enter the type and name of the icon displayed after 
registration, and then click on the [Next] button  
Please click on the [Next] button if you are satisfied with the settings.  
 
 

 
 
 
The [Add New Connection Wizard (Completing the Add New 
Connection Wizard)] window will appear. 

11. Click on the [Finish] button  
 
 
The access point icon will be registered in the [Bluetooth Settings] 
window.  
 
 

 
  
This will complete the access point set-up process.  
 
 
"Connecting to a LAN (LAP)"  
 
 

 
 



 

 
Connecting to a LAN 
(LAP) 

 

 Procedure 
1. Right-click on the connection icon in the [Bluetooth Settings] 

window, and then click on [Connect]  
 
 

 
 
 
The [Dial-up Connection] window will appear. 

2. Confirm that "Direct connection" has been selected under 
[Connection Destination], and then click on the [Connect] button  
 
 

 



 
 
A connection will be initiated.  

 Note 

o This is an example of what happens when you use 
"Direct connection" as a connection name under 
"Connect to access point." If a name different from the 
connection name is used, that name will appear under 
[Connection Destination].  

o Please simply click on [Settings] if no user name or 
password have been entered (i.e., if those fields have 
been left blank) 

o Please change the connection destination if a different 
connection name (for a dial-up connection) appears in 
[Connection Destination].  
 
 

 
 
 
Related topic "Changing the default connection 
destination" 

Once you connect to the network, Internet Explorer will start automatically, 
and you will be able to exchange data with other computers on the network. 

 Note 

o Please follow the procedure below if you need to set up 
a proxy server to connect to the Internet (the following 
procedure is not necessary if the PC you are going to 
use has already been set up as a proxy server).  
 
 
1 Select [Internet Options...] from the [Tools] menu 
in Internet Explorer  
 
 
The [Internet Options] window will appear.  
 
 
2 Click on the [Connections] tab, and then click on 
the [Settings...] button  
 
 



  
 
 
3 Enter the IP address and port number of the 
proxy server under [Proxy Server], and then click 
on the [OK] button  
 
 

  
3. End the connection  

Right-click either on the connection icon under the [Bluetooth 
Settings] window or on the icon in the task tray, and then click on 



[Disconnect].  
 
 

 
 
 
Click on the "Yes" button in the disconnection confirmation dialog 
box that appears.  

 
 

 
 
 

 

 
Connecting to a LAN using an access point (PAN) 
[PAN] 

This section describes how to connect to a network (for example, a company LAN 
or a personal home network) using a PAN profile-compatible access point.  
Please refer to "Using an access point (LAP) to connect to a LAN" if you are using a 
LAP profile-compatible access point. 

 
 

 
 
 
Setting up the access point  
Connecting to a LAN (PAN)  

 Important 
• The access point must be started and a normal connection already 

established to the network before the access point is set up. Please 
refer to the access point instruction manual for information on how to 
set up the access point. 

• A Bluetooth passkey (PIN code) is required for you to connect to the 
access point. Please make a note of your Bluetooth passkey before 
you start the set-up process. 



 Setting up the access point 
 

 Procedure 
1. Turn on the access point, and confirm that a connection has been 

established with the network 

2. Right-click the Bluetooth icon in the task tray, and then click on 
[Add New Connection]  
 
 

 

 Note 

o Alternatively, click [Start] -> [All Programs] -> 
[Bluetooth] -> [Bluetooth Settings], and then click on 
[New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
window will appear.  

3. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 



 

 
The [Add New Connection Wizard (Searching for Bluetooth devices)] window will 
appear. 

 
 
 
Once the program has finished searching for the devices, the [Add New Connection 
Wizard (Device Selection)] window will appear.  

4. Select the device name of the access point from [Device List], and 
then click on the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 

 
 
 
You will be asked for the Bluetooth passkey in the window that 
appears. 

5. Enter the passkey under [Bluetooth Passkey (PIN code)], and then 
click on the [OK] button  
 
 



 
 
 
Service detection and COM port creation will be performed 
automatically.  
The [Add New Connection Wizard (Connection Name Settings)] 
window will appear.  

6. Enter the type and name of the icon displayed after registration, 
and then click on the [Next] button  
Please click on the [Next] button if you are satisfied with the settings.  
 
 

 
 
 
The [Add New Connection Wizard (Completing the Add New 
Connection Wizard)] window will appear. 

7. Click on the [Finish] button  
 
 
The access point icon will be registered in the [Bluetooth Settings] 
window.  
 



 

 
  
This will complete the access point set-up process.  
 
 
"Connecting to a LAN (PAN)"  
 
 

 
 

 

 Connecting to a LAN (PAN) 
 

 Procedure 
1. Right-click on the connection icon in the [Bluetooth Settings] 

window, and then click on [Connect]  
 
 

 
 
 
You will be asked for the Bluetooth passkey in the window that 
appears. 

2. Enter the passkey under [Bluetooth Passkey (PIN code)], and then 
click on the [OK] button  
 
 



 
 
 
A connection will be initiated.  

Once you have connected to the network, Internet Explorer will start 
automatically, and you will be able to exchange data with other computers 
on the network. 

 Note 

o Please follow the procedure below if you need to set up 
a proxy server to connect to the Internet (the following 
procedure is not necessary if the PC you are going to 
use has already been set up as a proxy server).  
 
 
1 Select [Internet Options...] from the [Tools] menu 
in Internet Explorer  
 
 
The [Internet Options] window will appear.  
 
 
2 Click on the [Connections] tab, and then click on 
the [LAN Settings...] button  
 
 



  
 
 
3 Enter the IP address and port number of the 
proxy server under [Proxy Server], and then click 
on the [OK] button  
 
 

  
3. End the connection  

Right-click either on the connection icon under the [Bluetooth 
Settings] window or on the icon in the task tray, and then click on 
[Disconnect].  
 
 



 
 
 
Click on the "Yes" button in the disconnection confirmation dialog 
box that appears.  

 
 

 
 

 

 Building a personal area network  [PAN] 
You can use the PAN profile to build a network of Bluetooth-enabled devices. 

 
 
 
Operating as a server  
Operating as a client 
A personal area network comprises a client-server architecture. The device to which 
other devices connect is called the "server", and a device that connects to the server 
is called a "client."  
The client-server relationship is not necessarily a fixed one. The first of two devices 
to establish a connection can be the server when one other device is present, and can 
be the client in other instances. 



 
 

 

 Note 

• The maximum total number of devices that can be used to constitute a 
single personal area network is seven: one server and six clients.  
A network comprising as many as seven devices could theoretically 
be built, but an operating environment that involves the use of other 
Bluetooth devices, leaving aside other complications, might require 
the network to comprise fewer components.. 

By using the PAN profile, you will be able to build a network that uses the same 
TCP/IP protocol used in regular LANs. Accordingly, the machine designated as the 
server can be used for configuration tasks that utilize DHCP, such as assigning IP 
addresses to clients.  
In addition, you will be able to configure folder and file sharing, which will allow 
data to be browsed by other servers or clients on the network.  
 
 
 
 

                         
 
 
 



 

 

 Important 
• Please refer to Windows Help for further information on TCP/IP, 

DHCP and configurations for sharing. 

 Operating as a server 
The following icon will appear in the tasktray when the PAN server function has 
been activated.  

 
Should the icon not appear, please follow the procedure below to activate the PAN 
server function. 

1. Right-click the Bluetooth icon in the task tray and make sure the 
Option [Use PAN Group Ad-hoc Network] is enabled.  
A message will appear asking you to confirm whether you wish to 
activate the PAN group ad-hoc network.  

2. Click the [Yes] button  
The PAN server will be activated, and an icon will accordingly 
appear in the tasktray. Other devices that use the PAN profile will 
now be able to connect over the network.  

 Important 
• When using the device as the server, make sure that all user accounts 

have a password set for the security reasons.  
By clicking on the icon, the [Bluetooth PAN Server] window will appear.  
In the graphic below, one client has established a connection.  
 



 

 

 Note 

• When you try to connect to another server as a client, the task tray 
icon will disappear, and your machine will not be able to function as 
a server in response to connection requests originating from other 
devices. 

 Operating as a client 

Connecting to a server as a client is performed from the [Bluetooth Settings] 
window, as described below. 

 Procedure 
1. Right-click on the Bluetooth icon in the task tray, and click on 

[Add New Connection]  
 
 

 

 Note 

o Alternatively, click on [Start] -> [All Programs] -> 
[Bluetooth] -> [Bluetooth Settings], and then on [New 
Connection] from the [Bluetooth Settings] window. 

2. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 



 

 

3. Click on the [Next] button in the advisory dialog box  
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  

 
 
 
Once the program has finished searching for the devices, the [Add New 
Connection Wizard (Device Selection)] window will appear. 

4. Select the name of the device designated as the server from 
[Device List], and then click on the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 

 
 
 
The [Add New Connection Wizard (Confirm Connection Name)] 
window will appear.  

5. Click on the [Next] button  
 
 



 
 
 
The registered icon will appear in the [Bluetooth Settings] window.  
 
 

 

Connecting to a server 

 Procedure 
1. Right-click on the icon in the [Bluetooth Settings] window, and 

then click on [Connect]  
 
 

 
 



 
Once you have connected, the icon will change to indicate that the 
device is connected.  
 
 

 
Ending a connection to a server 

 Procedure 
1. Right-click on the icon in the [Bluetooth Settings] window, and 

then click on [Disconnect]  
 
 

 
 
 
A message confirming whether you wish to disconnect will appear. 
Click on the [Yes] button.  
 
 

 
 
 
Once you have disconnected, the icon will change to indicate that the 
device is not connected.  
 



 

 
 

 
 

 
 

 

 Using a modem station for fax transmissions [FAX] 
This section describes how to send a fax using a Bluetooth wireless modem station. 

 
 

 

Setting up the modem station  
Installing a modem  
Setting fax information  
Sending a fax  
Receiving a fax 

 Important 
• Please refer to the modem station instruction manual for information 

on how to connect the station to a telephone line. 
• Please ensure that any drivers used to connect the PC to the modem 

have been installed. 
• A Bluetooth passkey (PIN code) is required for you to connect to the 

modem station. Please make a note of your Bluetooth passkey before 
you start the set-up process. 

• A fax application is required for you to be able to send and receive 
faxes. The description below is based on a example using Microsoft 
Fax, which is installed with Windows XP as standard.  
If you are going to use a commercially available fax application, then 
please refer to the manual that came with the application for 
information on how to send and receive faxes.  

 Setting up the modem 
station 



Set up and register the modem station as a fax service. 

 Procedure 
1. Turn on the wireless modem station 

2. Right-click on the Bluetooth icon in the task tray, and then click 
on [Add New Connection]  
 
 

 

 Note 

o Alternatively, click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings], and then click on 
[New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] window will appear. 

3. Select [Custom Mode], and then click on the [Next] button  
 
 

 
 



 
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  
 
 

 
 
 
Once the program has finished searching for the devices, the [Add 
New Connection Wizard (Select Device)] window will appear. 

4. Select the device name of the wireless modem station from [Device 
List], and then click on the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Services)] window 



will appear.  
 
 

 

5. If you are connecting to the wireless modem station for the first 
time, enter the passkey for the device from the [Bluetooth 
Passkey (PIN Code)] window, and then click on the [OK] button  
 
 

 
 
 
Once the program has finished searching for the services, the [Add 
New Connection Wizard (Select Service)] window will appear. 

6. Select "Fax" under [Select Service], and then click on the [Next] 
button  
 



 

 

The [Add New Connection Wizard (Connecting to Remote Device)] screen 
will appear. 
The COM port and modem registration process will then be automatically 
performed.  
 
 

 
 
 
Once the COM port and modem (standard 33600 bps type) registration is 
complete,  
the [Add New Connection Wizard (Setting Connection Name)] screen will 
appear. 



7. Configure the type and name of the icon to appear after 
registration,  
and click on the [Next] button. 

Please click only on the [Next] button once you are satisfied with the 
configuration.  
 
 

 
 
 
The [Add New Connection Wizard (Completing the Add New Connection 
Wizard)] screen will appear. 

8. Click on the [Finish] button  
 
 
The settings will be registered, and the icon will appear on the 
[Bluetooth Settings] screen. 

 
 

 
 Setting FAX information 

Configure send/receive settings and register fax information.  

 Procedure 
1. Select [Start]->[Control Panel], and then double-click on the 

[Printers and Other Hardware] icon 

 Note 

o If the control panel is displayed in "Classic view", and 
you use Windows 2000, please start from Step (2). 



2. Double-click on the [Printers and Faxes] icon  
The [Printers & Faxes] window will appear. 

3. Click on "Install a local fax printer" in the [Printers and Faxes] 
window  
 
 

 
 
 
A window showing installed programs will appear, and a Fax icon 
will have been created in the [Printers and Faxes] screen.  
 
 

 

4. Click on "Send a fax" under "Printer Tasks" on the left side of 
the window  
 
 



 
 
 
If you have not yet configured a fax device, the [Fax Configuration 
Wizard] window will appear. In the window you can enter settings 
pertaining to the sender (yourself).  

 Note 

o If the fax configuration information has already been 
registered, the [Send Fax Wizard] window, which can 
be viewed under "Sending a fax" below, will appear 
instead of the [Fax Configuration Wizard] window.  

5. Enter the sender information, and click on the [Next] button  
 



 

 

 Note 

The sender information that you configure here will be 
automatically appended as header information when you 
send a fax. 
The [Fax Configuration Wizard (Select Device for 

Sending or Receiving Faxes)] window will appear. 

6. Select a device to be used for fax transmissions, enable the device 
for sending or receiving, and then click on the [Next] button  
 
 

 

 Note 



If [Enable Receive] is selected, the device will be on 
standby for receiving faxes even if it is not sending or 
receiving anything, and therefore will be in continuous 
connection to the wireless modem (when COM Auto 
Connect is on).  
Please decide whether to select this option based on the 
desired objective and/or frequency of transmission. 

The [Fax Configuration Wizard (Transmitting Subscriber Identification 
(TSID))] window will appear. 

7. Click on the [Next] button  
It is important that you do not change the transmitter subscriber 
identification.  
 
 

 
 
 
The [Fax Configuration Wizard (Completing the Fax Configuration 
Wizard)] window will appear.  

8. Click on the [Finish] button  
 
 



 
 
 
The fax information will be have been registered, and the [Fax 
Console] window will appear. 

 
 
This will complete the fax set-up process.  
Related topics: "Sending a fax" and "Receiving a fax" 
 
 

 
 
 

 

 

Sending a 
fax 

This section describes how to send a fax from the Fax Console.  

 Important 
• The Fax service must be enabled for sending in order for you to send a 

fax.  
Please refer to "Using a wireless modem station" under 
"Troubleshooting" for how to change the send and receive settings 
once the service has been configured.  

 Procedure 
1. Double-click on the [Fax] icon in the Control Panel  

The [Fax Console] window will appear.  
 



 

2. In the [Fax Console] window, click [File] ->[Send fax]  
The [Send Fax Wizard (Starting the Send Fax Wizard)] window will 
appear.  

3. Click on the [Next] button  
 
 

 
 
 
The [Send Fax Wizard (Recipient Information)] window will appear. 



4. Enter the name and fax number of the destination party, and then 
click on the [Next] button  
 
 

 
 
 
The [Send Fax Wizard (Preparing the Cover Page)] window will 
appear. 

5. Specify the cover page template, subject line, and note (body text), 
and then click on the [Next] button  
 
 

 
 



 
The [Send Fax Wizard (Schedule)] window will appear.  

6. If you wish to send the fax immediately, select "Now", and then 
click on the [Next] button  
 
 

 
 
 
The [Send Fax Wizard (Completing the Send Fax Wizard)] window 
will appear. 

7. Confirm the destination information and transmission details, and 
then click on the [Finish] button  
 
 



 
 
 
The software will automatically dial the number and send the fax.  
 
 

 
 
 
Once the fax has been sent, Fax Monitor will revert to standby mode.  
 
 

 
 
 
 
 
Related topic: "Receiving a fax"  



 
 

 
 

 

 Receiving a fax 
This section describes what to do when a fax arrives after you have established a 
connection to a modem station. 

 Important 
• The Fax service must be enabled for receiving in order for you to 

receive a fax.  
Please refer to "Using a wireless modem station" under 
"Troubleshooting" for information on how to change the send and 
receive settings once the fax service has been configured. 

• Please ensure you have connected to a modem station before you 
receive a fax (the device will be connected to the modem if "Enable 
Receive" has been selected or COM Auto Connect has been 
activated). 

 Procedure 
1. When a fax arrives, the Fax Monitor will start automatically as 

the fax is received  
 
 

 
 
 
Once the fax has been received, the Fax Monitor will revert to 
standby mode.  

 Note 

If you have enabled manual fax reception, the message 
below will appear when a fax arrives.  
 
 



             
                       Click on the message with your mouse to receive the fax. 
2. Double-click on the [Fax] icon in the Control Panel  

The [Fax Console] window will appear. 

3. In the [Fax Console] window, double-click on the fax that has 
arrived  
 
 

 
 
 
An image of the received fax will be displayed.  
 



 

 

Related topic: "Sending a fax" 
 
 

 
 

 

 
Using a mobile telephone for fax transmissions 
[FAX]  

This section describes how to send a fax using a mobile telephone as a modem.  
 
 

 

Setting up the mobile telephone  
Installing a modem  
Setting fax information  
Sending a fax  
Receiving a fax 

 Important 
• Please ensure that any drivers used to connect the PC to the mobile 

telephone have been installed. 



• A Bluetooth passkey (PIN code) is required for you to connect to the 
mobile telephone. Please make a note of your Bluetooth passkey 
before you start the set-up process. 

• A fax application is required for you to be able to send and receive 
faxes. The description below is based on a example using Microsoft 
Fax, which is installed with Windows XP as standard.  
If you are going to use a commercially available fax application, then 
please refer to the manual that came with the application for 
information on how to send and receive faxes.  

 Setting up the mobile 
telephone 

Set up and register the mobile telephone as a fax service. 

 Procedure 
1. Turn on the mobile telephone, and set it to be connectable via 

Bluetooth 

 Note 

Please refer to the instruction manual for information on how 
to operate the telephone. 

2. Right-click on the Bluetooth icon in the task tray, and then click 
on [Add New Connection]  
 
 

 

 Note 

Alternatively, click [Start]->[All Programs]->[Bluetooth]-
>[Bluetooth Settings], and then click on [New Connection] from the 
active  

[Bluetooth Settings] window. 
The [Add New Connection Wizard (Welcome to the Add 

New Connection Wizard)] window will appear. 

3. Select [Custom Mode], and then click on the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  
 
 

 
 
 
Once the program has finished searching for the devices, the [Add 
New Connection Wizard (Select Device)] window will appear. 

4. Select the device name of the mobile telephone from [Device List], 
and then click on the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 

 

5. If you are connecting to the mobile telephone for the first time, 
enter the passkey for the device from the [Bluetooth Passkey 
(PIN Code)] window, and then click on the [OK] button.  
 
 



 
 
 
Once the program has finished searching for the services, the [Add 
New Connection Wizard (Select Service)] window will appear. 

6. Select "Fax" under [Select Service], and then click on the [Next] 
button  
 
 

 

The [Add New Connection Wizard (Connecting to Remote Device)] 
screen will appear. 

The COM port and modem registration process will then be 
automatically performed. 



         
                                                                                                             

Once the COM port and modem (standard 33600 bps type) registration is 
complete, the [Add New Connection Wizard (Setting Connection Name)] 
screen will appear. 

7. Configure the type and name of the icon to appear after 
registration, and click on the [Next] button.  
Please click only on the [Next] button once you are satisfied with the 
configuration.  
 
 

 
 
 
The [Add New Connection Wizard (Completing the Add New 
Connection Wizard)] screen will appear.  



8. Click on the [Finish] button  
 
 The settings will be registered, and the icon will appear on the 
[Bluetooth Settings] screen.  

  

 Setting fax information 
Configure send/receive settings and register fax information.  

 Procedure 
1. Select [Start]->[Control Panel], and then double-click on the 

[Printers and Other Hardware] icon  

 Note 

If the control panel is displayed in "Classic view", and you 
use Windows 2000, please start from Step (2). 
2. Double-click on the [Printers and Faxes] icon  

The [Printers & Faxes] window will appear. 

3. Click on "Set up faxing" in the [Printers and Faxes] window  
 
 

 
 
 



A window showing installed programs will appear, and a Fax icon 
will have been created in the [Printers and Faxes] screen.  
 
 

 

4. Click on "Send a fax" under "Printer Tasks" on the left side of 
the window  
 
 

 
 
 
If you have not yet configured a fax device, the [Fax Configuration 
Wizard] window will appear. In the window you can enter settings 
pertaining to the sender (yourself).  

 Note 

If the fax configuration information has already been 
registered, the [Send Fax Wizard] window, which can be viewed under  

"Sending a fax" below, will appear instead of the [Fax 
Configuration Wizard] window. 
5. Enter the sender information, and click on the [Next] button  

 



 

 

 Note 

The sender information that you configure here will be 
automatically appended as header information when you send a fax. 

The [Fax Configuration Wizard (Select Device for 
Sending or Receiving Faxes)] window will appear.  

6. Select a device to be used for fax transmissions, enable the device 
for sending or receiving, and then click on the [Next] button  
 
 

 

 Note 



If [Enable Receive] is selected, the device will be on 
standby for receiving faxes even if it is not sending or receiving anything, 
and  

therefore will be in continuous connection to the 
wireless modem ¡]when COM Auto Connect is on).  

Please decide whether to select this option based on to 
the desired objective and/or frequency of transmission. 

The [Fax Configuration Wizard (Transmitting Subscriber 
Identification (TSID))] window will appear.  
 

7. Click on the [Next] button  
It is important that you do not change the transmitter subscriber 
identification.  
 
 

 
 
 
The [Fax Configuration Wizard (Completing the Fax Configuration 
Wizard)] window will appear.   

8. Click on the [Finish] button  
 
 



 
 
 
The fax information will be have been registered, and the [Fax 
Console] window will appear. 

This will complete the fax set-up process.  
Related topics: "Sending a fax" and "Receiving a fax" 
 
 

 
 

 

 Sending a fax 
This section describes how to send a fax from the Fax Console.  

 Important 
• The Fax service must be enabled for sending in order for you to send a 

fax.  
Please refer to "Using a mobile telephone" under "Troubleshooting" 
for how to change the send and receive settings once the service has 
been configured.""  

 Procedure 
1. Double-click on the [Fax] icon in the Control Panel  

The [Fax Console] window will appear.  
 



 

2. In the [Fax Console] window, click [File]->[Send fax]  
The [Send Fax Wizard (Starting the Send Fax Wizard)] window will 
appear.  

3. Click on the [Next] button  
 
 

 
 
 
The [Send Fax Wizard (Recipient Information)] window will appear. 



4. Enter the name and fax number of the destination party, and then 
click on the [Next] button  
 
 

 
 
 
The [Send Fax Wizard (Preparing the Cover Page)] window will 
appear.  

5. Specify the cover page template, subject line, and note (body text), 
and then click on the [Next] button  
 
 

 
 
 



 
 
The [Send Fax Wizard (Schedule)] window will appear. 

6. If you wish to send the fax immediately, select "Now", and then 
click on the [Next] button  
 
 

 
 
 
 
 
The [Send Fax Wizard (Completing the Send Fax Wizard)] window 
will appear.  

7. Confirm the destination information and transmission details, and 
then click on the [Finish] button  
 
 



 
 
 
The software will automatically dial the number and send the fax.  
 
 

 
 
 
Once the fax has been sent, Fax Monitor will revert to standby mode.  
 
 

 
Related topic: "Receiving a fax"  
 
 

 
 



 

 
Receiving a 
fax 

This section describes what to do when a fax arrives after you have established a 
connection to a modem station. 

 Important 
• The Fax service must be enabled for receiving in order for you to 

receive a fax.  
Please refer to "Using a mobile telephone" under "Troubleshooting" 
for information on how to change the send and receive settings once 
the fax service has been configured. 

• Please ensure you have connected to a modem station before you 
receive a fax (the device will be connected to the modem if "Enable 
Receive" has been selected or COM Auto Connect has been 
activated). 

 Procedure 
1. When a fax arrives, the Fax Monitor will start automatically as 

the fax is received  
 
 

 
 
 
Once the fax has been received, the Fax Monitor will revert to 
standby mode.  

 Note 

If you have enabled manual fax reception, the message 
below will appear when a fax arrives.  
 
 

             
 
 
            Click on the message with your mouse to receive the fax. 



2. Double-click on the [Fax] icon in the Control Panel  
The [Fax Console] window will appear. 

3. In the [Fax Console] window, double-click on the fax that has 
arrived  
 
 

 
 
 
An image of the received fax will be displayed.  
 
 

 

Related topic: "Sending a fax" 



 
 
 

 
 
 

 

 Printing 
This section describes how to use a Bluetooth-compatible printer for printing. 

 Types of printer functions 
When printing using Bluetooth, the methods for configuring and using the printer 
will vary with the corresponding profile. 

Profile Bluetooth Settings Operation 

HCRP 
(*1) 
SPP 

You must register 
the printer in 
Bluetooth Settings 

Allows you to print from various applications, as 
with ordinary cable-connected printers.  
"Printing document and images" 

OPP (*2) Not required Allows you to print business card data directly.  
"Printing business card data" 

BIP Not required 
Allows you to print image data directly.  
"Printing images directly from a digital camera or 
other device" 

 

 Note 
• (*1) The majority of Bluetooth-compatible printers support HCRP.  

If you have selected Express Mode, HCRP will be chosen as the default profile. If 
the printer does not support HCRP, then SPP will be the next choice. 

• (*2) The printing of business cards using OPP complies exclusively with the 
business card (vCARD) standard. 

 
 

 
 

 

 Printing documents and images [HCRP] [SPP] 

This section describes how to print using a Bluetooth-compatible printer. 



 
 

 
Setting up the printer  
Printing  

 Important 
• Please ensure that any printer-specific drivers have been installed on 

the PC before you have established a Bluetooth connection. 
• A Bluetooth passkey (PIN code) is required for you to connect to the 

printer. Please make a note of your Bluetooth passkey before you 
start the set-up process. 

 Setting up the printer 
 

 Procedure 
1. Turn on the printer 

2. Right-click on the Bluetooth icon in the task tray, and then click 
on [Add New Connection]  
 
 

 

 Note 

Alternatively, click [Start]->[All Programs]->[Bluetooth]-
>[Bluetooth Settings], and then click on [New Connection] from the 
active  

[Bluetooth Settings] window. 
The [Add New Connection Wizard (Welcome to the Add 

New Connection Wizard)] window will appear. 

3. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  



 
 

 
 
 
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  
 
 

 
 
 
Once the program has finished searching for the devices, the [Add 
New Connection Wizard (Device Selection)] window will appear. 

4. Select the device name of the printer from [Device List], and then 
click on the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 

 

5. If you are connecting to the printer for the first time, enter the 
passkey for the device from the [Bluetooth Passkey (PIN Code)] 
window, and then click on the [OK] button.  
 
 



 
 
 
Once the services have been detected successfully, connection to the 
device and creation of the HCRP port will be performed 
automatically.  
 
 
If you have not yet installed a printer, a message prompting you to 
install a printer will appear. 

6. Click on the [OK] button  
 
 

 
 
 
The [Add Printer Wizard (Starting the Add Printer Wizard)] window 
will appear. 

7. Click on the [Next] button  
 
 



 
 
 
The [Add Printer Wizard (Local Printer or Network Printer)] window 
will appear. 

8. Select "Local printer attached to this computer", remove the 
check next to "Automatically detect and install my Plug and Play 
printer", and then click on the [Next] button  
 
 

 
 
 
The [Add Printer Wizard (Select Printer Port)] window will appear. 

9. Select the desired port, and then click on the [Next] button  
 
 



 
 
 
 
 
The [Add Printer Wizard (Install Printer Software)] window will 
appear. 

10. Select the [Manufacturer] and [Printer] as pertains to the 
printer to be installed, or click on the [Use Device] button, and 
then click on the [Next] button  
 
 

 
 
 
Please install the printer according to the instructions in the windows 
that follow.  
 



 
Once installation is complete, a message of confirmation will appear 
in the [Add New Connection Wizard (Printer Settings)] window. 

11. Click on [Next]  
 
 

 
 
 
The [Add New Connection Wizard (Connection Name Settings)] 
window will appear. 

12. Enter the type and name of the icon displayed after 
registration, and then click on the [Next] button  
Please click on the [Next] button if you are satisfied with the settings.  
 
 

 



 Note 

You can change the connection icon and icon name.  
"Changing the connection icon name"  
"Changing the connection icon" 

 Printing 
Try to print from the message pad.  

1. Click [File]->[Print]  
The [Print] screen will appear. 

2. Select wireless printer from under [Select Printer], and then click 
on the [Print] button  
 
 

 
 
 
Printing will commence.  

 Note 

If you have connected to a printer using HCRP or SPP profiles, all future 
Bluetooth connections to that printer will be established automatically once  

you have printed a document from your PC. 
 
 
 

 
 

 



 Printing images directly from a digital camera or other device [BIP] 
If you have a printer that supports BIP (Basic Imaging Profile), you can send images 
directly to a printer to be printed out, without having to perform any special set-up 
procedure. 

 
Printing image files on a printer (using icons)  
Printing image files on a printer (by right-clicking the mouse) 

 Note 

• Below is a list of file types (extensions) of images that can be printed 
out directly. 

o Bitmap (*.bmp) 
o JPEG (*.jpg; *.jpeg) 
o PNG (*.png) 

 Procedure 
 
 
Printing image files on a printer (using icons)   

1. Turn on the printer 

2. Click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

Alternatively, open Explorer and click on the Bluetooth 
Information Exchanger folder for the same result.  
 
 



            

 
The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Image Transfer] icon  
 
 
A list of devices will appear in the [Image Transfer] window.  
 
 

 

 Note 



If your desired printer does not appear in the list, please 
confirm that the printer has been turned on, and then click on  

[Bluetooth]->[Search Devices]  
A device search will be performed. 

4. Drag and drop the file to be sent on top of the icon of the 
destination printer  
 
 

 
 
 
The file will be sent to the printer.  
If the file has been sent to the printer successfully, the message below 
will appear, and the image will be printed out. Please click on the 
[OK] button.  
 
 

 
 
 
The message below will appear if the file transmission was 
unsuccessful. Please click on the [OK] button to close the message, 
and repeat the printing procedure.  



 
 

 

 Note 

If the printer does not support the BIP profile, the 
message below will appear.  

 

             
Printing image files to a printer (by right-clicking the mouse) 

1. Turn on the printer 

2. Right-click on the file to be sent, and then click on the destination 
printer under [to Bluetooth]  
 
 

 

 Note 

If your desired device does not appear in the list, please confirm that the 
device has been turned on, and then click on [to Bluetooth] -> 



[Search Other Devices]  
 
 
      Once the device has been detected, the message below will appear. 
Please select the destination device, and click on the [Send] button.  
 
 

      

A window indicating that the file is being sent to the printer will appear.  
If the file has been sent to the printer successfully, the message below will 
appear, and the image will be printed out. Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the file transmission was unsuccessful. 
Please click on the [OK] button to close the message, and repeat the printing 
procedure.  
 



 

 

 Note 

If the printer does not support the BIP profile, the message below will 
appear.  
 
 

  
 
 

 
 

 

 Printing business card data [OPP] 
If you have a printer that supports OPP (Object Push Profile), you can directly send 
business card data that conforms to the "vCard" standard to a printer and print it out.  

 
 

 
Printing business card data (using icons)  
Printing business card data (by right-clicking the mouse) 

 Procedure 
¦Printing business card data (using icons) 

1. Turn on the printer 

2. Click on the Bluetooth Information Exchanger icon on the 
Desktop  
 



 

 

 Note 

Alternatively, open Explorer and click on the Bluetooth 
Information Exchanger folder for the same result.  
 
 
            

 
The [Bluetooth Information Exchanger] window will 

appear. 

3. Double-click on the [Object Push] icon  
 
 
A list of devices will appear in the [Object Push] window.  
 
 



 
 
 
Here, the image will be sent to the target printer.  

 Note 

If your desired printer does not appear in the list, 
please confirm that the printer has been turned on, 
and then click on [Bluetooth]->[Search Devices]  
A device search will be performed.  
 
 

  
 

4. Drag and drop the business card data to be sent on top of the icon 
of the destination printer  
 
 



 
 
 
The business card will be sent to the printer.  
If the business card has been sent to the printer successfully, the 
message below will appear, and the image will be printed out. Please 
click on the [OK] button.  
 
 

 
 
 
The message below will appear if the business card transmission was 
unsuccessful. Please click on the [OK] button to close the message, 
and repeat the printing procedure.  
 
 

 



Printing business card data (by right-clicking the mouse) 
1. Turn on the printer 

2. Right-click on the business card data to be sent, and then click on 
the destination printer under [to Bluetooth]  
 
 

 

 Note 

If your desired device does not appear in the list, please confirm that the 
device has been turned on, and then click on [to Bluetooth]->[Search 
Other Devices]  
 
 
Once the device has been detected, the message below will appear. Please 
select the destination device, and click on the [Send] button.  
 



 

            

The business card will be sent to the printer.  
If the business card has been sent to the printer successfully, the message 
below will appear, and the image will be printed out. Please click on the [OK] 
button.  
 
 

 
 
 
The message below will appear if the business card transmission was 
unsuccessful. Please click on the [OK] button to close the message, and 
repeat the printing procedure.  
 
 

 

 
 

 
 



 

 Listening to music using the stereo headphones [GAVDP][A2DP] [AVRCP] 
This section describes how to use the stereo headphones to listen to your favorite 
music or other audio files stored on your PC. 

 
 
 
Configuring the stereo headphones  
Connecting to the stereo headphones  
Listening to music or other audio files  
Playing music using remote control  
Copyright protection function  

 Configuring the stereo headphones 
 

 Procedure 
1. Right-click on the Bluetooth icon in the task tray, and click on 

[Add New Connection].  
 
 

 

 Note 

Alternatively, click [Start]->[All Programs]->[Bluetooth]-
>[Bluetooth Settings], and then click on [New Connection] 
from the [Bluetooth Settings] screen that has opened. 

The [Add New Connection Wizard (Welcome to the Add 
New Connection Wizard)] will appear. 

2. Switch ON the stereo headphones and activate "Discoverable" 
mode  



Please refer to the user guide for the stereo headphones for further 
information on how to operate them. 

3. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Bluetooth 
Devices)] screen will appear.  
 
 

 
 
 
Once the search for the devices has ended, the [Add New Connection 
Wizard (Select Device)] screen will appear. 



4. Select the device name of the stereo headphones from the list, and 
click on the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Services)] screen 
will appear. 

5. Configure the type and name of the icon to appear once 
registration is complete, and click on the [Next] button  
Please click the [Next] button once you are satisfied with the 
configuration.  
 
 

 
 
 
The [Add New Connection Wizard (Configure Connection Name)] 
screen will appear. 



6. Click on the [Finish] button  
 
 
The settings will be registered, and the icon will appear on the 
[Bluetooth Settings] screen.  
 
 

 

 Connecting to the stereo headphones 
You can connect to the stereo headphones from the icon registered in [Bluetooth 
Settings]. Please refer to the user guide for information on how to make a 
connection from the stereo headphones. 
 

 Important 
• Please close the following audio applications before any connection is 

made between your stereo headphones and PC. 
o Music/video playback applications 
o e-Conferencing applications 
o Voice-recognition applications 

Please finish connecting the stereo headphones before launching any of these 
applications. 

 Listening to music or other audio files 
1. Playing music or other audio files on your PC 

 Important 
o Please confirm the points below if you are unable to 

hear anything despite having properly connected the 
stereo headphones.  
 
 
Click [Start]->[All Programs]->[Accessories]-
>[Entertainment]->[Volume Control].  
 
 
Remove the tick next to [Mute] if it has been ticked. If 
the volume is at its lowest setting, please adjust it to 
an appropriate level. 

o Music playback may be interrupted if other Bluetooth 
devices are currently connected to your PC. When you 
are listening to music, it is recommended that the 
stereo headphones be the only connected device. 



o Music playback may be interrupted if you are some 
distance away from the PC, or if there are any 
obstructions between you and the PC. 

o If you are unable to hear any sound out of your stereo 
headphones while music or audio is currently playing 
in a related application, please stop the files being 
played, open [Sounds and Audio Devices] from the 
Control Panel, and change the default device to 
"Toshiba Bluetooth Wave."  
 
 
If you are still unable to hear any sound from the 
stereo headphones even after having set "Toshiba 
Bluetooth Wave" as the default device, please re-
launch the application.  
 
 

 
2. Finishing listening to music and disconnecting 

o Right-click on the icon for the currently connected 
mode from [Bluetooth Settings] on your PC, and 
click on "Disconnect."  
A message confirming the disconnection may appear. 

o Click on the "Yes" button after having followed the 
instructions in the message.  
The icon will indicate that the device has been 
disconnected. 

 Important 
o Please close the following audio applications before 

you disconnect the stereo headphones from your PC: 
§ Music/video playback applications 



§ e-Conferencing applications 
§ Voice-recognition applications 

Please completely disconnect the stereo headphones before launching 
any of these applications. 
Please refer to the user guide for information on terminating a 
connection from the stereo headphones.  

 Playing music using remote control 
Music applications and video playback applications installed on your PC 
(e.g.,"Windows Media Player 9" and "InterVideo WinDVD") may be operated with 
the remote control button/switch on your stereo headphones.  
 
 
The remote control used with the stereo headphones must be compliant with the 
Bluetooth AVRCP profile. Please refer to the headphones user guide for further 
information.  
 
 
You can configure the application to be operated using the switch/button according 
to the following procedure. 

 Procedure 
1. Double-click on the Bluetooth icon in the taskbar  

Launches "Bluetooth Settings." 
2. Click on [Bluetooth]->[Select AV Player] from the 

menu bar  
The [Select AV Player] screen will appear. 

3. Select the application, and click on the [OK] button 
The functions and switch/button that can be operated may differ depending on the 
application used for music/video playback as well as the version. 
 
 
The procedure below can be performed in order to change the position where the 
receive command is displayed or to not have the command displayed. 

 Procedure 
1. Double-click on the Bluetooth icon in the taskbar  

Launches "Bluetooth Settings." 
2. Click on [Bluetooth]->[Select AV Player] from the 

menu bar.  
The [Select AV Player] screen will appear. 

3. Select the appropriate item from the pull-down 
menu of positions where the receive command is to 
be displayed, and then click on the [OK] button. 

If the receive command appears but does not function properly, sometimes the 
problem may be rectified by changing the setting to "Do not display."  
 



 
The commands supported by this application are shown below. Please refer to the 
headphone user guide for commands that are supported by the stereo headphones. 
Problems with operation may be encountered with certain versions of "Windows 
Media Player 9" and "InterVideo WinDVD."  
 
 
[Windows Media Player 9] 

• Play 
• Stop  
• Pause 
• Next 
• Previous 
• Fast forward 
• Rewind 

[InterVideo WinDVD] 
• Play 
• Stop 
• Pause 
• Next chapter 
• Previous chapter 
• Fast Forward 
• Fast Backward 
• Up 
• Down 
• Left 
• Right 
• Select 
• Root menu 
• Angle 

  Copyright protection function 
A copyright protection function is supported according to the SCMS-T format as 
defined in the Bluetooth specifications. Follow the configuration procedure below to 
establish connections only with devices that support this function. 

 Procedure 
1. Double-click on the Bluetooth icon in the task tray.  

Launches "Bluetooth Settings." 
2. Select [Bluetooth] from the menu, and click on [Copyright 

Protection Setting].  
The copyright protection dialog will appear. 



3. Tick the box next to "Only connect to devices that are copyright-
protected under the SCMS-T format," and click on the OK 
button.  

 
 

 

 
Using a wireless keyboard 
[HID] 

This section describes how to connect a Bluetooth-compatible keyboard to a PC. 
 
 

 

 Setting up the wireless keyboard 
 

 Procedure 
1. Right-click on the Bluetooth icon in the task tray, and then click 

on [Add New Connection]  
 
 

 

 Note 

Alternatively, click [Start]->[All Programs]->[Bluetooth]-
>[Bluetooth Settings], and then click on [New Connection] 
from the active [Bluetooth Settings] window. 

The [Add New Connection Wizard (Welcome to the Add New 
Connection Wizard)] window will appear. 

2. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  
 
 

 
 
 
Once the program has finished searching for the devices, the [Add 
New Connection Wizard (Device Selection)] window will appear. 

3. Select the device name of the keyboard from [Device List], and 
then click on the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 

 
4. Use the wireless keyboard to enter the numbers that appear in 

[Bluetooth Passkey (PIN Code)], and then hit the [Enter] key  
 
 



 
 
 
Once the program has detected the services successfully, connection 
to the device and registration of settings information will be 
performed automatically.  
 
 

 
 
 
The [Add New Connection Wizard (Connection Name Settings)] 
window will appear. 

5. Enter the type and name of the icon displayed after registration, 
and then click on the [Next] button  
 
 
Please click on the [Next] button if you are satisfied with the settings.  
 



 

 

 Note 

You can change the connection icon and icon name.  
"Changing a connection icon name"  
"Changing a connection icon" 
The [Add New Connection Wizard (Completing the Add 

New Connection Wizard)] window will appear. 

6. Click on the [Finish] button  
 
 
The settings information will be registered, and an icon will appear in 
the [Bluetooth Settings] window.  
 
 

 

 Note 

Pressing any key on the wireless keyboard will automatically connect it to 
the PC thereafter.  
Please connect manually if automatic connection is unsuccessful. 

 
 

 
 

 

 
Using a wireless mouse 
[HID] 



This section describes how to connect a Bluetooth-compatible mouse to a PC. 
 
 

 
 Setting up the wireless 
mouse 

 

 Procedure 
1. Turn on the wireless mouse, and set it to be connectable via 

Bluetooth  
Please refer to the instruction manual for details on how to operate 
the mouse. 

2. Right-click on the Bluetooth icon in the task tray, and then click 
on [Add New Connection]  
 
 

 

 Note 

Alternatively, click [Start]->[All Programs]->[Bluetooth]-
>[Bluetooth Settings], and then click on [New Connection] 
from the active [Bluetooth Settings] window. 
The [Add New Connection Wizard (Welcome to the Add 

New Connection Wizard)] window will appear. 

3. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  
 
 

 
 
 
Once the program has finished searching for the devices, the [Add 
New Connection Wizard (Device Selection)] window will appear. 

4. Select the device name of the mouse from [Device List], and then 
click on the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 

 
 
 
A message confirming a device connection will appear. 

5. Click on the [OK] button  
 
 



 
 
 
The [Add New Connection Wizard (Connection Name Settings)] 
window will appear. 

6. Enter the type and name of the icon displayed after registration, 
and then click on the [Next] button  
Please click on the [Next] button if you are satisfied with the settings.  
 
 

 

 Note 

Please use this window to change the connection name and 
icon.  
- Changing the connection icon name  
- Changing the connection icon  

The [Add New Connection Wizard (Completing the Add New Connection 
Wizard)] window will appear. 

7. Click on the [Finish] button  
 
 
The settings information will be have been registered, and an icon 
will appear in the [Bluetooth Settings] window.  
 



 

 

 Note 

Clicking on one of the mouse buttons or otherwise operating it will 
automatically connect it to the PC thereafter. Please connect manually if 
automatic connection is unsuccessful. 

 
 

 
 
 

 

 Exchanging files with a PC or PDA [FTP] 
You can send and receive files other than business card data with a Bluetooth-
enabled PC or PDA.  
Use "File transfer" in the Bluetooth Information Exchanger to exchange files. 

 

 Note 

The same operations will be valid as long as the PC and PDA support the 
FTP profile. 

"File transfer" cannot be used to send or receive business card data. Please 
instead use "Object Push" to perform these activities. 

Sending files to a PC or PDA (using icons)  
Sending files to a PC or PDA (by right-clicking the mouse)  
Receiving files from a PC or PDA  

 Procedure 
 
 
Sending files to a PC or PDA (using icons)  

1. Turn on the PC or PDA 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 



 

 

 Note 

Alternatively, opening Explorer and clicking on the Bluetooth 
Information Exchanger folder will produce the same result.  
 
 
        

 
The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [File transfer] icon  
 
 
A list of devices will appear in the [File transfer] window.  
 



 

 

 Note 

If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then select 
[Bluetooth]->[Search Devices].  
A device search will be performed. 
You can also use "Image transfer" when sending individual 

image files. 
4. Use the mouse to drag and drop the file you wish to send over the 

destination icon  
In this case, the file will be sent to a PC named "PC-1".  
 
 

 

 Note 



When using "File transfer", you can send individual files 
as well as entire folders. 
5. Confirm that the file is being sent  

The file will be sent to the PC. 

 Note 

When sending files using "File transfer", a message requesting 
permission to receive the files may appear on the destination (receiving) 
device. The content of the message will vary with the Bluetooth software 
installed on the destination device, so please be sure to follow the 
instructions provided.  
If you are using the Bluetooth Utility, a message similar to the one below 
will appear.  
 

 
If the file has been sent successfully, the message below will appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the file transmission was unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 

Files that have been sent will be saved in a file transfer shared folder on 
the destination device. 



Additionally, with "File transfer", you can open the shared folder on the 
destination device using Explorer, specify a subfolder, and then send the 
file there.  
 
 
      

 

You can use Properties in the Bluetooth Information Exchanger to change the 
location of the "Shared folder" on the hard drive.  
Sending files to a PC or PDA (by right-clicking the mouse) 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Right-click on the file you wish to send, and then select its 
destination from [to Bluetooth]  
 



 

 

 Note 

If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [to Bluetooth]->[Search other devices].  
 
 
Once the devices have been detected, the message below 
will appear. Please select the destination device, and then 
click on the [Send] button.  
 



 

   
3. Confirm that the file is being sent  

The file will be sent to the PC. 

 Note 

When sending files using "File transfer", a message requesting 
permission to receive the files may appear on the destination (receiving) 
device. The content of the message will vary with the Bluetooth software 
installed on the destination device, so please be sure to follow the 
instructions provided.  
If you are using the Bluetooth Utility, a message similar to the one below 
will appear.  
 
 

  
If the file has been sent successfully, the message below will appear.  
Please click on the [OK] button.  



 
 

 
 
 
The message below will appear if the file transmission was unsuccessful.  
Please click on the [OK] button to close the message, and then repeat 
the procedure.  
 
 

 

 Note 

Files that have been sent will be saved in a file transfer shared folder on 
the destination device. 

 
Receiving files from a PC or PDA 
Your PC is able to receive files that have been saved in the shared folder on the 
destination PC or PDA. Received files will be saved in the shared folder under "File 
transfer". 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce the same result.  
 
 



             

 
The [Bluetooth Information Exchanger] window will 

appear. 

3. Double-click on the [File transfer] icon  
 
 
A list of devices will appear in the [File transfer] window.  
 
 

 
 
 
In this case, the file will be received from the PDA named "My 
Mobile". 



4. Double-click on the [PDA-1] icon  
The file saved in the shared folder in "My Mobile" will appear.  
 
 

5. Right-click on the file you wish to receive, and then select 
"Receive file".  
 
 

 
 
 
The file will be received from a PDA. 

 Note 

With "File transfer", you can send individual files as well as entire 
folders.  
Please right-click on the folder you wish to receive, and select "Receive 
folder".  
 
 

   
 
 
Subsequent operations should be performed in the same manner as when 
receiving individual files. 

 
 
   If the file has been received successfully, the message below will appear.  
   Please click on the [OK] button.  



 
 

    
 
 
 The message below will appear if the file transmission was unsuccessful. 
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

    

 Note 

The received file will be saved in the "Shared folder" under "File 
transfer" in the Bluetooth Information Exchanger  
 
 

     
 
 
You can use Properties under the Bluetooth Information Exchanger to specify 
the location of the "Shared folder" on the hard drive. 

 
 

 
 



 

 Sending images to a mobile telephone [BIP] 
You can send image data to a Bluetooth-compatible mobile telephone.  
Large images will be automatically reduced to fit on the telephone display screen.  
 
 
Images are sent using "Image transfer" under Bluetooth Information Exchanger. 

 

 Note 

The mobile telephone must support the BIP profile. 
The following image file formats can be sent and received using "Image 

transfer":  
o Bitmap (*.bmp) 
o JPEG (*.jpg, *.jpeg)  
o PNG (*.png) 

Sending images to a mobile telephone (using icons)  
Sending images to a mobile telephone (by right-clicking the mouse)  

 Procedure 
¦Sending images to a mobile telephone (using icons) 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce the same result.  
 
 



           

 
The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Image transfer] icon  
A list of devices will appear in the [Image transfer] window.  
 
 

 

 Note 

If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then select 
[Bluetooth]->[Search Devices].  
A device search will be performed. 

4. Drag and drop the file you wish to send over the destination icon  
In this case, the image will be sent to a mobile telephone named "BT-
Phone-1".  
 



 

 
 
 
The image will be sent.  
If the image has been sent successfully, the message below will 
appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the image transmission was 
unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 
  
Sending images to a mobile telephone (by right-clicking the mouse) 



1. Turn on the mobile telephone  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Right-click on the file you wish to send, and then click on its 
destination from [to Bluetooth]  
 
 

 

 Note 

If the desired device does not appear in the list, please confirm that the 
device has been turned on, and then select [to Bluetooth]->[Search other 
devices].  
 
 
Once the devices have been detected, the message below will appear. 
Please select the destination device, and then click on the [Send] button.  
 



 

        
The image will be sent.  
If the image has been sent successfully, the message below will appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the image transmission was unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 



 
 

 
 

 

 Sending images to a PC or PDA [BIP] 
You can send image data to a Bluetooth-enabled PC or PDA.  
Images are sent using "Image transfer" under Bluetooth Information Exchanger. 

 

 Note 

The following image file formats can be sent and received using "Image 
transfer":  

o Bitmap (*.bmp) 
o JPEG (*.jpg, *.jpeg) 
o PNG (*.png) 

Sending images to a PC or PDA (using icons)  
Sending images to a PC or PDA (by right-clicking the mouse) 

 Procedure 
Sending images to a PC or PDA (using icons) 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

Opening Explorer and clicking on the Bluetooth Information 
Exchanger folder will produce the same result.  
 
 



           

 
The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Image transfer] icon  
A list of devices will appear in the [Image transfer] window.  
 
 

 

 Note 

If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then select 
[Bluetooth]->[Search Devices].  
A device search will be performed. 

4. Drag and drop the file you wish to send over the destination icon  
In this case, the image will be sent to a PC named "PC-1".  
 



 

 
The image will be sent.  
If the image has been sent successfully, the message below will appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the image transmission was unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 

Images that have been sent will be saved in an image transfer folder on the 
destination device. 

Images received using "Image transfer" in the Bluetooth Information 
Exchanger will be saved in the "Image Box" in "Image transfer".  
 



 
   

You can use Properties under the Bluetooth Information Exchanger to change the 
location of the "Image Box" folder on the hard drive. 
 
Sending images to a PC or PDA (by right-clicking the mouse) 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding 

2. Right-click on the file you wish to send, and then click on its 
destination from [to Bluetooth]  
 
 

 

 Note 

If the desired device does not appear in the list, please confirm that the 
device has been turned on, and then select [to Bluetooth]->[Search other 



devices].  
 
 
Once the devices have been detected, the message below will appear. 
Please select the destination device, and then click on the [Send] button.  
 
 

             
The image will be sent.  
If the image has been sent successfully, the message below will appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the image transmission was unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 



 

 

 Note 

When you send images by right-clicking the mouse, the image data that has 
been sent will be saved in the image transfer shared folder on the 
destination device. This is also the case when you send images using icons. 

 
 

 
 

 

 Exchanging business card data with a PC or PDA [OPP] 
You can exchange business card data with a Bluetooth-enabled PC or PDA.  
Business card data are exchanged using "Object Push" under Bluetooth Information 
Exchanger. 

 

 Note 

• Data compliant with the "vCARD" standard are the only type of 
business card data able to be sent and received with "Object Push".  
Business card data can be used by applications such as Microsoft 
Outlook. 

• Business card data can be created in vCARD format by Microsoft 
Outlook and other similar applications.  
"Creating business card data in the vCARD format" 

• You can send business card data directly from Microsoft Outlook.  
"Sending business card data from Outlook" 

• The OPP profile must be supported by the PC or PDA of the other 
party. 

Selecting a business card and sending it to a PC or PDA (using icons)  
Selecting a business card and sending it to a PC or PDA (by right-clicking the 
mouse)  
Sending your personal business card  



Receiving a business card from another party  
Exchanging business cards  

 Procedure 
Selecting a business card and sending it to a PC or PDA (using icons) 
Select a business card you wish to send from among all the business card data you 
have already received through exchanges with your business or other contacts, and 
then send it to another party. 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce the same result.  
 
 
            

 
The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Object Push] icon  
A list of devices will appear in the [Object Push] window.  



 
 

 

 Note 

If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then select 
[Bluetooth]->[Search Devices].  
A device search will be performed. 

4. Use the mouse to drag and drop the business card you wish to 
send over the destination icon  
In this case, the business card will be sent to a PC named "PC-1".  
 
 

 
The business card will be sent.  

 Note 

When you try to send a business card, a message requesting permission 
to receive the card may appear on the device belonging to the other party 
(i.e., on the receiving end). The content of the message will vary with the 
Bluetooth software installed on the destination device, so please be sure 



to follow the instructions provided. If you are using the Bluetooth Utility, 
a message similar to the one below will appear.  
 
 

       
If the business card has been sent successfully, the message below will 
appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the business card transmission was 
unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Memo 

Data that have been sent will be saved in a folder for exchanged 
business cards on the destination device. 

You can configure an associated application (Microsoft Outlook etc) to 
start automatically when you have received a business card, allowing 
you to view the card details.  
 
 
       



 
 
 
You can use Properties under Bluetooth Information Exchanger to 
configure whether or not you would like such an application to start 
automatically. 

Selecting a business card and sending it to a PC or PDA (by right-clicking the 
mouse) 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Right-click on the business card you wish to send, and then click 
on its destination from [to Bluetooth]  
 



 

 

 Note 

If the desired device does not appear in the list, please confirm that the 
device has been turned on, and then select [to Bluetooth]->[Search other 
devices].  
 
 
Once the devices have been detected, the message below will appear. 
Please select the destination device, and then click on the [Send] button.  
 
 

               
The business card will be sent.  

 Note 

When you try to send a business card, a message requesting permission 
to receive the files may appear on the device belonging to the other party 
(i.e., on the receiving end). The content of the message will vary with the 
Bluetooth software installed on the destination device, so please be sure 



to follow the instructions provided.  
If you are using the Bluetooth Utility, a message similar to the one below 
will appear.  
 
 

  
If the business card has been sent successfully, the message below will 
appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the business card transmission was 
unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 

Data that have been sent will be saved in a folder for exchanged business 
cards on the destination device. 

Sending your personal business card 
You can prepare a business card bearing your name and other details such as your 
company and telephone numbers, and then send it to another party. 

 Note 

• Please use Properties under Bluetooth Information Exchanger 
beforehand to configure which data to use for your own business card. 



• You can only have one business card registered as your own that is 
able to be sent. 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce the same result.  
 
         

 
The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Object Push] icon  
A list of devices will appear in the [Object Push] window.  
 



 

 

 Note 

If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then select 
[Bluetooth]->[Search Devices].  
A device search will be performed. 

 
4. Right-click on the destination icon, and then click on [Send 

business card To]  
In this case, your personal business card will be sent to a PC named 
"PC-1".  
 
 

 
 
 
The business card will be sent.  

 Note 



When you try to send a business card, a message requesting permission 
to receive the files may appear on the device belonging to the other party 
(i.e., on the receiving end). The content of the message will vary with the 
Bluetooth software installed on the destination device, so please be sure 
to follow the instructions provided. If you are using the Bluetooth Utility, 
a message similar to the one below will appear.  
 
 

        

Business cards that have been sent will be saved in the Inbox of the 
destination party. 

If your business card has been sent successfully, the message below will 
appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the business card transmission was 
unsuccessful. Please click on the [OK] button to close the message, and 
repeat the procedure.  
 
 

 

 Note 

Data that has been sent will be saved in a folder for exchanged business 
cards on the destination device. 

Acquiring a business card from another party 
You can use your PC to acquire a business card from a party containing their details. 



1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

Alternatively, opening Explorer and clicking on the Bluetooth 
Information Exchanger folder will produce the same result.  
 
        

 
The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Object Push] icon  
A list of devices will appear in the [Object Push] window.  
 



 

 

 Note 

If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then select 
[Bluetooth]->[Search Devices].  
A device search will be performed. 

 
4. Right-click on the icon of the party whose card you wish to 

acquire, and then click on [Receive business card]  
In this case, the business card of the other party will be acquired from 
a PC named "PC-1".  
 
 

 
 
 
The business card will be received. 

 Note 



When you try to acquire a business card, a message requesting permission 
to send the files may appear on the device belonging to the other party (i.e., 
on the sending end). The content of the message will vary with the 
Bluetooth software installed on the destination device, so please be sure to 
follow the instructions provided.  
If you are using the Bluetooth Utility, a message similar to the one below 
will appear.  
 
 

  

If the business card has been received successfully, the message below 
will appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the business card was unsuccessfully 
received.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 

Business card data that have been received will be saved in the Inbox under 
"Object Push".  
You can use Properties under the Bluetooth Information Exchanger to set 
the location of the Inbox on the hard drive. 

Exchanging business cards 
Simultaneously exchange your business card with one belonging to another party. 



1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

Alternatively, opening Explorer and clicking on the Bluetooth 
Information Exchanger folder will produce the same result.  
 
 
       

 
The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Object Push] icon  
A list of devices will appear in the [Object Push] window.  
 



 

 

 Note 

If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then select 
[Bluetooth]->[Search Devices].  
A device search will be performed. 

 
4. Right-click on the icon of the party with whom you wish to 

exchange business cards, and then click on [Object Push]  
In this case, the business cards will be exchanged with a PC named 
"PC-1".  
 
 

 
 
 
The business card from the party who executed the "Exchange 
business cards" command will be sent first. 

 Note 



When you try to send a business card, a message requesting permission 
to receive the files may appear on the device belonging to the other party 
(i.e., on the receiving end). The content of the message will vary with 
the Bluetooth software installed on the destination device, so please be 
sure to follow the instructions provided.  
If you are using the Bluetooth Utility, a message similar to the one 
below will appear.  
 
 

             
A message of confirmation will appear if the card has been successfully sent. 

 Note 

Business cards that have been sent will be saved in the Inbox of the 
destination party. 
Once your business card has finished being sent, the program will start 
receiving the business card belonging to the other party. 

 Note 

When a business card is to be received, a message such as the one below 
may appear on the device belonging to the other party.  
Please click on the [Yes] button if you give permission for the business card 
to be sent.  
 
 

             
A message of confirmation will appear if the card has been successfully 
received. 

 Note 

Business cards that have been received will be saved in the "Inbox" under 
"Object Push".  
You can use Properties under the Bluetooth Information Exchanger to set the 
location of the Inbox on the hard drive. 

 
 



 
 

 

 Using a Bluetooth-compatible camera [BIP] 
By connecting a Bluetooth-compatible digital camera to your PC via Bluetooth, you 
will be able to operate the camera shutter from the PC and transmit the captured 
images to it as well. 

 
Connecting the camera  
Taking pictures  
Viewing images saved on your PC 

 Connecting the camera 
Use the "Remote Camera" tool in the Bluetooth Utility to connect the camera to 
your PC. 

 Procedure 
1. Click on [Start ]->[All Programs]->[Bluetooth]->[Remote Camera]  

 Note 

In Windows 2000, click on [Start]->[Programs]->[Bluetooth]-
>[Remote Camera]. 

 

The [Remote Camera] window will appear. 

2. Turn on the camera, and set it to be connectable via Bluetooth 

 Note 

Different cameras are operated in different ways, depending on 
the manufacturer and model used. Please refer to the instruction 
manual for further details on how to operate your camera. 

3. Click on the [Camera Search...] button  
 
 



 
 
 
The camera will be detected and its icon displayed.  
 
 

 

4. Right-click on the camera icon, and select [Connect]  
 
 

 

The camera will be connected, and images from the camera will appear on-
screen.  
 



 

 

 Taking pictures 

By placing the mouse cursor over the on-screen image, the camera's operating 
window will appear.  
You can operate the camera from this window.  
 
 

 

 Procedure 
Taking a single picture 

1. Click on the button in the operating window.  
A single image will be captured and sent to the PC.  
 
 

 



Taking several consecutive frames  

1. Click on the button in the operating window  
A succession of images will be captured and sent to the PC.  
 
 

 

 Note 
o The remote camera shutter cannot be operated while 

the camera is connected to the PC. 
o The number of consecutive pictures taken can be set to 

anywhere between 2 and 16 

1. In the [Remote Camera] window, click on [Bluetooth]-
>[Properties]->[Consecutive Image Settings]  
 
 

 
 
 
The [Change number of consecutive images] dialog box 
will appear 

2. Click on the [<][>] buttons to select the number of 
consecutive images to be captured  
 
 



 
2.  

 Important 
o Images are not only sent to the PC, but are stored in the 

camera's on-board memory as well.  
Please be aware of the remaining memory capacity 
when you are taking a large number of pictures. 

o Large file sizes are common for high-resolution images, 
and may take some time to be transferred to the PC. 

 Viewing images saves on your PC 
A "Remote Camera" folder will be created in the "Bluetooth" folder under "My 
Documents" during initial set-up. A folder bearing the same name as the camera will 
be created in it, and images will be saved in this folder.  
Click the [Explorer] button in the [Remote Camera] window to display the folder 
where the images have been saved. 

 

 Note 



• This window is an example showing pictures when [Filmstrip] has 
been selected from the [View] menu in Explorer. 

 
 

 
 

 

 
Synchronizing information using ActiveSync 
[SPP] 

This section describes how to synchronize information on your PDA (calendars, 
contacts, inboxes etc) with your PC using Microsoft ActiveSync.  
When you connect via Bluetooth instead of with a standard cable, you will always 
be able to synchronize your data without the hassle of having to connect the cable.  

 
Connecting using ActiveSync  
Establishing a partnership between ActiveSync and a PDA  
Finishing an ActiveSync connection  
Cancelling a partnership 

 Important 
• Please use ActiveSync v.3.7 or higher. Also please establish a 

partnership between the devices using a USB or infrared link before 
you connect via Bluetooth. 

• Please refer to the ActiveSync Help or other manuals for information 
on how to use the application. 

• Microsoft Outlook 2002 or another schedule management tool must 
also be installed on the PC. 

 Connecting using 
ActiveSync 

Both the PC and PDA must be set up in order for a connection to be established.  
 
 
¦Preparing the PC 

 Procedure 
1. On the PC, click on [Start]->[All Programs]->[Microsoft 

ActiveSync]  
The initial ActiveSync set-up window will appear.  
It is assumed in the explanation below that no ActiveSync 
connections have been established with other devices.  



 
 

 

2. Click [File]->[Connection Settings]  
 
 

 
 
 
The [Connection Settings] window will appear. 

3. Place a check next to [Allow serial cable or infrared connection to 
this COM port], and then select "COM7".  
 



 

 

 Note 

o In the standard set-up, the port is configured to 
"COM7" (refer to Steps (3) and (4) under "Preparing 
the PDA" below). When using a different port, please 
also change the port number selected in this window. 

¦Preparing the PDA 

 Procedure 
1. Tap on the Bluetooth icon in the bottom right of the screen  

 
 

 
 Important 

o The graphic above shows an example of a PDA 
operating window.  



The connection procedure may be different depending 
on the manufacturer or model of PDA you use. Please 
refer to the product instruction manuals for further 
details. 

The [Bluetooth Settings] window will open.  
The message "Connection not registered" will appear if no Bluetooth device 
has been registered.  
 
 

 
 
 
Please tap on [OK] to close the message. 

2. Double click on [Tools]->[Search for peripheral components]  
 
 

 
 



 
The application searches for nearby Bluetooth devices. 

3. Tap and hold on the destination PC icon, and then select [Update 
Services]  
 
 

 
 
 
A search for services will be carried out, and then a list of service 
names and their connection status will appear as list in the lower 
window.  
 
 

 

4. Tap and hold on "COM7" from the list of service names, and 
then select "Register ActiveSync".  
 



 

 

5. Tap [OK] in the confirmation message window  
 
 

 
 
 
An ActiveSync connection will be initiated. 

 Establishing a partnership between ActiveSync and a PDA 

Once a connection has been successfully established with a PDA, the procedure for 
establishing a partnership with the PDA will be started by the ActiveSync 
application on the PC.  
Performing this set-up procedure will enable data to be synchronized between your 
PC and PDA. 



 Procedure 
1. In the [New Partnership (Set Up a Partnership)] window, select 

"Standard partnership", and then click on the [Next] button  
 
 

 
 
 
The [New Partnership (Specify Data Synchronization Method)] 
window will appear. 

2. Select "Synchronize with this PC", and then click on the [Next] 
button  
 
 

 
 
 



The [New Partnership (Select Synchronization Settings)] window 
will appear. 

3. Select the type of information to be synchronized between your 
PC and PDA, and then click on the [Next] button  
 
 

 
 
 
The [New Partnership (Completing Setup)] window will appear. 

4. Click on the [Finish] button  
 
 

 
 
 
When you click on the [Finish] button, ActiveSync will begin to 



synchronize your information.  
 
 
[Confirming changes]  
 
 

 
 
 
 
[Synchronization complete]  
 
 

 
 
 
While the ActiveSync connection is active, synchronization will be 
performed whenever information is changed on either the PC or the 
PDA.  
 
 
Once a partnership has been established, every time you start your 
PC (and PDA) thereafter, a Bluetooth connection will be opened and 
ActiveSync will synchronize your information. 



 Finishing an ActiveSync connection 

Follow the procedure below on your PDA if you want to end an ActiveSync 
connection manually. 

 Procedure 
1. Tap and hold on "COM7" in the Bluetooth Settings window, and 

select [ActiveSync Release]  
 
 

 

 Cancelling a partnership 
Follow the procedure below from the ActiveSync window on the PC if you want to 
cancel the partnership between your PC and PDA. 

 Procedure 
1. Click on [File]->"Delete partnership"  

 
 



 
 
 
Click on the [Yes] button when the confirmation message appears. 

 Note 

o If you wish to create another ActiveSync connection, 
you will have to repeat the above procedure to re-
establish a partnership. 

 
 
 

 
 
 

 

 Using a headset to communicate [HSP] 
This section provides a description of how to use a Bluetooth-compatible wireless 
headset to communicate (chat) using Microsoft NetMeeting or other software.  

 
Registering the headset  
Making a connection to the headset  
Disconnecting from the headset 

 Registering the 
headset 

 

 Procedure 



1. Right-click on the Bluetooth icon in the tasktray, then click on 
[Add New Connection Wizard]  
 
 

 

 Note 

o Alternatively, you can click on [Start]>[All 
Programs]>[Bluetooth]>[Bluetooth Settings], then 
click on [New Connection] in the [Bluetooth Settings] 
screen that has opened. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] screen will appear. 

2. Turn the headset power on  
Once you have turned on the headset, set the mode to enable a 
Bluetooth connection.  

 Important 
o The procedure for operating the headset may differ 

depending on the manufacturer and model.  
Please consult your user guide for a detailed 
description of how to operate the unit. 

3. Confirm that [Express Mode] has been selected, then click on the 
[Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Bluetooth 
Devices)] screen will appear.  
 
 

 
 
 
Once the device search has been completed, the [Add New 
Connection Wizard (Select a Device)] screen will appear. 

4. Select the name of the headset device from the list, then click on 
the [Next] button  
 



 

 

5. Answering with the headset  
If the service has been properly detected, a screen will appear 
indicating that the headset is being called, and a tone will accordingly 
sound in the headset.  
 
 

 
 
 
Please press the headset switch.  

 Important 
o The procedure for operating the headset may differ 

depending on the manufacturer and model.  
Please consult your user guide for a detailed 
description of how to operate the unit. 

The [Add New Connection Wizard (Configuring (Connecting to Voice 
Circuit))] screen will appear, and device configuration will be performed. 

 Note 

o If you are connecting to the headset for the first time, 
or if another Bluetooth audio device has not yet been 
registered, the following [Found New Hardware 



Wizard] screen will appear, from which you can 
proceed to install the driver.  
 
 
If another audio device has already been registered 
(i.e., the driver has been installed), you can proceed to 
Step 9 without having to install the driver. 

6. Click on the [Next] button  
 
 

 
 
 
The [Install Hardware] screen will appear. 

7. Click on the [Continue Anyway] button  
The following screen will appear automatically. You may disregard it 
and click on the [Continue Anyway] button.  
 
 

 
 



 
The [Add New Connection Wizard (Completing the Found New 
Hardware Wizard)] screen, which is the final screen of the 
installation wizard, will appear. 

8. Click on the [Finish] button  
 
 

 
 
 
Once driver installation is complete, the [Add New Connection 
Wizard (Enter Connection Name)] will appear. 

9. Confirm the information you have entered, and click on the [Next] 
button  
 
 

 



 
 
The [Add New Connection Wizard (Completing the Add New 
Connection Wizard)] screen will appear. 

10. Click on the [Finish] button  
 
 
The configuration information will be registered, and an icon will be 
displayed in the [Bluetooth Settings] screen.  
 
 

 
 Making a connection to the headset 

You can make a connection to the headset from an icon that has been registered in 
[Bluetooth Settings]. 

 Important 
• Before making a connection to the headset, please check that you have 

turned on the headset's power, and that it has been enabled for a 
Bluetooth connection. 

Please ensure that the following audio-related applications have been closed 
before you connect the headset to your PC.  

o Windows Media Player, BeatJam, InterVideo 
WinDVD and other music/audio playback software  

o Windows Messenger and other e-conferencing 
software  

If you wish to use these applications, please terminate the headset connection 
before you launch them.  

 Procedure 
1. Right-click on the headset icon, then click on [Connect].  

 



 

 

2. Answer with the headset  
   
A screen will appear indicating that the headset is being called, and a 
tone will accordingly sound in the headset.  
Please press the headset switch.  
 
 

 
 
 
If the connection has been properly established, the icon's appearance 
will change to indicate a connected state.  
 
 

 
 
 
You may now launch conferencing and voice-recognition software 
and use the headset. 

 Disconnecting from the headset 

Please follow the steps below to disconnect from the headset. 



 Procedure 
1. Right-click on the headset icon in the [Bluetooth Settings] screen, 

then click on [Disconnect].  
 
 

 
 
 
A message will appear, requesting confirmation that you wish to 
disconnect. Click on the [Yes] button.  
The icon on the [Bluetooth Settings] screen will appear as shown 
below, indicating that the device has been disconnected.  
 
 

 
 
 

 

 Connecting to the Internet using a modem station [DUN] 
You can use a Bluetooth wireless modem to connect to the Internet via a telephone 
line.  

 
 

 



Setting up the modem station  
Connecting to the Internet  

 Important 
• In order to connect to the Internet, you must have already signed up 

with a provider and obtained a connection ID and password. Please 
ensure you have confirmed the ID, password and telephone number 
of your provider's access point before you begin the set-up process. 

• Please refer to your instruction manual for information on connecting 
the modem station to a telephone line.  

• A Bluetooth passkey (PIN code) is required for you to connect to the 
modem station. Please make a note of your Bluetooth passkey before 
you start the set-up process. 

 Setting up the modem station 
 

 Procedure 
1. Turn on the wireless modem station 

2. Right-click the Bluetooth icon in the task tray, and then click on 
[Add New Connection]  
 
 

 

 Note 

o Alternatively, click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings], and then click on 
[New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] window will appear.  

3. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  
 
 

 
4. Select the device name of the wireless modem station from [Device 

List], and then click on the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 

 
 
 
Once a service has been detected successfully, connection to the 
device and COM port creation will be performed automatically, after 
which the [Add New Connection Wizard (Modem Settings)] window 
will appear.  

5. If you are connecting to a wireless modem station for the first 
time, enter the passkey for the modem station under [Bluetooth 
Passkey (PIN code)], and then click on the [OK] button  
 



 

 
 
 
Once the program has finished searching for the devices, the [Add 
New Connection Wizard (Device Selection)] window will appear. 

6. Click on the [Next] button  
 
 

 
 
 
Certain modems require you to configure initialization commands 
separately.  
Please click on the [Additional initialization Command Settings] 
button, enter the initialization commands in the following window, 
and then click on the [OK] button.  
 



 

 

 Note 

o Please refer to the modem or mobile phone instruction 
manual for further details on the initialization 
commands. 

7. Enter the connection name (optional), telephone number (of your 
provider's access point), user name and password (as issued by 
your provider), and then click on the [Finish] button.  
 
 

 
 Important 

o The sample entries shown in the window are provided 
solely for purpose of explanation. Please use your own 
telephone number, ID and password according to the 
arrangement with your provider. 



 
 
The settings will be registered, and an icon will appear in the [Bluetooth 
Settings] window.  
 
 

 
 Connecting to the Internet 

You can connect to the Internet by following the procedure below if the connection 
destination registered when you configured the wireless modem has been set as the 
default connection destination.  

1. Start your browser, e-mail application or other application  

 Important 
o Please enter the e-mail settings separately if you are 

going to use e-mail (the set-up method will vary with 
the application). 

2. Enter the URL of the Web page you wish to display and then 
press the [Enter] key, or use the e-mail tool to send/receive items 
or perform other activities.  
 
 
The [Dial-up Connection] window will appear. 

3. Click on the [Connect] button  
 
 

 
 Important 

o A connection will be automatically established with the 
modem station if COM Auto Connect is available. If 
COM Auto Connect is not available, please manually 
connect to the modem station. 



The following message will appear once you have connected to the Internet.  
 
 

 

4. End the connection  
The window below will appear if you double-click on the icon in 
the task bar.  
 
 

 
 
 
Please click on the [Disconnect] button when you want to disconnect 
from the Internet.  
Alternatively, please right-click on the icon, and then click on 
[Disconnect].  
 
 

 

 Note 

• You can start an application to make an automatic connection to the 
Internet, but you can also make a manual connection using the 
connection destination icon.  
The procedure is described below. 

1. From the [Bluetooth Settings] window, right-click on the 
connection destination icon, and then click on [Connect] from the 



menu that appears  
 
 

 
 
 
A window indicating that the connection is being established will 
appear.  
 
 

 
 
 
If the connection has been established successfully, the connection 
icon and task tray will appear as shown below.  
 
 



      
 
 
You will be able to browse Web pages using your browser and send 
and receive e-mail.   

 Important 
o Please enter the e-mail settings separately if you are 

going to use e-mail (the set-up method will vary with 
the application). 

2. End the connection  
Right-click on the icon, and then click [Disconnect] to end the 
connection.  
 
 

 
 
 
The following message will appear. Click on the [Yes] button.  
 
 

 
 
 
When the icon appears as shown below, the connection will have 
ended.  
 



 

 
 
 

 
 
 

 

 Using a modem station for fax transmissions [FAX] 
This section describes how to send a fax using a Bluetooth wireless modem station. 

 
 

 

Setting up the modem station  
Installing a modem  
Setting fax information  
Sending a fax  
Receiving a fax 

 Important 
• Please refer to the modem station instruction manual for information 

on how to connect the station to a telephone line. 
• Please ensure that any drivers used to connect the PC to the modem 

have been installed. 
• A Bluetooth passkey (PIN code) is required for you to connect to the 

modem station. Please make a note of your Bluetooth passkey before 
you start the set-up process. 

• A fax application is required for you to be able to send and receive 
faxes. The description below is based on a example using Microsoft 
Fax, which is installed with Windows XP as standard.  
If you are going to use a commercially available fax application, then 
please refer to the manual that came with the application for 
information on how to send and receive faxes.  

 Setting up the modem 
station 

Set up and register the modem station as a fax service. 



 Procedure 
1. Turn on the wireless modem station 

2. Right-click on the Bluetooth icon in the task tray, and then click 
on [Add New Connection]  
 
 

 

 Note 

o Alternatively, click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings], and then click on 
[New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] window will appear. 

3. Select [Custom Mode], and then click on the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Bluetooth devices)] 



window will appear.  
 
 

 
 
 
Once the program has finished searching for the devices, the [Add 
New Connection Wizard (Select Device)] window will appear. 

4. Select the device name of the wireless modem station from [Device 
List], and then click on the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 



 

 

5. If you are connecting to the wireless modem station for the first 
time, enter the passkey for the device from the [Bluetooth 
Passkey (PIN Code)] window, and then click on the [OK] button  
 
 

 
 
 
Once the program has finished searching for the services, the [Add 
New Connection Wizard (Select Service)] window will appear. 

6. Select "Fax" under [Select Service], and then click on the [Next] 
button  
 



 

 

The [Add New Connection Wizard (Connecting to Remote Device)] screen 
will appear. 
The COM port and modem registration process will then be automatically 
performed.  
 
 

 
 
 
Once the COM port and modem (standard 33600 bps type) registration is 
complete,  
the [Add New Connection Wizard (Setting Connection Name)] screen will 
appear. 



7. Configure the type and name of the icon to appear after 
registration,  
and click on the [Next] button. 

Please click only on the [Next] button once you are satisfied with the 
configuration.  
 
 

 
 
 
The [Add New Connection Wizard (Completing the Add New Connection 
Wizard)] screen will appear. 

8. Click on the [Finish] button  
 
 
The settings will be registered, and the icon will appear on the 
[Bluetooth Settings] screen. 

 
 

 
 Setting FAX information 

Configure send/receive settings and register fax information.  

 Procedure 
1. Select [Start]->[Control Panel], and then double-click on the 

[Printers and Other Hardware] icon 

 Note 

o If the control panel is displayed in "Classic view", and 
you use Windows 2000, please start from Step (2). 



2. Double-click on the [Printers and Faxes] icon  
The [Printers & Faxes] window will appear. 

3. Click on "Install a local fax printer" in the [Printers and Faxes] 
window  
 
 

 
 
 
A window showing installed programs will appear, and a Fax icon 
will have been created in the [Printers and Faxes] screen.  
 
 

 

4. Click on "Send a fax" under "Printer Tasks" on the left side of 
the window  
 
 



 
 
 
If you have not yet configured a fax device, the [Fax Configuration 
Wizard] window will appear. In the window you can enter settings 
pertaining to the sender (yourself).  

 Note 

o If the fax configuration information has already been 
registered, the [Send Fax Wizard] window, which can 
be viewed under "Sending a fax" below, will appear 
instead of the [Fax Configuration Wizard] window.  

5. Enter the sender information, and click on the [Next] button  
 



 

 

 Note 

o The sender information that you configure here will be 
automatically appended as header information when 
you send a fax. 

The [Fax Configuration Wizard (Select Device for Sending or Receiving 
Faxes)] window will appear. 

6. Select a device to be used for fax transmissions, enable the device 
for sending or receiving, and then click on the [Next] button  
 
 

 

 Note 



o If [Enable Receive] is selected, the device will be on 
standby for receiving faxes even if it is not sending or 
receiving anything, and therefore will be in continuous 
connection to the wireless modem (when COM Auto 
Connect is on).  
Please decide whether to select this option based on 
the desired objective and/or frequency of transmission. 

The [Fax Configuration Wizard (Transmitting Subscriber Identification 
(TSID))] window will appear. 

7. Click on the [Next] button  
It is important that you do not change the transmitter subscriber 
identification.  
 
 

 
 
 
The [Fax Configuration Wizard (Completing the Fax Configuration 
Wizard)] window will appear.  

8. Click on the [Finish] button  
 
 



 
 
 
The fax information will be have been registered, and the [Fax 
Console] window will appear. 

 
 
This will complete the fax set-up process.  
Related topics: "Sending a fax" and "Receiving a fax" 
 
 

 
 

 

 

Sending a 
fax 

This section describes how to send a fax from the Fax Console.  

 Important 
• The Fax service must be enabled for sending in order for you to send a 

fax.  
Please refer to "Using a wireless modem station" under 
"Troubleshooting" for how to change the send and receive settings 
once the service has been configured.  

 Procedure 
1. Double-click on the [Fax] icon in the Control Panel  

The [Fax Console] window will appear.  
 



 

2. In the [Fax Console] window, click [File]->[Send fax]  
The [Send Fax Wizard (Starting the Send Fax Wizard)] window will 
appear.  

3. Click on the [Next] button  
 
 

 
 
 
The [Send Fax Wizard (Recipient Information)] window will appear. 



4. Enter the name and fax number of the destination party, and then 
click on the [Next] button  
 
 

 
 
 
The [Send Fax Wizard (Preparing the Cover Page)] window will 
appear. 

5. Specify the cover page template, subject line, and note (body text), 
and then click on the [Next] button  
 
 

 
 



 
The [Send Fax Wizard (Schedule)] window will appear.  

6. If you wish to send the fax immediately, select "Now", and then 
click on the [Next] button  
 
 

 
 
 
The [Send Fax Wizard (Completing the Send Fax Wizard)] window 
will appear. 

7. Confirm the destination information and transmission details, and 
then click on the [Finish] button  
 
 



 
 
 
The software will automatically dial the number and send the fax.  
 
 

 
 
 
Once the fax has been sent, Fax Monitor will revert to standby mode.  
 
 

 
 
 
 
 
Related topic: "Receiving a fax"  



 
 

 
 

 

 Receiving a fax 
This section describes what to do when a fax arrives after you have established a 
connection to a modem station. 

 Important 
• The Fax service must be enabled for receiving in order for you to 

receive a fax.  
Please refer to "Using a wireless modem station" under 
"Troubleshooting" for information on how to change the send and 
receive settings once the fax service has been configured. 

• Please ensure you have connected to a modem station before you 
receive a fax (the device will be connected to the modem if "Enable 
Receive" has been selected or COM Auto Connect has been 
activated). 

 Procedure 
1. When a fax arrives, the Fax Monitor will start automatically as 

the fax is received  
 
 

 
 
 
Once the fax has been received, the Fax Monitor will revert to 
standby mode.  

 Note 

o If you have enabled manual fax reception, the message 
below will appear when a fax arrives.  
 
 

 



 
 
Click on the message with your mouse to receive the 
fax. 

2. Double-click on the [Fax] icon in the Control Panel  
The [Fax Console] window will appear. 

3. In the [Fax Console] window, double-click on the fax that has 
arrived  
 
 

 
 
 
An image of the received fax will be displayed.  
 



 

 

Related topic: "Sending a fax" 
 
 

 
 

 

 
Connecting to the Internet using a mobile telephone 
[DUN] 

This section describes how to connect to the Internet via a telephone line, using a 
mobile telephone.   

 
 

 
Configuring a mobile telephone for use as a modem  
Connecting to the Internet  

 Important 
• In order to connect to the Internet, you must have already signed up 

with a provider and obtained a connection ID and password. Please 
ensure you have confirmed the ID, password and telephone number 
of your provider's access point before you begin the set-up process. 



• A Bluetooth passkey (PIN code) is required for you to connect to the 
mobile telephone. Please make a note of your Bluetooth passkey 
before you start the set-up process. 

 Configuring a mobile telephone for use as a 
modem 

 

 Procedure 
1. Turn on the mobile telephone, and set it to be connectable via 

Bluetooth 

 Note 

o Please refer to the mobile telephone instruction manual 
for information on how to operate the device. 

 
2. Right-click on the Bluetooth icon in the task tray, and then click 

on [Add New Connection]  
 
 

 

 Note 

o Alternatively, click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings], and then click on 
[New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] window will appear. 

3. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  
 
 

 

4. Select the device name of the mobile telephone from [Device List], 
and then click on the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 

 
 
 
Once a service has been detected successfully, connection to the 
device and COM port creation will be performed automatically, after 
which the [Add New Connection Wizard (Modem Settings)] window 
will appear.  

5. If you are connecting to a mobile telephone for the first time, 
enter the passkey for the wireless modem station under 
[Bluetooth Passkey (PIN code)], and then click on the [OK] 
button  



 
 

 
 
 
Once the program has finished searching for the devices, the [Add 
New Connection Wizard (Device Selection)] window will appear. 

6. Click on the [Next] button  
 
 

 
 
 
Certain modems require you to configure initialization commands 
separately.  
Please click on the [Additional Initialization Command Settings] 
button, enter the initialization commands in the following window, 
and then click on the [OK] button.  
 



 

 

 Note 

o Please refer to the modem or mobile phone instruction 
manual for further details on the initialization 
commands. 

7. Enter the connection name (optional), telephone number (of your 
provider's access point), user name and password (as issued by 
your provider), and then click on the [Finish] button.  
 
 

 
 Important 

o The sample entries shown in the window are provided 
solely for purpose of explanation. Please use your own 
telephone number, ID and password according to the 
arrangement with your provider. 



 
 
The settings will be registered, and an icon will appear in the [Bluetooth 
Settings] window.  
 
 

 
 Connecting to the 

Internet 
You can connect to the Internet by following the procedure below if the connection 
destination registered when you configured the mobile telephone has been set as the 
default connection destination.  

1. Start your browser, e-mail application or other application  

 Important 
o Please enter the e-mail settings separately if you are 

going to use e-mail (the set-up method will vary with 
the application). 

2. Enter the URL of the Web page you wish to display and then 
press the [Enter] key, or use the e-mail tool to send/receive items 
or perform other activities.  
 
 
The [Dial-up Connection] window will appear. 

3. Click on the [Connect] button  
 
 

 

 Important 
o A connection will be automatically established with the 

mobile telephone if COM Auto Connect is available. 



If COM Auto Connect is not available, please 
manually connect to the mobile telephone. 

The following message will appear once you have connected to the Internet.  
 
 

 

4. End the connection  
The window below will appear if you double-click on the icon in 
the task bar.  
 
 

 
 
 
Please click on the [Disconnect] button when you want to disconnect 
from the Internet.  
Alternatively, please right-click on the icon, and then click on 
[Disconnect].  
 
 

 

 Note 

• You can start an application to make an automatic connection to the 
Internet, but you can also make a manual connection using the 
connection destination icon.  
The procedure is described below. 



1. From the [Bluetooth Settings] window, right-click on the 
connection destination icon, and then click on [Connect] from the 
menu that appears  
 
 

 
 
 
A window indicating that the connection is being established will 
appear.  
 
 

 
 
 
If the connection has been established successfully, the connection 
icon and task tray will appear as shown below.  
 
 



      
 
 
You will be able to browse Web pages using your browser and send 
and receive e-mail.  

 Important 
o Please enter the e-mail settings separately if you are 

going to use e-mail (the set-up method will vary with 
the application). 

2. End the connection  
Right-click on the icon, and then click [Disconnect] to end a 
connection.  
 
 

 
 
 
The following message will appear. Click on the [Yes] button.  
 
 

 
 
 
When the icon appears as shown below, the connection will have 
been ended.  
 



 

 
 
 

 
 
 

 

 
Using a mobile telephone for fax transmissions 
[FAX]  

This section describes how to send a fax using a mobile telephone as a modem.  
 
 

 

Setting up the mobile telephone  
Installing a modem  
Setting fax information  
Sending a fax  
Receiving a fax 

 Important 
• Please ensure that any drivers used to connect the PC to the mobile 

telephone have been installed. 
• A Bluetooth passkey (PIN code) is required for you to connect to the 

mobile telephone. Please make a note of your Bluetooth passkey 
before you start the set-up process. 

• A fax application is required for you to be able to send and receive 
faxes. The description below is based on a example using Microsoft 
Fax, which is installed with Windows XP as standard.  
If you are going to use a commercially available fax application, then 
please refer to the manual that came with the application for 
information on how to send and receive faxes.  

 Setting up the mobile 
telephone 

Set up and register the mobile telephone as a fax service. 

 Procedure 



1. Turn on the mobile telephone, and set it to be connectable via 
Bluetooth 

 Note 

o Please refer to the instruction manual for information 
on how to operate the telephone. 

2. Right-click on the Bluetooth icon in the task tray, and then click 
on [Add New Connection]  
 
 

 

 Note 

o Alternatively, click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings], and then click on 
[New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] window will appear. 

3. Select [Custom Mode], and then click on the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  
 
 

 
 
 
Once the program has finished searching for the devices, the [Add 
New Connection Wizard (Select Device)] window will appear. 

4. Select the device name of the mobile telephone from [Device List], 
and then click on the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 

 

5. If you are connecting to the mobile telephone for the first time, 
enter the passkey for the device from the [Bluetooth Passkey 
(PIN Code)] window, and then click on the [OK] button.  
 
 



 
 
 
Once the program has finished searching for the services, the [Add 
New Connection Wizard (Select Service)] window will appear. 

6. Select "Fax" under [Select Service], and then click on the [Next] 
button  
 
 

 

The [Add New Connection Wizard (Connecting to Remote Device)] screen 
will appear. 
The COM port and modem registration process will then be automatically 
performed. 



         
                                                                                                             

Once the COM port and modem (standard 33600 bps type) registration is 
complete,  
the [Add New Connection Wizard (Setting Connection Name)] screen will 
appear. 

7. Configure the type and name of the icon to appear after 
registration, and click on the [Next] button.  
Please click only on the [Next] button once you are satisfied with the 
configuration.  
 
 

 
 
 



The [Add New Connection Wizard (Completing the Add New 
Connection Wizard)] screen will appear.  

Click on the [Finish] button  
 
 
       The settings will be registered, and the icon will appear on the 
[Bluetooth Settings] screen.  

       

 Setting fax information 
Configure send/receive settings and register fax information.  

 Procedure 
1. Select [Start]->[Control Panel], and then double-click on the 

[Printers and Other Hardware] icon  

 Note 

o If the control panel is displayed in "Classic view", and 
you use Windows 2000, please start from Step (2). 

2. Double-click on the [Printers and Faxes] icon  
The [Printers & Faxes] window will appear. 

3. Click on "Set up faxing" in the [Printers and Faxes] window  
 
 



 
 
 
A window showing installed programs will appear, and a Fax icon 
will have been created in the [Printers and Faxes] screen.  
 
 

 

4. Click on "Send a fax" under "Printer Tasks" on the left side of 
the window  
 
 



 
 
 
If you have not yet configured a fax device, the [Fax Configuration 
Wizard] window will appear. In the window you can enter settings 
pertaining to the sender (yourself).  

 Note 

o If the fax configuration information has already been 
registered, the [Send Fax Wizard] window, which can 
be viewed under "Sending a fax" below, will appear 
instead of the [Fax Configuration Wizard] window. 

5. Enter the sender information, and click on the [Next] button  
 



 

 

 Note 

o The sender information that you configure here will be 
automatically appended as header information when 
you send a fax. 

The [Fax Configuration Wizard (Select Device for Sending or Receiving 
Faxes)] window will appear.  

6. Select a device to be used for fax transmissions, enable the device 
for sending or receiving, and then click on the [Next] button  
 
 

 

 Note 



o If [Enable Receive] is selected, the device will be on 
standby for receiving faxes even if it is not sending or 
receiving anything, and therefore will be in continuous 
connection to the wireless modem ¡]when COM Auto 
Connect is on).  
Please decide whether to select this option based on to 
the desired objective and/or frequency of transmission. 

The [Fax Configuration Wizard (Transmitting Subscriber Identification 
(TSID))] window will appear.  
 

7. Click on the [Next] button  
It is important that you do not change the transmitter subscriber 
identification.  
 
 

 
 
 
The [Fax Configuration Wizard (Completing the Fax Configuration 
Wizard)] window will appear.   

8. Click on the [Finish] button  
 
 



 
 
 
The fax information will be have been registered, and the [Fax 
Console] window will appear. 

This will complete the fax set-up process.  
Related topics: "Sending a fax" and "Receiving a fax" 
 
 

 
 

 

 Sending a fax 
This section describes how to send a fax from the Fax Console.  

 Important 
• The Fax service must be enabled for sending in order for you to send a 

fax.  
Please refer to "Using a mobile telephone" under "Troubleshooting" 
for how to change the send and receive settings once the service has 
been configured.""  

 Procedure 
1. Double-click on the [Fax] icon in the Control Panel  

The [Fax Console] window will appear.  
 



 

2. In the [Fax Console] window, click [File]->[Send fax]  
The [Send Fax Wizard (Starting the Send Fax Wizard)] window will 
appear.  

3. Click on the [Next] button  
 
 

 
 
 
The [Send Fax Wizard (Recipient Information)] window will appear. 



4. Enter the name and fax number of the destination party, and then 
click on the [Next] button  
 
 

 
 
 
The [Send Fax Wizard (Preparing the Cover Page)] window will 
appear.  

5. Specify the cover page template, subject line, and note (body text), 
and then click on the [Next] button  
 
 

 
 
 



 
 
The [Send Fax Wizard (Schedule)] window will appear. 

6. If you wish to send the fax immediately, select "Now", and then 
click on the [Next] button  
 
 

 
 
 
 
 
The [Send Fax Wizard (Completing the Send Fax Wizard)] window 
will appear.  

7. Confirm the destination information and transmission details, and 
then click on the [Finish] button  
 
 



 
 
 
The software will automatically dial the number and send the fax.  
 
 

 
 
 
Once the fax has been sent, Fax Monitor will revert to standby mode.  
 
 

 
Related topic: "Receiving a fax"  
 
 

 
 



 

 
Receiving a 
fax 

This section describes what to do when a fax arrives after you have established a 
connection to a modem station. 

 Important 
• The Fax service must be enabled for receiving in order for you to 

receive a fax.  
Please refer to "Using a mobile telephone" under "Troubleshooting" 
for information on how to change the send and receive settings once 
the fax service has been configured. 

• Please ensure you have connected to a modem station before you 
receive a fax (the device will be connected to the modem if "Enable 
Receive" has been selected or COM Auto Connect has been 
activated). 

 Procedure 
1. When a fax arrives, the Fax Monitor will start automatically as 

the fax is received  
 
 

 
 
 
Once the fax has been received, the Fax Monitor will revert to 
standby mode.  

 Note 

o If you have enabled manual fax reception, the message 
below will appear when a fax arrives.  
 
 

 
 
 
Click on the message with your mouse to receive the 
fax. 



2. Double-click on the [Fax] icon in the Control Panel  
The [Fax Console] window will appear. 

3. In the [Fax Console] window, double-click on the fax that has 
arrived  
 
 

 
 
 
An image of the received fax will be displayed.  
 
 

 

Related topic: "Sending a fax" 



 
 
 

 
 

 

 Sending images to a mobile telephone [BIP] 
You can send image data to a Bluetooth-compatible mobile telephone.  
Large images will be automatically reduced to fit on the telephone display screen.  
 
 
Images are sent using "Image transfer" under Bluetooth Information Exchanger. 

 

 Note 

• The mobile telephone must support the BIP profile. 
• The following image file formats can be sent and received using 

"Image transfer":  
o Bitmap (*.bmp) 
o JPEG (*.jpg, *.jpeg)  
o PNG (*.png) 

Sending images to a mobile telephone (using icons)  
Sending images to a mobile telephone (by right-clicking the mouse)  

 Procedure 
¦Sending images to a mobile telephone (using icons) 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 



o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 
 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Image transfer] icon  
A list of devices will appear in the [Image transfer] window.  
 
 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [Bluetooth]->[Search Devices].  
A device search will be performed. 



4. Drag and drop the file you wish to send over the destination icon  
In this case, the image will be sent to a mobile telephone named "BT-
Phone-1".  
 
 

 
 
 
The image will be sent.  
If the image has been sent successfully, the message below will 
appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the image transmission was 
unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 



  
Sending images to a mobile telephone (by right-clicking the mouse) 

1. Turn on the mobile telephone  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Right-click on the file you wish to send, and then click on its 
destination from [to Bluetooth]  
 
 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [to Bluetooth]->[Search other devices].  
 
 
Once the devices have been detected, the message 
below will appear. Please select the destination device, 
and then click on the [Send] button.  
 



 

 
The image will be sent.  
If the image has been sent successfully, the message below will appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the image transmission was unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 



 
 

 
 

 

 
Connecting to a LAN using an access point (LAP) 
[LAP] 

This section describes how to connect to a network (for example, a company LAN 
or a personal home network) using a LAP profile-compatible access point.  
Please refer to "Using an access point (PAN) to connect to a LAN if you are using a 
PAN profile-compatible access point. 

 
 

 
 
 
Setting up the access point  
Connecting to a LAN (LAP)  

 Important 
• The access point must have been started and a normal connection 

already established to the network before the access point is set up. 
Please refer to the access point instruction manual for information on 
how to set up the access point. 

• A Bluetooth passkey (PIN code) is required for you to connect to the 
access point. Please make a note of your Bluetooth passkey before 
you start the set-up process. 

 Setting up the access point 
 

 Procedure 
1. Turn on the access point, and confirm that a connection has been 

established with the network  

2. Right-click the Bluetooth icon in the task tray, and then click on 
[Add New Connection]  
 



 

 

 Note 

o Alternatively, click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings], and then click on 
[New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
window will appear.  

3. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 

 
The [Add New Connection Wizard (Searching for Bluetooth devices)] window will 
appear. 



 
 
 
Once the program has finished searching for the devices, the [Add New Connection 
Wizard (Device Selection)] window will appear.   

4. Select the device name of the access point from [Device List], and 
then click on the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 



 
 
 
You will be asked for the Bluetooth passkey in the window that 
appears. 

5. Enter the passkey under [Bluetooth Passkey (PIN code)], and then 
click on the [OK] button  
 
 

 
 
 
Service detection and COM port creation will be performed 
automatically.  
The [Add New Connection Wizard (Create Connection Destination)] 
window will appear. 

6. Enter the connection name, user name and password, then click 
on the [Next] button  
 



 

 

 Note 

o The user name and password are entered here to allow 
you to connect to the access point. 

The [Add New Connection Wizard (Confirm Dial-up Settings)] window will 
appear.  

7. Click on the [Confirm Settings] button  
 
 

 
 
 
 
 
The [Internet Options] window will appear. 



8. Configure the connection method, and then click on the [OK] 
button  
Set the connection destination used for the LAN connection set up in 
(6) above as the default connection destination, and then select 
"Always dial my default connection."  
 
 

 

9. Click on the [Next] button  
 
 

 
 
 



The [Add New Connection Wizard (Connection Name Settings)] 
window will appear.  

10. Enter the type and name of the icon displayed after 
registration, and then click on the [Next] button  
Please click on the [Next] button if you are satisfied with the settings.  
 
 

 
 
 
The [Add New Connection Wizard (Completing the Add New 
Connection Wizard)] window will appear. 

11. Click on the [Finish] button  
 
 
The access point icon will be registered in the [Bluetooth Settings] 
window.  
 
 

 
  
This will complete the access point set-up process.  
 
 
"Connecting to a LAN (LAP)"  
 
 

 
 



 

 
Connecting to a LAN 
(LAP) 

 

 Procedure 
1. Right-click on the connection icon in the [Bluetooth Settings] 

window, and then click on [Connect]  
 
 

 
 
 
The [Dial-up Connection] window will appear. 

2. Confirm that "Direct connection" has been selected under 
[Connection Destination], and then click on the [Connect] button  
 
 

 



 
 
A connection will be initiated.  

 Note 

o This is an example of what happens when you use 
"Direct connection" as a connection name under 
"Connect to access point." If a name different from the 
connection name is used, that name will appear under 
[Connection Destination].  

o Please simply click on [Settings] if no user name or 
password have been entered (i.e., if those fields have 
been left blank) 

o Please change the connection destination if a different 
connection name (for a dial-up connection) appears in 
[Connection Destination].  
 
 

 
 
 
Related topic "Changing the default connection 
destination" 

Once you connect to the network, Internet Explorer will start automatically, 
and you will be able to exchange data with other computers on the network. 

 Note 

o Please follow the procedure below if you need to set up 
a proxy server to connect to the Internet (the following 
procedure is not necessary if the PC you are going to 
use has already been set up as a proxy server).  
 
 
1 Select [Internet Options...] from the [Tools] menu 
in Internet Explorer  
 
 
The [Internet Options] window will appear.  
 
 
2 Click on the [Connections] tab, and then click on 
the [Settings...] button  
 
 



       
 
 
3 Enter the IP address and port number of the 
proxy server under [Proxy Server], and then click 
on the [OK] button  
 
 

      
3. End the connection  

Right-click either on the connection icon under the [Bluetooth 
Settings] window or on the icon in the task tray, and then click on 



[Disconnect].  
 
 

 
 
 
Click on the "Yes" button in the disconnection confirmation dialog 
box that appears.  

 
 

 
 

 

 
Connecting to a LAN using an access point (PAN) 
[PAN] 

This section describes how to connect to a network (for example, a company LAN 
or a personal home network) using a PAN profile-compatible access point.  
Please refer to "Using an access point (LAP) to connect to a LAN" if you are using a 
LAP profile-compatible access point. 

 
 

 
 
 
Setting up the access point  
Connecting to a LAN (PAN)  

 Important 
• The access point must be started and a normal connection already 

established to the network before the access point is set up. Please 
refer to the access point instruction manual for information on how to 
set up the access point. 

• A Bluetooth passkey (PIN code) is required for you to connect to the 
access point. Please make a note of your Bluetooth passkey before 
you start the set-up process. 

 Setting up the access point 



 

 Procedure 
1. Turn on the access point, and confirm that a connection has been 

established with the network 

2. Right-click the Bluetooth icon in the task tray, and then click on 
[Add New Connection]  
 
 

 

 Note 

o Alternatively, click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings], and then click on 
[New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
window will appear.  

3. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 

 



The [Add New Connection Wizard (Searching for Bluetooth devices)] window will 
appear. 

 
 
 
Once the program has finished searching for the devices, the [Add New Connection 
Wizard (Device Selection)] window will appear.  

4. Select the device name of the access point from [Device List], and 
then click on the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 



 
 
 
You will be asked for the Bluetooth passkey in the window that 
appears. 

5. Enter the passkey under [Bluetooth Passkey (PIN code)], and then 
click on the [OK] button  
 
 

 
 
 
Service detection and COM port creation will be performed 
automatically.  
The [Add New Connection Wizard (Connection Name Settings)] 
window will appear.  

6. Enter the type and name of the icon displayed after registration, 
and then click on the [Next] button  
Please click on the [Next] button if you are satisfied with the settings.  
 
 



 
 
 
The [Add New Connection Wizard (Completing the Add New 
Connection Wizard)] window will appear. 

7. Click on the [Finish] button  
 
 
The access point icon will be registered in the [Bluetooth Settings] 
window.  
 
 

 
  
This will complete the access point set-up process.  
 
 
"Connecting to a LAN (PAN)"  
 
 

 
 

 

 Connecting to a LAN (PAN) 
 

 Procedure 



1. Right-click on the connection icon in the [Bluetooth Settings] 
window, and then click on [Connect]  
 
 

 
 
 
You will be asked for the Bluetooth passkey in the window that 
appears. 

2. Enter the passkey under [Bluetooth Passkey (PIN code)], and then 
click on the [OK] button  
 
 

 
 
 
A connection will be initiated.  

Once you have connected to the network, Internet Explorer will start 
automatically, and you will be able to exchange data with other computers 
on the network. 

 Note 

o Please follow the procedure below if you need to set up 
a proxy server to connect to the Internet (the following 
procedure is not necessary if the PC you are going to 
use has already been set up as a proxy server).  



 
 
1 Select [Internet Options...] from the [Tools] menu 
in Internet Explorer  
 
 
 The [Internet Options] window will appear.  
 
 
2 Click on the [Connections] tab, and then click on 
the [LAN Settings...] button  
 
 

       
 
 
3 Enter the IP address and port number of the 
proxy server under [Proxy Server], and then click 
on the [OK] button  
 



 

       
3. End the connection  

Right-click either on the connection icon under the [Bluetooth 
Settings] window or on the icon in the task tray, and then click on 
[Disconnect].  
 
 

 
 
 
Click on the "Yes" button in the disconnection confirmation dialog 
box that appears.  

 
 

 
 

 

 Printing 
This section describes how to use a Bluetooth-compatible printer for printing. 

 Types of printer functions 
When printing using Bluetooth, the methods for configuring and using the printer 
will vary with the corresponding profile. 

Profile Bluetooth Settings Operation 

HCRP 
(*1) 

You must register 
the printer in 

Allows you to print from various applications, as 
with ordinary cable-connected printers.  



SPP Bluetooth Settings "Printing document and images" 

OPP (*2) Not required Allows you to print business card data directly.  
"Printing business card data" 

BIP Not required 
Allows you to print image data directly.  
"Printing images directly from a digital camera or 
other device" 

 

 Note 
• (*1) The majority of Bluetooth-compatible printers support HCRP.  

If you have selected Express Mode, HCRP will be chosen as the default profile. If 
the printer does not support HCRP, then SPP will be the next choice. 

• (*2) The printing of business cards using OPP complies exclusively with the 
business card (vCARD) standard. 

 
 

 
 
 

 

 Printing documents and images [HCRP] [SPP] 

This section describes how to print using a Bluetooth-compatible printer. 
 
 

 
Setting up the printer  
Printing  

 Important 
• Please ensure that any printer-specific drivers have been installed on 

the PC before you have established a Bluetooth connection. 
• A Bluetooth passkey (PIN code) is required for you to connect to the 

printer. Please make a note of your Bluetooth passkey before you 
start the set-up process. 

 Setting up the printer 
 

 Procedure 
1. Turn on the printer 



2. Right-click on the Bluetooth icon in the task tray, and then click 
on [Add New Connection]  
 
 

 

 Note 

o Alternatively, click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings], and then click on 
[New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] window will appear. 

3. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  
 



 

 
 
 
Once the program has finished searching for the devices, the [Add 
New Connection Wizard (Device Selection)] window will appear. 

4. Select the device name of the printer from [Device List], and then 
click on the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 



 

 

5. If you are connecting to the printer for the first time, enter the 
passkey for the device from the [Bluetooth Passkey (PIN Code)] 
window, and then click on the [OK] button.  
 
 

 
 
 
Once the services have been detected successfully, connection to the 
device and creation of the HCRP port will be performed 
automatically.  
 
 
If you have not yet installed a printer, a message prompting you to 
install a printer will appear. 

6. Click on the [OK] button  
 
 



 
 
 
The [Add Printer Wizard (Starting the Add Printer Wizard)] window 
will appear. 

7. Click on the [Next] button  
 
 

 
 
 
The [Add Printer Wizard (Local Printer or Network Printer)] window 
will appear. 

8. Select "Local printer attached to this computer", remove the 
check next to "Automatically detect and install my Plug and Play 
printer", and then click on the [Next] button  
 
 



 
 
 
The [Add Printer Wizard (Select Printer Port)] window will appear. 

9. Select the desired port, and then click on the [Next] button  
 
 

 
 
 
 
 
The [Add Printer Wizard (Install Printer Software)] window will 
appear. 

10. Select the [Manufacturer] and [Printer] as pertains to the 
printer to be installed, or click on the [Use Device] button, and 
then click on the [Next] button  
 



 

 
 
 
Please install the printer according to the instructions in the windows 
that follow.  
 
 
Once installation is complete, a message of confirmation will appear 
in the [Add New Connection Wizard (Printer Settings)] window. 

11. Click on [Next]  
 
 

 
 
 
The [Add New Connection Wizard (Connection Name Settings)] 
window will appear. 



12. Enter the type and name of the icon displayed after 
registration, and then click on the [Next] button  
Please click on the [Next] button if you are satisfied with the settings.  
 
 

 

 Note 

o You can change the connection icon and icon name.  
"Changing the connection icon name"  
"Changing the connection icon" 

 Printing 
Try to print from the message pad.  

1. Click [File]->[Print]  
The [Print] screen will appear. 

2. Select wireless printer from under [Select Printer], and then click 
on the [Print] button  
 
 



 
 
 
Printing will commence.  

 Note 

• If you have connected to a printer using HCRP or SPP profiles, all 
future Bluetooth connections to that printer will be established 
automatically once you have printed a document from your PC. 

 
 
 

 
 

 

 Printing images directly from a digital camera or other device [BIP] 
If you have a printer that supports BIP (Basic Imaging Profile), you can send images 
directly to a printer to be printed out, without having to perform any special set-up 
procedure. 

 
Printing image files on a printer (using icons)  
Printing image files on a printer (by right-clicking the mouse) 

 Note 



• Below is a list of file types (extensions) of images that can be printed 
out directly. 

o Bitmap (*.bmp) 
o JPEG (*.jpg; *.jpeg) 
o PNG (*.png) 

 Procedure 
 
 
¦Printing image files on a printer (using icons)   

1. Turn on the printer 

2. Click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

o Alternatively, open Explorer and click on the Bluetooth 
Information Exchanger folder for the same result.  
 
 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Image Transfer] icon  
 
 



A list of devices will appear in the [Image Transfer] window.  
 
 

 

 Note 

o If your desired printer does not appear in the list, 
please confirm that the printer has been turned on, and 
then click on [Bluetooth]->[Search Devices]  
A device search will be performed. 

4. Drag and drop the file to be sent on top of the icon of the 
destination printer  
 
 



 
 
 
The file will be sent to the printer.  
If the file has been sent to the printer successfully, the message below 
will appear, and the image will be printed out. Please click on the 
[OK] button.  
 
 

 
 
 
The message below will appear if the file transmission was 
unsuccessful. Please click on the [OK] button to close the message, 
and repeat the printing procedure.  
 
 

 

 Note 



o If the printer does not support the BIP profile, the 
message below will appear.  
 
 

 
Printing image files to a printer (by right-clicking the mouse) 

1. Turn on the printer 

2. Right-click on the file to be sent, and then click on the destination 
printer under [to Bluetooth]  
 
 

 

 Note 

o If your desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
click on [to Bluetooth] ->[Search Other Devices]  
 
 
Once the device has been detected, the message below 
will appear. Please select the destination device, and 
click on the [Send] button.  
 



 

 

A window indicating that the file is being sent to the printer will appear.  
If the file has been sent to the printer successfully, the message below will 
appear, and the image will be printed out. Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the file transmission was unsuccessful. 
Please click on the [OK] button to close the message, and repeat the printing 
procedure.  
 
 

 

 Note 



o If the printer does not support the BIP profile, the 
message below will appear.  
 
 

 
 
 

 
 

 

 Printing business card data [OPP] 
If you have a printer that supports OPP (Object Push Profile), you can directly send 
business card data that conforms to the "vCard" standard to a printer and print it out.  

 
 

 
Printing business card data (using icons)  
Printing business card data (by right-clicking the mouse) 

 Procedure 
¦Printing business card data (using icons) 

1. Turn on the printer 

2. Click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

o Alternatively, open Explorer and click on the Bluetooth 
Information Exchanger folder for the same result.  
 



 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Object Push] icon  
 
 
A list of devices will appear in the [Object Push] window.  
 
 

 



 
 
Here, the image will be sent to the target printer.  

 Note 

o If your desired printer does not appear in the list, 
please confirm that the printer has been turned on, and 
then click on [Bluetooth]->[Search Devices]  
A device search will be performed.  
 
 

 
 

4. Drag and drop the business card data to be sent on top of the icon 
of the destination printer  
 
 

 
 
 
The business card will be sent to the printer.  
If the business card has been sent to the printer successfully, the 
message below will appear, and the image will be printed out. Please 



click on the [OK] button.  
 
 

 
 
 
The message below will appear if the business card transmission was 
unsuccessful. Please click on the [OK] button to close the message, 
and repeat the printing procedure.  
 
 

 
¦Printing business card data (by right-clicking the mouse) 

1. Turn on the printer 

2. Right-click on the business card data to be sent, and then click on 
the destination printer under [to Bluetooth]  
 
 

 

 Note 

o If your desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
click on [to Bluetooth] ->[Search Other Devices]  
 



 
Once the device has been detected, the message below 
will appear. Please select the destination device, and 
click on the [Send] button.  
 
 

 

The business card will be sent to the printer.  
If the business card has been sent to the printer successfully, the message 
below will appear, and the image will be printed out. Please click on the [OK] 
button.  
 
 

 
 
 
The message below will appear if the business card transmission was 
unsuccessful. Please click on the [OK] button to close the message, and 
repeat the printing procedure.  
 
 

 



 
 

 
 

 

 Listening to music using the stereo headphones ¡iGAVDP¡j ¡iA2DP¡j ¡iAVRCP¡j 
This section describes how to use the stereo headphones to listen to your favourite 
music or other audio files stored on your PC. 

 
 
 
Configuring the stereo headphones  
Connecting to the stereo headphones  
Listening to music or other audio files  
Playing music using remote control  
Copyright protection function  

 Configuring the stereo headphones 
 

 Procedure 
1. Right-click on the Bluetooth icon in the task tray, and click on 

[Add New Connection].  
 
 

 

 Note 

o Alternatively, click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings], and then click on 
[New Connection] from the [Bluetooth Settings] 
screen that has opened. 



The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] will appear. 

2. Switch ON the stereo headphones and activate "Discoverable" 
mode  
Please refer to the user guide for the stereo headphones for further 
information on how to operate them. 

3. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Bluetooth 
Devices)] screen will appear.  
 
 



 
 
 
Once the search for the devices has ended, the [Add New Connection 
Wizard (Select Device)] screen will appear. 

4. Select the device name of the stereo headphones from the list, and 
click on the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Services)] screen 
will appear. 

5. Configure the type and name of the icon to appear once 
registration is complete, and click on the [Next] button  
Please click the [Next] button once you are satisfied with the 
configuration.  
 



 

 
 
 
The [Add New Connection Wizard (Configure Connection Name)] 
screen will appear. 

6. Click on the [Finish] button  
 
 
The settings will be registered, and the icon will appear on the 
[Bluetooth Settings] screen.  
 
 

 

 Connecting to the stereo headphones 
You can connect to the stereo headphones from the icon registered in [Bluetooth 
Settings]. Please refer to the user guide for information on how to make a 
connection from the stereo headphones. 

 

 Important 
• Please close the following audio applications before any connection is 

made between your stereo headphones and PC. 
o Music/video playback applications 
o e-Conferencing applications 
o Voice-recognition applications 

Please finish connecting the stereo headphones before launching any of these 
applications. 

 
Listening 
to music 



or other 
audio 
files 

1. Playing music or other audio files on your PC 

 Important 
o Please confirm the points below if you are unable to 

hear anything despite having properly connected the 
stereo headphones.  
 
 
Click [Start]->[All Programs]->[Accessories]-
>[Entertainment]->[Volume Control].  
 
 
Remove the tick next to [Mute] if it has been ticked. If 
the volume is at its lowest setting, please adjust it to 
an appropriate level. 

o Music playback may be interrupted if other Bluetooth 
devices are currently connected to your PC. When you 
are listening to music, it is recommended that the 
stereo headphones be the only connected device. 

o Music playback may be interrupted if you are some 
distance away from the PC, or if there are any 
obstructions between you and the PC. 

o If you are unable to hear any sound out of your stereo 
headphones while music or audio is currently playing 
in a related application, please stop the files being 
played, open [Sounds and Audio Devices] from the 
Control Panel, and change the default device to 
"Toshiba Bluetooth Wave."  
 
 
If you are still unable to hear any sound from the 
stereo headphones even after having set "Toshiba 
Bluetooth Wave" as the default device, please re-
launch the application.  
 



 

 
2. Finishing listening to music and disconnecting 

o Right-click on the icon for the currently connected 
mode from [Bluetooth Settings] on your PC, and 
click on "Disconnect."  
A message confirming the disconnection may appear. 

o Click on the "Yes" button after having followed the 
instructions in the message.  
The icon will indicate that the device has been 
disconnected. 

 Important 
o Please close the following audio applications before 

you disconnect the stereo headphones from your PC: 
§ Music/video playback applications 
§ e-Conferencing applications 
§ Voice-recognition applications 

Please completely disconnect the stereo headphones before launching 
any of these applications. 
Please refer to the user guide for information on terminating a 
connection from the stereo headphones.  

 Playing music using remote control 
Music applications and video playback applications installed on your PC 
(e.g.,"Windows Media Player 9" and "InterVideo WinDVD") may be operated with 
the remote control button/switch on your stereo headphones.  
 
 
The remote control used with the stereo headphones must be compliant with the 
Bluetooth AVRCP profile. Please refer to the headphones user guide for further 



information.  
 
 
You can configure the application to be operated using the switch/button according 
to the following procedure. 

 Procedure 
1. Double-click on the Bluetooth icon in the taskbar  

Launches "Bluetooth Settings." 
2. Click on [Bluetooth]->[Select AV Player] from the 

menu bar  
The [Select AV Player] screen will appear. 

3. Select the application, and click on the [OK] button 
The functions and switch/button that can be operated may differ depending on the 
application used for music/video playback as well as the version. 
 
 
The procedure below can be performed in order to change the position where the 
receive command is displayed or to not have the command displayed. 

 Procedure 
1. Double-click on the Bluetooth icon in the taskbar  

Launches "Bluetooth Settings." 
2. Click on [Bluetooth]->[Select AV Player] from the 

menu bar.  
The [Select AV Player] screen will appear. 

3. Select the appropriate item from the pull-down 
menu of positions where the receive command is to 
be displayed, and then click on the [OK] button. 

If the receive command appears but does not function properly, sometimes the 
problem may be rectified by changing the setting to "Do not display."  
 
 
The commands supported by this application are shown below. Please refer to the 
headphone user guide for commands that are supported by the stereo headphones. 
Problems with operation may be encountered with certain versions of "Windows 
Media Player 9" and "InterVideo WinDVD."  
 
 
[Windows Media Player 9] 

• Play 
• Stop  
• Pause 
• Next 
• Previous 
• Fast forward 



• Rewind 
[InterVideo WinDVD] 

• Play 
• Stop 
• Pause 
• Next chapter 
• Previous chapter 
• Fast Forward 
• Fast Backward 
• Up 
• Down 
• Left 
• Right 
• Select 
• Root menu 
• Angle 

  Copyright protection function 
A copyright protection function is supported according to the SCMS-T format as 
defined in the Bluetooth specifications. Follow the configuration procedure below to 
establish connections only with devices that support this function. 

 Procedure 
1. Double-click on the Bluetooth icon in the task tray.  

Launches "Bluetooth Settings." 
2. Select [Bluetooth] from the menu, and click on [Copyright 

Protection Setting].  
The copyright protection dialog will appear. 

3. Tick the box next to "Only connect to devices that are copyright-
protected under the SCMS-T format," and click on the OK 
button.  

 
 
 

 

 
Using a wireless keyboard 
[HID] 

This section describes how to connect a Bluetooth-compatible keyboard to a PC. 



 
 

 

 Setting up the wireless keyboard 
 

 Procedure 
1. Right-click on the Bluetooth icon in the task tray, and then click 

on [Add New Connection]  
 
 

 

 Note 

o Alternatively, click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings], and then click on 
[New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] window will appear. 

2. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  
 
 

 
 
 
Once the program has finished searching for the devices, the [Add 
New Connection Wizard (Device Selection)] window will appear. 

3. Select the device name of the keyboard from [Device List], and 
then click on the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 

 
4. Use the wireless keyboard to enter the numbers that appear in 

[Bluetooth Passkey (PIN Code)], and then hit the [Enter] key  
 
 



 
 
 
Once the program has detected the services successfully, connection 
to the device and registration of settings information will be 
performed automatically.  
 
 

 
 
 
The [Add New Connection Wizard (Connection Name Settings)] 
window will appear. 

5. Enter the type and name of the icon displayed after registration, 
and then click on the [Next] button  
 
 
Please click on the [Next] button if you are satisfied with the settings.  
 



 

 

 Note 

o You can change the connection icon and icon name.  
"Changing a connection icon name"  
"Changing a connection icon" 

The [Add New Connection Wizard (Completing the Add New Connection 
Wizard)] window will appear. 

6. Click on the [Finish] button  
 
 
The settings information will be registered, and an icon will appear in 
the [Bluetooth Settings] window.  
 
 

 

 Note 

• Pressing any key on the wireless keyboard will automatically connect 
it to the PC thereafter.  
Please connect manually if automatic connection is unsuccessful. 

 
 

 
 

 

 
Using a wireless mouse 
[HID] 



This section describes how to connect a Bluetooth-compatible mouse to a PC. 
 
 

 
 Setting up the wireless 
mouse 

 

 Procedure 
1. Turn on the wireless mouse, and set it to be connectable via 

Bluetooth  
Please refer to the instruction manual for details on how to operate 
the mouse. 

2. Right-click on the Bluetooth icon in the task tray, and then click 
on [Add New Connection]  
 
 

 

 Note 

o Alternatively, click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings], and then click on 
[New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] window will appear. 

3. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  
 
 

 
 
 
Once the program has finished searching for the devices, the [Add 
New Connection Wizard (Device Selection)] window will appear. 

4. Select the device name of the mouse from [Device List], and then 
click on the [Next] button  
 
 



 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 

 
 
 
A message confirming a device connection will appear. 

5. Click on the [OK] button  
 
 



 
 
 
The [Add New Connection Wizard (Connection Name Settings)] 
window will appear. 

6. Enter the type and name of the icon displayed after registration, 
and then click on the [Next] button  
Please click on the [Next] button if you are satisfied with the settings.  
 
 

 

 Note 

o Please use this window to change the connection name 
and icon.  
- Changing the connection icon name  
- Changing the connection icon  

The [Add New Connection Wizard (Completing the Add New Connection 
Wizard)] window will appear. 

7. Click on the [Finish] button  
 
 
The settings information will be have been registered, and an icon 
will appear in the [Bluetooth Settings] window.  
 



 

 

 Note 

o Clicking on one of the mouse buttons or otherwise 
operating it will automatically connect it to the PC 
thereafter. Please connect manually if automatic 
connection is unsuccessful. 

 
 

 
 

 

 Exchanging files with a PC or PDA [FTP] 
You can send and receive files other than business card data with a Bluetooth-
enabled PC or PDA.  
Use "File transfer" in the Bluetooth Information Exchanger to exchange files. 

 

 Note 

• The same operations will be valid as long as the PC and PDA support 
the FTP profile. 

• "File transfer" cannot be used to send or receive business card data. 
Please instead use "Object Push" to perform these activities. 

Sending files to a PC or PDA (using icons)  
Sending files to a PC or PDA (by right-clicking the mouse)  
Receiving files from a PC or PDA  

 Procedure 
 
 
¦Sending files to a PC or PDA (using icons)  

1. Turn on the PC or PDA 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 



 

 

 Note 

o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 
 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [File transfer] icon  
 
 
A list of devices will appear in the [File transfer] window.  
 



 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [Bluetooth]->[Search Devices].  
A device search will be performed. 

o You can also use "Image transfer" when sending 
individual image files. 

4. Use the mouse to drag and drop the file you wish to send over the 
destination icon  
In this case, the file will be sent to a PC named "PC-1".  
 
 

 

 Note 



o When using "File transfer", you can send individual 
files as well as entire folders. 

5. Confirm that the file is being sent  
The file will be sent to the PC. 

 Note 

o When sending files using "File transfer", a message 
requesting permission to receive the files may appear 
on the destination (receiving) device. The content of 
the message will vary with the Bluetooth software 
installed on the destination device, so please be sure to 
follow the instructions provided.  
If you are using the Bluetooth Utility, a message 
similar to the one below will appear.  
 
 

 
If the file has been sent successfully, the message below will appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the file transmission was unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 



o Files that have been sent will be saved in a file transfer 
shared folder on the destination device. 

o Additionally, with "File transfer", you can open the 
shared folder on the destination device using Explorer, 
specify a subfolder, and then send the file there.  
 
 

o You can use Properties in the Bluetooth Information 
Exchanger to change the location of the "Shared 
folder" on the hard drive.  

Sending files to a PC or PDA (by right-clicking the mouse) 
1. Turn on the PC or PDA  

Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Right-click on the file you wish to send, and then select its 
destination from [to Bluetooth]  
 



 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [to Bluetooth]->[Search other devices].  
 
 
Once the devices have been detected, the message 
below will appear. Please select the destination device, 
and then click on the [Send] button.  
 



 

 
3. Confirm that the file is being sent  

The file will be sent to the PC. 

 Note 

o When sending files using "File transfer", a message 
requesting permission to receive the files may appear 
on the destination (receiving) device. The content of 
the message will vary with the Bluetooth software 
installed on the destination device, so please be sure to 
follow the instructions provided.  
If you are using the Bluetooth Utility, a message 
similar to the one below will appear.  
 
 

 



If the file has been sent successfully, the message below will appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the file transmission was unsuccessful.  
Please click on the [OK] button to close the message, and then repeat the 
procedure.  
 
 

 

 Note 

o Files that have been sent will be saved in a file transfer 
shared folder on the destination device. 

¦Receiving files from a PC or PDA 
Your PC is able to receive files that have been saved in the shared folder on the 
destination PC or PDA. Received files will be saved in the shared folder under "File 
transfer". 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 



 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [File transfer] icon  
 
 
A list of devices will appear in the [File transfer] window.  
 
 

 
 
 
In this case, the file will be received from the PDA named "My 
Mobile". 



4. Double-click on the [PDA-1] icon  
The file saved in the shared folder in "My Mobile" will appear.  
 
 

5. Right-click on the file you wish to receive, and then select 
"Receive file".  
 
 

 
 
 
The file will be received from a PDA. 

 Note 

o With "File transfer", you can send individual files as 
well as entire folders.  
Please right-click on the folder you wish to receive, 
and select "Receive folder".  
 
 

 
 
 
Subsequent operations should be performed in the 
same manner as when receiving individual files. 

 
 
If the file has been received successfully, the message below will appear.  
Please click on the [OK] button.  



 
 

 
 
 
The message below will appear if the file transmission was unsuccessful. 
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 

o The received file will be saved in the "Shared folder" 
under "File transfer" in the Bluetooth Information 
Exchanger  
 
 

 
 
 
You can use Properties under the Bluetooth 
Information Exchanger to specify the location of the 
"Shared folder" on the hard drive. 

 
 

 



 

 

 Sending images to a PC or PDA [BIP] 
You can send image data to a Bluetooth-enabled PC or PDA.  
Images are sent using "Image transfer" under Bluetooth Information Exchanger. 

 

 Note 

• The following image file formats can be sent and received using 
"Image transfer":  

o Bitmap (*.bmp) 
o JPEG (*.jpg, *.jpeg) 
o PNG (*.png) 

Sending images to a PC or PDA (using icons)  
Sending images to a PC or PDA (by right-clicking the mouse) 

 Procedure 
¦Sending images to a PC or PDA (using icons) 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 



 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Image transfer] icon  
A list of devices will appear in the [Image transfer] window.  
 
 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [Bluetooth]->[Search Devices].  
A device search will be performed. 

4. Drag and drop the file you wish to send over the destination icon  
In this case, the image will be sent to a PC named "PC-1".  
 



 

 
The image will be sent.  
If the image has been sent successfully, the message below will appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the image transmission was unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 

o Images that have been sent will be saved in an image 
transfer folder on the destination device. 

o Images received using "Image transfer" in the 
Bluetooth Information Exchanger will be saved in the 
"Image Box" in "Image transfer".  



 
 

o You can use Properties under the Bluetooth 
Information Exchanger to change the location of the 
"Image Box" folder on the hard drive. 

¦Sending images to a PC or PDA (by right-clicking the mouse) 
1. Turn on the PC or PDA  

Confirm that a Bluetooth connection has been enabled before 
proceeding 

2. Right-click on the file you wish to send, and then click on its 
destination from [to Bluetooth]  
 
 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 



select [to Bluetooth]->[Search other devices].  
 
 
Once the devices have been detected, the message 
below will appear. Please select the destination device, 
and then click on the [Send] button.  
 
 

 
The image will be sent.  
If the image has been sent successfully, the message below will appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the image transmission was unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 



 

 

 Note 

o When you send images by right-clicking the mouse, 
the image data that has been sent will be saved in the 
image transfer shared folder on the destination device. 
This is also the case when you send images using 
icons. 

 
 

 
 

 

 Exchanging business card data with a PC or PDA [OPP] 
You can exchange business card data with a Bluetooth-enabled PC or PDA.  
Business card data are exchanged using "Object Push" under Bluetooth Information 
Exchanger. 

 

 Note 

• Data compliant with the "vCARD" standard are the only type of 
business card data able to be sent and received with "Object Push".  
Business card data can be used by applications such as Microsoft 
Outlook. 

• Business card data can be created in vCARD format by Microsoft 
Outlook and other similar applications.  
"Creating business card data in the vCARD format" 

• You can send business card data directly from Microsoft Outlook.  
"Sending business card data from Outlook" 

• The OPP profile must be supported by the PC or PDA of the other 
party. 

Selecting a business card and sending it to a PC or PDA (using icons)  
Selecting a business card and sending it to a PC or PDA (by right-clicking the 
mouse)  



Sending your personal business card  
Receiving a business card from another party  
Exchanging business cards  

 Procedure 
¦Selecting a business card and sending it to a PC or PDA (using icons) 
Select a business card you wish to send from among all the business card data you 
have already received through exchanges with your business or other contacts, and 
then send it to another party. 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 
 

The [Bluetooth Information Exchanger] window will appear. 



3. Double-click on the [Object Push] icon  
A list of devices will appear in the [Object Push] window.  
 
 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [Bluetooth]->[Search Devices].  
A device search will be performed. 

4. Use the mouse to drag and drop the business card you wish to 
send over the destination icon  
In this case, the business card will be sent to a PC named "PC-1".  
 
 

 
The business card will be sent.  

 Note 

o When you try to send a business card, a message 
requesting permission to receive the card may appear 



on the device belonging to the other party (i.e., on the 
receiving end). The content of the message will vary 
with the Bluetooth software installed on the 
destination device, so please be sure to follow the 
instructions provided. If you are using the Bluetooth 
Utility, a message similar to the one below will appear.  
 
 

 
If the business card has been sent successfully, the message below will 
appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the business card transmission was 
unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Memo 

o Data that have been sent will be saved in a folder for 
exchanged business cards on the destination device. 

o You can configure an associated application (Microsoft 
Outlook etc) to start automatically when you have 
received a business card, allowing you to view the 
card details.  
 



 

 
 
 
You can use Properties under Bluetooth Information 
Exchanger to configure whether or not you would like 
such an application to start automatically. 

Selecting a business card and sending it to a PC or PDA (by right-clicking the 
mouse) 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Right-click on the business card you wish to send, and then click 
on its destination from [to Bluetooth]  
 



 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [to Bluetooth]->[Search other devices].  
 
 
Once the devices have been detected, the message 
below will appear. Please select the destination device, 
and then click on the [Send] button.  
 
 

 
The business card will be sent.  

 Note 

o When you try to send a business card, a message 
requesting permission to receive the files may appear 
on the device belonging to the other party (i.e., on the 



receiving end). The content of the message will vary 
with the Bluetooth software installed on the 
destination device, so please be sure to follow the 
instructions provided.  
If you are using the Bluetooth Utility, a message 
similar to the one below will appear.  
 
 

 
If the business card has been sent successfully, the message below will 
appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the business card transmission was 
unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 

o Data that have been sent will be saved in a folder for 
exchanged business cards on the destination device. 

Sending your personal business card 
You can prepare a business card bearing your name and other details such as your 
company and telephone numbers, and then send it to another party. 



 Note 

• Please use Properties under Bluetooth Information Exchanger 
beforehand to configure which data to use for your own business card. 

• You can only have one business card registered as your own that is 
able to be sent. 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 
 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Object Push] icon  
A list of devices will appear in the [Object Push] window.  
 



 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [Bluetooth]->[Search Devices].  
A device search will be performed. 

 
4. Right-click on the destination icon, and then click on [Send 

business card To]  
In this case, your personal business card will be sent to a PC named 
"PC-1".  
 
 

 
 
 
The business card will be sent.  

 Note 



o When you try to send a business card, a message 
requesting permission to receive the files may appear 
on the device belonging to the other party (i.e., on the 
receiving end). The content of the message will vary 
with the Bluetooth software installed on the 
destination device, so please be sure to follow the 
instructions provided. If you are using the Bluetooth 
Utility, a message similar to the one below will appear.  
 
 

 

o Business cards that have been sent will be saved in the 
Inbox of the destination party. 

If your business card has been sent successfully, the message below will 
appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the business card transmission was 
unsuccessful. Please click on the [OK] button to close the message, and 
repeat the procedure.  
 
 

 

 Note 

o Data that has been sent will be saved in a folder for 
exchanged business cards on the destination device. 

¦Acquiring a business card from another party 



You can use your PC to acquire a business card from a party containing their details. 
1. Turn on the PC or PDA  

Confirm that a Bluetooth connection has been enabled before 
proceeding 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 
 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Object Push] icon  
A list of devices will appear in the [Object Push] window.  
 



 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [Bluetooth]->[Search Devices].  
A device search will be performed. 

 
4. Right-click on the icon of the party whose card you wish to 

acquire, and then click on [Receive business card]  
In this case, the business card of the other party will be acquired from 
a PC named "PC-1".  
 
 

 
 
 
The business card will be received. 

 Note 



o When you try to acquire a business card, a message 
requesting permission to send the files may appear on 
the device belonging to the other party (i.e., on the 
sending end). The content of the message will vary 
with the Bluetooth software installed on the 
destination device, so please be sure to follow the 
instructions provided.  
If you are using the Bluetooth Utility, a message 
similar to the one below will appear.  
 
 

 

If the business card has been received successfully, the message below will 
appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the business card was unsuccessfully 
received.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 

o Business card data that have been received will be 
saved in the Inbox under "Object Push".  
You can use Properties under the Bluetooth 
Information Exchanger to set the location of the Inbox 
on the hard drive. 

¦Exchanging business cards 
Simultaneously exchange your business card with one belonging to another party. 



1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 
 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Object Push] icon  
A list of devices will appear in the [Object Push] window.  
 



 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [Bluetooth]->[Search Devices].  
A device search will be performed. 

 
4. Right-click on the icon of the party with whom you wish to 

exchange business cards, and then click on [Object Push]  
In this case, the business cards will be exchanged with a PC named 
"PC-1".  
 
 

 
 
 
The business card from the party who executed the "Exchange 
business cards" command will be sent first. 

 Note 



o When you try to send a business card, a message 
requesting permission to receive the files may appear 
on the device belonging to the other party (i.e., on the 
receiving end). The content of the message will vary 
with the Bluetooth software installed on the 
destination device, so please be sure to follow the 
instructions provided.  
If you are using the Bluetooth Utility, a message 
similar to the one below will appear.  
 
 

 
A message of confirmation will appear if the card has been successfully sent. 

 Note 

o Business cards that have been sent will be saved in the 
Inbox of the destination party. 

Once your business card has finished being sent, the program will start 
receiving the business card belonging to the other party. 

 Note 

o When a business card is to be received, a message such 
as the one below may appear on the device belonging 
to the other party.  
Please click on the [Yes] button if you give permission 
for the business card to be sent.  
 
 

 
A message of confirmation will appear if the card has been successfully 
received. 

 Note 

o Business cards that have been received will be saved in 
the "Inbox" under "Object Push".  
You can use Properties under the Bluetooth 



Information Exchanger to set the location of the Inbox 
on the hard drive. 

 
 

 
 

 

 Building a personal area network  [PAN] 
You can use the PAN profile to build a network of Bluetooth-enabled devices. 

 
 

 
 
 
Operating as a server  
Operating as a client 
A personal area network comprises a client-server architecture. The device to which 
other devices connect is called the "server", and a device that connects to the server 
is called a "client."  
The client-server relationship is not necessarily a fixed one. The first of two devices 
to establish a connection can be the server when one other device is present, and can 
be the client in other instances. 

 
 

 

 Note 



• The maximum total number of devices that can be used to constitute a 
single personal area network is seven: one server and six clients.  
A network comprising as many as seven devices could theoretically 
be built, but an operating environment that involves the use of other 
Bluetooth devices, leaving aside other complications, might require 
the network to comprise fewer components.. 

By using the PAN profile, you will be able to build a network that uses the same 
TCP/IP protocol used in regular LANs. Accordingly, the machine designated as the 
server can be used for configuration tasks that utilize DHCP, such as assigning IP 
addresses to clients.  
In addition, you will be able to configure folder and file sharing, which will allow 
data to be browsed by other servers or clients on the network.  
 
 
 
 

            
 
 
 
 

 



 Important 
• Please refer to Windows Help for further information on TCP/IP, 

DHCP and configurations for sharing. 

 Operating as a server 
The following icon will appear in the tasktray when the PAN server function has 
been activated.  

 
Should the icon not appear, please follow the procedure below to activate the PAN 
server function. 

1. Right-click the Bluetooth icon in the task tray and make sure the 
Option [Use PAN Group Ad-hoc Network] is enabled.  
A message will appear asking you to confirm whether you wish to 
activate the PAN group ad-hoc network.  

2. Click the [Yes] button  
The PAN server will be activated, and an icon will accordingly 
appear in the tasktray. Other devices that use the PAN profile will 
now be able to connect over the network.  

 Important 
• When using the device as the server, make sure that all user accounts 

have a password set for the security reasons.  
By clicking on the icon, the [Bluetooth PAN Server] window will appear.  
In the graphic below, one client has established a connection.  
 
 

 

 Note 

• When you try to connect to another server as a client, the task tray 
icon will disappear, and your machine will not be able to function as 
a server in response to connection requests originating from other 
devices. 

 Operating as a client 



Connecting to a server as a client is performed from the [Bluetooth Settings] 
window, as described below. 

 Procedure 
1. Right-click on the Bluetooth icon in the task tray, and click on 

[Add New Connection]  
 
 

 

 Note 

o Alternatively, click on [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings], and then on [New 
Connection] from the [Bluetooth Settings] window. 

2. Confirm that [Express Mode] has been selected, and then click on 
the [Next] button  
 
 

 

3. Click on the [Next] button in the advisory dialog box  
The [Add New Connection Wizard (Searching for Bluetooth devices)] 
window will appear.  



 
 
 
Once the program has finished searching for the devices, the [Add New 
Connection Wizard (Device Selection)] window will appear. 
4. Select the name of the device designated as the server from 

[Device List], and then click on the [Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Services)] window 
will appear.  
 
 



 
 
 
The [Add New Connection Wizard (Confirm Connection Name)] 
window will appear.  

5. Click on the [Next] button  
 
 

 
 
 
The registered icon will appear in the [Bluetooth Settings] window.  
 
 

 



Connecting to a server 

 Procedure 
1. Right-click on the icon in the [Bluetooth Settings] window, and 

then click on [Connect]  
 
 

 
 
 
Once you have connected, the icon will change to indicate that the 
device is connected.  
 
 

 
¦Ending a connection to a server 

 Procedure 
1. Right-click on the icon in the [Bluetooth Settings] window, and 

then click on [Disconnect]  
 
 



 
 
 
A message confirming whether you wish to disconnect will appear. 
Click on the [Yes] button.  
 
 

 
 
 
Once you have disconnected, the icon will change to indicate that the 
device is not connected.  
 
 

 
 

 
 

 
 

 

 Exchanging files with a PC or PDA [FTP] 
You can send and receive files other than business card data with a Bluetooth-
enabled PC or PDA.  
Use "File transfer" in the Bluetooth Information Exchanger to exchange files. 



 

 Note 

• The same operations will be valid as long as the PC and PDA support 
the FTP profile. 

• "File transfer" cannot be used to send or receive business card data. 
Please instead use "Object Push" to perform these activities. 

Sending files to a PC or PDA (using icons)  
Sending files to a PC or PDA (by right-clicking the mouse)  
Receiving files from a PC or PDA  

 Procedure 
 
 
Sending files to a PC or PDA (using icons)  

1. Turn on the PC or PDA 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 



 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [File transfer] icon  
 
 
A list of devices will appear in the [File transfer] window.  
 
 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 



select [Bluetooth]->[Search Devices].  
A device search will be performed. 

o You can also use "Image transfer" when sending 
individual image files. 

4. Use the mouse to drag and drop the file you wish to send over the 
destination icon  
In this case, the file will be sent to a PC named "PC-1".  
 
 

 

 Note 

o When using "File transfer", you can send individual 
files as well as entire folders. 

5. Confirm that the file is being sent  
The file will be sent to the PC. 

 Note 

o When sending files using "File transfer", a message 
requesting permission to receive the files may appear 
on the destination (receiving) device. The content of 
the message will vary with the Bluetooth software 
installed on the destination device, so please be sure to 
follow the instructions provided.  
If you are using the Bluetooth Utility, a message 
similar to the one below will appear.  
 



 

 
If the file has been sent successfully, the message below will appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the file transmission was unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 

o Files that have been sent will be saved in a file transfer 
shared folder on the destination device. 

o Additionally, with "File transfer", you can open the 
shared folder on the destination device using Explorer, 
specify a subfolder, and then send the file there.  
 



 

o You can use Properties in the Bluetooth Information 
Exchanger to change the location of the "Shared 
folder" on the hard drive.  

Sending files to a PC or PDA (by right-clicking the mouse) 
1. Turn on the PC or PDA  

Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Right-click on the file you wish to send, and then select its 
destination from [to Bluetooth]  
 
 

 



 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [to Bluetooth]->[Search other devices].  
 
 
Once the devices have been detected, the message 
below will appear. Please select the destination device, 
and then click on the [Send] button.  
 
 

 
3. Confirm that the file is being sent  

The file will be sent to the PC. 

 Note 

o When sending files using "File transfer", a message 
requesting permission to receive the files may appear 
on the destination (receiving) device. The content of 
the message will vary with the Bluetooth software 
installed on the destination device, so please be sure to 
follow the instructions provided.  
If you are using the Bluetooth Utility, a message 
similar to the one below will appear.  
 



 

 
If the file has been sent successfully, the message below will appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the file transmission was unsuccessful.  
Please click on the [OK] button to close the message, and then repeat the 
procedure.  
 
 

 

 Note 

o Files that have been sent will be saved in a file transfer 
shared folder on the destination device. 

Receiving files from a PC or PDA 
Your PC is able to receive files that have been saved in the shared folder on the 
destination PC or PDA. Received files will be saved in the shared folder under "File 
transfer". 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 



 

 

 Note 

o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 
 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [File transfer] icon  
 
 
A list of devices will appear in the [File transfer] window.  
 
 



 
 
 
In this case, the file will be received from the PDA named "My 
Mobile". 

4. Double-click on the [PDA-1] icon  
The file saved in the shared folder in "My Mobile" will appear.  
 
 

5. Right-click on the file you wish to receive, and then select 
"Receive file".  
 
 

 
 
 
The file will be received from a PDA. 



 Note 

o With "File transfer", you can send individual files as 
well as entire folders.  
Please right-click on the folder you wish to receive, 
and select "Receive folder".  
 
 

 
 
 
Subsequent operations should be performed in the 
same manner as when receiving individual files. 

 
 
If the file has been received successfully, the message below will appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the file transmission was unsuccessful. 
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 

o The received file will be saved in the "Shared folder" 
under "File transfer" in the Bluetooth Information 
Exchanger  
 



 

 
 
 
You can use Properties under the Bluetooth 
Information Exchanger to specify the location of the 
"Shared folder" on the hard drive. 

 
 

 
 

 

 Sending images to a PC or PDA [BIP] 
You can send image data to a Bluetooth-enabled PC or PDA.  
Images are sent using "Image transfer" under Bluetooth Information Exchanger. 

 

 Note 

• The following image file formats can be sent and received using 
"Image transfer":  

o Bitmap (*.bmp) 
o JPEG (*.jpg, *.jpeg) 
o PNG (*.png) 

Sending images to a PC or PDA (using icons)  
Sending images to a PC or PDA (by right-clicking the mouse) 

 Procedure 



¦Sending images to a PC or PDA (using icons) 
1. Turn on the PC or PDA  

Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 
 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Image transfer] icon  
A list of devices will appear in the [Image transfer] window.  
 



 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [Bluetooth]->[Search Devices].  
A device search will be performed. 

4. Drag and drop the file you wish to send over the destination icon  
In this case, the image will be sent to a PC named "PC-1".  
 
 

 
The image will be sent.  
If the image has been sent successfully, the message below will appear.  
Please click on the [OK] button.  
 
 



 
 
 
The message below will appear if the image transmission was unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 

o Images that have been sent will be saved in an image 
transfer folder on the destination device. 

o Images received using "Image transfer" in the 
Bluetooth Information Exchanger will be saved in the 
"Image Box" in "Image transfer".  
 
 

o You can use Properties under the Bluetooth 
Information Exchanger to change the location of the 
"Image Box" folder on the hard drive. 

Sending images to a PC or PDA (by right-clicking the mouse) 



1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding 

2. Right-click on the file you wish to send, and then click on its 
destination from [to Bluetooth]  
 
 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [to Bluetooth]->[Search other devices].  
 
 
Once the devices have been detected, the message 
below will appear. Please select the destination device, 
and then click on the [Send] button.  
 



 

 
The image will be sent.  
If the image has been sent successfully, the message below will appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the image transmission was unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 



o When you send images by right-clicking the mouse, 
the image data that has been sent will be saved in the 
image transfer shared folder on the destination device. 
This is also the case when you send images using 
icons. 

 
 

 
 

 

 Exchanging business card data with a PC or PDA [OPP] 
You can exchange business card data with a Bluetooth-enabled PC or PDA.  
Business card data are exchanged using "Object Push" under Bluetooth Information 
Exchanger. 

 

 Note 

• Data compliant with the "vCARD" standard are the only type of 
business card data able to be sent and received with "Object Push".  
Business card data can be used by applications such as Microsoft 
Outlook. 

• Business card data can be created in vCARD format by Microsoft 
Outlook and other similar applications.  
"Creating business card data in the vCARD format" 

• You can send business card data directly from Microsoft Outlook.  
"Sending business card data from Outlook" 

• The OPP profile must be supported by the PC or PDA of the other 
party. 

Selecting a business card and sending it to a PC or PDA (using icons)  
Selecting a business card and sending it to a PC or PDA (by right-clicking the 
mouse)  
Sending your personal business card  
Receiving a business card from another party  
Exchanging business cards  

 Procedure 
¦Selecting a business card and sending it to a PC or PDA (using icons) 



Select a business card you wish to send from among all the business card data you 
have already received through exchanges with your business or other contacts, and 
then send it to another party. 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 
 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Object Push] icon  
A list of devices will appear in the [Object Push] window.  
 



 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [Bluetooth]->[Search Devices].  
A device search will be performed. 

4. Use the mouse to drag and drop the business card you wish to 
send over the destination icon  
In this case, the business card will be sent to a PC named "PC-1".  
 
 

 
The business card will be sent.  

 Note 

o When you try to send a business card, a message 
requesting permission to receive the card may appear 
on the device belonging to the other party (i.e., on the 
receiving end). The content of the message will vary 
with the Bluetooth software installed on the 



destination device, so please be sure to follow the 
instructions provided. If you are using the Bluetooth 
Utility, a message similar to the one below will appear.  
 
 

 
If the business card has been sent successfully, the message below will 
appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the business card transmission was 
unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Memo 

o Data that have been sent will be saved in a folder for 
exchanged business cards on the destination device. 

o You can configure an associated application (Microsoft 
Outlook etc) to start automatically when you have 
received a business card, allowing you to view the 
card details.  
 
 



 
 
 
You can use Properties under Bluetooth Information 
Exchanger to configure whether or not you would like 
such an application to start automatically. 

Selecting a business card and sending it to a PC or PDA (by right-clicking the 
mouse) 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Right-click on the business card you wish to send, and then click 
on its destination from [to Bluetooth]  
 



 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [to Bluetooth]->[Search other devices].  
 
 
Once the devices have been detected, the message 
below will appear. Please select the destination device, 
and then click on the [Send] button.  
 
 

 
The business card will be sent.  

 Note 

o When you try to send a business card, a message 
requesting permission to receive the files may appear 
on the device belonging to the other party (i.e., on the 



receiving end). The content of the message will vary 
with the Bluetooth software installed on the 
destination device, so please be sure to follow the 
instructions provided.  
If you are using the Bluetooth Utility, a message 
similar to the one below will appear.  
 
 

 
If the business card has been sent successfully, the message below will 
appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the business card transmission was 
unsuccessful.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 

o Data that have been sent will be saved in a folder for 
exchanged business cards on the destination device. 

¦Sending your personal business card 
You can prepare a business card bearing your name and other details such as your 
company and telephone numbers, and then send it to another party. 



 Note 

• Please use Properties under Bluetooth Information Exchanger 
beforehand to configure which data to use for your own business card. 

• You can only have one business card registered as your own that is 
able to be sent. 

1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 
 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Object Push] icon  
A list of devices will appear in the [Object Push] window.  
 



 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [Bluetooth]->[Search Devices].  
A device search will be performed. 

 
4. Right-click on the destination icon, and then click on [Send 

business card To]  
In this case, your personal business card will be sent to a PC named 
"PC-1".  
 
 

 
 
 
The business card will be sent.  

 Note 



o When you try to send a business card, a message 
requesting permission to receive the files may appear 
on the device belonging to the other party (i.e., on the 
receiving end). The content of the message will vary 
with the Bluetooth software installed on the 
destination device, so please be sure to follow the 
instructions provided. If you are using the Bluetooth 
Utility, a message similar to the one below will appear.  
 
 

 

o Business cards that have been sent will be saved in the 
Inbox of the destination party. 

If your business card has been sent successfully, the message below will 
appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the business card transmission was 
unsuccessful. Please click on the [OK] button to close the message, and 
repeat the procedure.  
 
 

 

 Note 

o Data that has been sent will be saved in a folder for 
exchanged business cards on the destination device. 

¦Acquiring a business card from another party 



You can use your PC to acquire a business card from a party containing their details. 
1. Turn on the PC or PDA  

Confirm that a Bluetooth connection has been enabled before 
proceeding 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 
 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Object Push] icon  
A list of devices will appear in the [Object Push] window.  
 



 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [Bluetooth]->[Search Devices].  
A device search will be performed. 

 
4. Right-click on the icon of the party whose card you wish to 

acquire, and then click on [Receive business card]  
In this case, the business card of the other party will be acquired from 
a PC named "PC-1".  
 
 

 
 
 
The business card will be received. 

 Note 



o When you try to acquire a business card, a message 
requesting permission to send the files may appear on 
the device belonging to the other party (i.e., on the 
sending end). The content of the message will vary 
with the Bluetooth software installed on the 
destination device, so please be sure to follow the 
instructions provided.  
If you are using the Bluetooth Utility, a message 
similar to the one below will appear.  
 
 

 

If the business card has been received successfully, the message below will 
appear.  
Please click on the [OK] button.  
 
 

 
 
 
The message below will appear if the business card was unsuccessfully 
received.  
Please click on the [OK] button to close the message, and repeat the 
procedure.  
 
 

 

 Note 

o Business card data that have been received will be 
saved in the Inbox under "Object Push".  
You can use Properties under the Bluetooth 
Information Exchanger to set the location of the Inbox 
on the hard drive. 

¦Exchanging business cards 
Simultaneously exchange your business card with one belonging to another party. 



1. Turn on the PC or PDA  
Confirm that a Bluetooth connection has been enabled before 
proceeding. 

2. Double-click on the Bluetooth Information Exchanger icon on the 
Desktop  
 
 

 

 Note 

o Alternatively, opening Explorer and clicking on the 
Bluetooth Information Exchanger folder will produce 
the same result.  
 
 

The [Bluetooth Information Exchanger] window will appear. 

3. Double-click on the [Object Push] icon  
A list of devices will appear in the [Object Push] window.  
 



 

 

 Note 

o If the desired device does not appear in the list, please 
confirm that the device has been turned on, and then 
select [Bluetooth]->[Search Devices].  
A device search will be performed. 

 
4. Right-click on the icon of the party with whom you wish to 

exchange business cards, and then click on [Object Push]  
In this case, the business cards will be exchanged with a PC named 
"PC-1".  
 
 

 
 
 
The business card from the party who executed the "Exchange 
business cards" command will be sent first. 

 Note 



o When you try to send a business card, a message 
requesting permission to receive the files may appear 
on the device belonging to the other party (i.e., on the 
receiving end). The content of the message will vary 
with the Bluetooth software installed on the 
destination device, so please be sure to follow the 
instructions provided.  
If you are using the Bluetooth Utility, a message 
similar to the one below will appear.  
 
 

 
A message of confirmation will appear if the card has been successfully sent. 

 Note 

o Business cards that have been sent will be saved in the 
Inbox of the destination party. 

Once your business card has finished being sent, the program will start 
receiving the business card belonging to the other party. 

 Note 

o When a business card is to be received, a message such 
as the one below may appear on the device belonging 
to the other party.  
Please click on the [Yes] button if you give permission 
for the business card to be sent.  
 
 

 
A message of confirmation will appear if the card has been successfully 
received. 

 Note 

o Business cards that have been received will be saved in 
the "Inbox" under "Object Push".  
You can use Properties under the Bluetooth 



Information Exchanger to set the location of the Inbox 
on the hard drive. 

 
 

 
 

 

 
Synchronising information using ActiveSync 
[SPP] 

This section describes how to synchronize information on your PDA (calendars, 
contacts, inboxes etc) with your PC using Microsoft ActiveSync.  
When you connect via Bluetooth instead of with a standard cable, you will always 
be able to synchronise your data without the hassle of having to connect the cable.  

 
Connecting using ActiveSync  
Establishing a partnership between ActiveSync and a PDA  
Finishing an ActiveSync connection  
Cancelling a partnership 

 Important 
• Please use ActiveSync v.3.7 or higher. Also please establish a 

partnership between the devices using a USB or infrared link before 
you connect via Bluetooth. 

• Please refer to the ActiveSync Help or other manuals for information 
on how to use the application. 

• Microsoft Outlook 2002 or another schedule management tool must 
also be installed on the PC. 

 Connecting using 
ActiveSync 

Both the PC and PDA must be set up in order for a connection to be established.  
 
 
¦Preparing the PC 

 Procedure 
1. On the PC, click on [Start]->[All Programs]->[Microsoft 

ActiveSync]  
The initial ActiveSync set-up window will appear.  
It is assumed in the explanation below that no ActiveSync 
connections have been established with other devices.  



 
 

 

2. Click [File]->[Connection Settings]  
 
 

 
 
 
The [Connection Settings] window will appear. 

3. Place a check next to [Allow serial cable or infrared connection to 
this COM port], and then select "COM7".  
 



 

 

 Note 

o In the standard set-up, the port is configured to 
"COM7" (refer to Steps (3) and (4) under "Preparing 
the PDA" below). When using a different port, please 
also change the port number selected in this window. 

Preparing the PDA 

 Procedure 
1. Tap on the Bluetooth icon in the bottom right of the screen  

 
 

 
 Important 

o The graphic above shows an example of a PDA 
operating window.  



The connection procedure may be different depending 
on the manufacturer or model of PDA you use. Please 
refer to the product instruction manuals for further 
details. 

The [Bluetooth Settings] window will open.  
The message "Connection not registered" will appear if no Bluetooth device 
has been registered.  
 
 

 
 
 
Please tap on [OK] to close the message. 

2. Double click on [Tools]->[Search for peripheral components]  
 
 

 
 



 
The application searches for nearby Bluetooth devices. 

3. Tap and hold on the destination PC icon, and then select [Update 
Services]  
 
 

 
 
 
A search for services will be carried out, and then a list of service 
names and their connection status will appear as list in the lower 
window.  
 
 

 

4. Tap and hold on "COM7" from the list of service names, and 
then select "Register ActiveSync".  
 



 

 

5. Tap [OK] in the confirmation message window  
 
 

 
 
 
An ActiveSync connection will be initiated. 

 Establishing a partnership between ActiveSync and a 
PDA 

Once a connection has been successfully established with a PDA, the procedure for 
establishing a partnership with the PDA will be started by the ActiveSync 
application on the PC.  
Performing this set-up procedure will enable data to be synchronised between your 
PC and PDA. 



 Procedure 
1. In the [New Partnership (Set Up a Partnership)] window, select 

"Standard partnership", and then click on the [Next] button  
 
 

 
 
 
The [New Partnership (Specify Data Synchronisation Method)] 
window will appear. 

2. Select "Synchronise with this PC", and then click on the [Next] 
button  
 
 

 
 
 



The [New Partnership (Select Synchronisation Settings)] window 
will appear. 

3. Select the type of information to be synchronised between your 
PC and PDA, and then click on the [Next] button  
 
 

 
 
 
The [New Partnership (Completing Setup)] window will appear. 

4. Click on the [Finish] button  
 
 

 
 
 
When you click on the [Finish] button, ActiveSync will begin to 



synchronise your information.  
 
 
[Confirming changes]  
 
 

 
 
 
 
 
[Synchronization complete]  
 
 

 
 
 
While the ActiveSync connection is active, synchronization will be 
performed whenever information is changed on either the PC or the 
PDA.  
 
 
Once a partnership has been established, every time you start your 



PC (and PDA) thereafter, a Bluetooth connection will be opened and 
ActiveSync will synchronize your information. 

 Finishing an ActiveSync connection 

Follow the procedure below on your PDA if you want to end an ActiveSync 
connection manually. 

 Procedure 
1. Tap and hold on "COM7" in the Bluetooth Settings window, and 

select [ActiveSync Release]  
 
 

 

 Cancelling a partnership 
Follow the procedure below from the ActiveSync window on the PC if you want to 
cancel the partnership between your PC and PDA. 

 Procedure 
1. Click on [File] -> "Delete partnership"  

 
 



 
 
 
Click on the [Yes] button when the confirmation message appears. 

 Note 

o If you wish to create another ActiveSync connection, 
you will have to repeat the above procedure to re-
establish a partnership. 

 
 
 

 
 

 

 Using a Bluetooth-compatible camera [BIP] 
By connecting a Bluetooth-compatible digital camera to your PC via Bluetooth, you 
will be able to operate the camera shutter from the PC and transmit the captured 
images to it as well. 

 
Connecting the camera  
Taking pictures  
Viewing images saved on your PC 

 Connecting the camera 
Use the "Remote Camera" tool in the Bluetooth Utility to connect the camera to 
your PC. 



 Procedure 
1. Click on [Start ]->[All Programs]->[Bluetooth]->[Remote Camera]  

 Note 

o In Windows 2000, click on [Start]->[Programs]-
>[Bluetooth]->[Remote Camera]. 

 
 
 
The [Remote Camera] window will appear. 

2. Turn on the camera, and set it to be connectable via Bluetooth 

 Note 

o Different cameras are operated in different ways, 
depending on the manufacturer and model used. 
Please refer to the instruction manual for further 
details on how to operate your camera. 

3. Click on the [Camera Search...] button  
 
 

 
 
 
The camera will be detected and its icon displayed.  
 



 

 

4. Right-click on the camera icon, and select [Connect]  
 
 

 

The camera will be connected, and images from the camera will appear on-
screen.  
 
 

 

 Taking pictures 
By placing the mouse cursor over the on-screen image, the camera's operating 
window will appear.  
You can operate the camera from this window.  
 



 

 

 Procedure 
Taking a single picture 

1. Click on the button in the operating window.  
A single image will be captured and sent to the PC.  
 
 

 
Taking several consecutive frames  

1. Click on the button in the operating window  
A succession of images will be captured and sent to the PC.  
 



 

 

 Note 

o The remote camera shutter cannot be operated while 
the camera is connected to the PC. 

o The number of consecutive pictures taken can be set to 
anywhere between 2 and 16 

1. In the [Remote Camera] window, click on [Bluetooth]-
>[Properties]->[Consecutive Image Settings]  
 
 

 
 
 
The [Change number of consecutive images] dialog box 
will appear 

2. Click on the [<][>] buttons to select the number of 
consecutive images to be captured  
 
 

 
2.  

 Important 



o Images are not only sent to the PC, but are stored in the 
camera's on-board memory as well.  
Please be aware of the remaining memory capacity 
when you are taking a large number of pictures. 

o Large file sizes are common for high-resolution images, 
and may take some time to be transferred to the PC. 

 Viewing images saves on your PC 

A "Remote Camera" folder will be created in the "Bluetooth" folder under "My 
Documents" during initial set-up. A folder bearing the same name as the camera will 
be created in it, and images will be saved in this folder.  
Click the [Explorer] button in the [Remote Camera] window to display the folder 
where the images have been saved. 

 

 Note 

• This window is an example showing pictures when [Filmstrip] has 
been selected from the [View] menu in Explorer. 

 
 

 
 

 



 Using a headset to communicate [HSP] 
This section provides a description of how to use a Bluetooth-compatible wireless 
headset to communicate (chat) using Microsoft NetMeeting or other software.  

 
Registering the headset  
Making a connection to the headset  
Disconnecting from the headset 

 Registering the 
headset 

 

 Procedure 
1. Right-click on the Bluetooth icon in the tasktray, then click on 

[Add New Connection Wizard]  
 
 

 

 Note 

o Alternatively, you can click on [Start]>[All 
Programs]>[Bluetooth]>[Bluetooth Settings], then 
click on [New Connection] in the [Bluetooth Settings] 
screen that has opened. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] screen will appear. 

2. Turn the headset power on  
Once you have turned on the headset, set the mode to enable a 
Bluetooth connection.  

 Important 
o The procedure for operating the headset may differ 

depending on the manufacturer and model.  



Please consult your user guide for a detailed 
description of how to operate the unit. 

3. Confirm that [Express Mode] has been selected, then click on the 
[Next] button  
 
 

 
 
 
The [Add New Connection Wizard (Searching for Bluetooth 
Devices)] screen will appear.  
 
 

 
 
 
Once the device search has been completed, the [Add New 
Connection Wizard (Select a Device)] screen will appear. 



4. Select the name of the headset device from the list, then click on 
the [Next] button  
 
 

 

5. Answering with the headset  
If the service has been properly detected, a screen will appear 
indicating that the headset is being called, and a tone will accordingly 
sound in the headset.  
 
 

 
 
 
Please press the headset switch.  

 Important 
o The procedure for operating the headset may differ 

depending on the manufacturer and model.  
Please consult your user guide for a detailed 
description of how to operate the unit. 

The [Add New Connection Wizard (Configuring (Connecting to Voice 
Circuit))] screen will appear, and device configuration will be performed. 

 Note 



o If you are connecting to the headset for the first time, 
or if another Bluetooth audio device has not yet been 
registered, the following [Found New Hardware 
Wizard] screen will appear, from which you can 
proceed to install the driver.  
 
 
If another audio device has already been registered 
(i.e., the driver has been installed), you can proceed to 
Step 9 without having to install the driver. 

6. Click on the [Next] button  
 
 

 
 
 
The [Install Hardware] screen will appear. 

7. Click on the [Continue Anyway] button  
The following screen will appear automatically. You may disregard it 
and click on the [Continue Anyway] button.  
 
 



 
 
 
The [Add New Connection Wizard (Completing the Found New 
Hardware Wizard)] screen, which is the final screen of the 
installation wizard, will appear. 

8. Click on the [Finish] button  
 
 

 
 
 
Once driver installation is complete, the [Add New Connection 
Wizard (Enter Connection Name)] will appear. 

9. Confirm the information you have entered, and click on the [Next] 
button  
 
 



 
 
 
The [Add New Connection Wizard (Completing the Add New 
Connection Wizard)] screen will appear. 

10. Click on the [Finish] button  
 
 
The configuration information will be registered, and an icon will be 
displayed in the [Bluetooth Settings] screen.  
 
 

 
 Making a connection to the headset 

You can make a connection to the headset from an icon that has been registered in 
[Bluetooth Settings]. 

 Important 
• Before making a connection to the headset, please check that you have 

turned on the headset's power, and that it has been enabled for a 
Bluetooth connection. 

Please ensure that the following audio-related applications have been closed 
before you connect the headset to your PC.  

o Windows Media Player, BeatJam, InterVideo 
WinDVD and other music/audio playback software  

o Windows Messenger and other e-conferencing 
software  

If you wish to use these applications, please terminate the headset connection 
before you launch them.  



 Procedure 
1. Right-click on the headset icon, then click on [Connect].  

 
 

 

2. Answer with the headset  
   
A screen will appear indicating that the headset is being called, and a 
tone will accordingly sound in the headset.  
Please press the headset switch.  
 
 

 
 
 
If the connection has been properly established, the icon's appearance 
will change to indicate a connected state.  
 
 

 
 
 
You may now launch conferencing and voice-recognition software 
and use the headset. 



 Disconnecting from the headset 

Please follow the steps below to disconnect from the headset. 

 Procedure 
1. Right-click on the headset icon in the [Bluetooth Settings] screen, 

then click on [Disconnect].  
 
 

 
 
 
A message will appear, requesting confirmation that you wish to 
disconnect. Click on the [Yes] button.  
The icon on the [Bluetooth Settings] screen will appear as shown 
below, indicating that the device has been disconnected.  
 
 

 
 
 

 

 Making a device undiscoverable to other users 
For security purposes, you may not wish your device to be detected by other 
Bluetooth users. The procedure for accomplishing this is provided below. 

 Procedure 
1. Right-click on the Bluetooth icon in the task tray, and click on 

[Device Properties & Security]  
 
 



 
 
 
The [Device Properties] window will appear. 

2. Select [Non-discoverable mode] in [Discoverability mode] under 
the [Security] tab, and then click on the [OK] button  
 
 

 
 
 
Your device will now be undetectable by other users, even when they 
search for other devices. 

 Note 

• Other devices are still able to establish connections with your device 
even if you have enabled the Non-discoverable mode.  
Please enable "Non-connectable mode" if you wish to reject 
connections from other devices. 

Related topic: "Bluetooth Manager" 
 
 



 
 
 

 

 Encrypting the content of your transmissions 
Since Bluetooth communication is conducted wirelessly, there is always the 
possibility that a third party may be able to intercept your transmissions.  
You can use encryption to render the content indecipherable to anyone who 
manages to intercept it. 

 Important 
• Encrypting your transmissions will still not guarantee complete 

security. Accordingly, please be aware that transmitting data is 
conducted with an element of risk for the user. 

 Procedure 
1. Right-click on the Bluetooth icon in the task tray, and click on 

[Device Properties & Security].  
 
 

 
 
 
The [Device Properties] window will appear. 

2. Select [Link Level Enforced Security] in [Security Mode] under 
the [Security] tab, put a check next to [Encryption], and then 
click on the [OK] button  
 



 

 

 Note 

• Once you have configured the security mode, a window will appear 
when you first make a connection to another device, prompting you 
to enter a Bluetooth passkey (PIN code).  
Please click on the [OK] button after you have entered the passkey.  
 
 

 

• The window in which you enter the passkey will not appear once you 
have connected more than two times to the device.  
 
 
 
 
Related topic: "Bluetooth Manager"  

 
 

 
 



 

 
Changing the default 
connection 

The "default connection" refers to the dial-up connection configured for use 
whenever a connection is made to the Internet.  
If several connections have been registered, you can change the default connection 
by following the procedure below. 

 Procedure 
1. Start Internet Explorer 

2. Click on [Tools]->[Internet Options...]  
 
 

 
 
 
The [Internet Options] window will appear. 

3. Click on the [Connections] tab  
 
 

 
 
 



In this window, "Direct Connection" is set as the default, and "Never 
dial a connection" has been selected.  
Change the settings so that "London A" will always be dialled when 
you connect to the Internet. 

4. Select "Always dial my default connection"  
 
 

 

5. Click on "London A", and then click on the [Set Default] button  
 
 



 
 
 
"London A" has been changed to the default connection.  
 
 

 

 Note 

• Alternatively, if you wish to connect to the Internet from a LAN in a 
company or other environment where a LAN can be accessed, select 
"Never dial a connection" if you have a dial-up configuration, but do 
not want dial-up to occur automatically. 



• When connecting to the Internet via a LAN, you must enter the 
appropriate LAN settings under [LAN Settings...]. 

 
 

 
 

 

 Sending business card data from Outlook 
This section describes how to send business card data wirelessly using Microsoft 
Outlook  

 Note 

• The explanation below relates to an example in which Microsoft 
Outlook 2002 has been used to perform the procedure. Subtle 
differences may arise when using other versions of the software. 

 Sending business card 
data 

You can send business card data directly from the "Contacts" window in Outlook. 

 Procedure 
1. Start Microsoft Outlook, and open the "Contacts" window  

 



 

2. Double-click on the contact whose details you wish to send as a 
business card  
 
 
The details of the contact you selected will appear.  
 



 

3. Click on the [to Bluetooth] from the toolbar  
 
 

 
 
 
The [Device List] window will appear. 

 Note 

o If the [to Bluetooth] button does not appear on the 
toolbar, please refer to Installing business card-
sending functionality in Outlook as an Add-in" below 
and change the settings accordingly.  

 
4. Select the destination for the business card data, and then click on 

the [Send] button  
 



 

 

 Note 

o If you cannot find the destination device in the list, 
please click on the [Searching for devices] button to 
discover it.  

The business card will be sent.  
If the business card has been sent successfully, the message below will 
appear.  
 
 

 

 Note 

o If the transmission was unsuccessful, please attempt to 
send the data once more after having confirmed the 
operating conditions (power status, security settings, 
etc) of the destination device. 

 
 
Installing business card-sending functionality in Outlook as an Add-in 
You can install one of the functions of the Bluetooth Utility in Outlook as an "Add-
in", which will enable you to send business cards from the Outlook toolbar. 

 Procedure 
1. Click on [Tools]-[Options...] in Outlook  

 
 



 
 
 
The [Options] dialog box will appear. 

2. Select the [Other] tab, and then click on the [Advanced Options...] 
button in the "General" field  
 
 



 
 
 
The [Advanced Options] dialog box will appear 

3. Click on the [COM Add-Ins...] button  
 
 

 
 
 
The [COM Add-Ins] dialog box will appear. 

4. Click on the [Add...] button  
 



 

 
 
 
The [Add Add-In] dialog box will appear. 

5. Select "TosBTAddin.dll", and then click on the [OK] button  
 
 

 

 Note 

o "TosBTAddin.dll" can be found on the hard drive at 
the address below.  
C:\Program Files\Toshiba\Bluetooth Toshiba Stack 

6. Confirm that "Send to Bluetooth" has been added to the list and 
that a check appears next to it, and then click on the [OK] button  
 



 

 
This will complete the Add-in process. 

 
 

 
 

 

 
Manually creating a virtual Bluetooth COM 
port 

In order for a PC to connect to and communicate with a Bluetooth device, the 
Bluetooth Utility will create a gateway for data to be exchanged between the 
respective devices. This gateway is known as a "port" (or "virtual COM port").  
 
 
Since one virtual COM port will be allocated to each device, trouble-free 
communication will still be possible even if several devices are being used.  
 
 
When you use the Bluetooth Utility, a virtual COM port will be automatically 
created on set-up; however, virtual COM ports can be created manually if so needed.  

 Note 

• Bluetooth Manager must be active in order for you to be able to use 
Bluetooth Local COM. 

 Clients and servers 
When Bluetooth communications are performed, there will always be a 
"client/server" relationship between the various devices. A "client" is a device that 
sends certain requests to another device, while a "server" is a device that provides a 
service on receipt of such requests from another device.  
 
 
For example, when a PC issues a print command to a wireless printer, the PC 
functions as the client, while the printer functions as the server.  
When a PDA or other device attempts to receive files located on a PC by means of 
file transfer protocol, the PC functions as the server, while the PDA functions as the 
client.  
 



 
Virtual Bluetooth COM ports can be created both for clients and servers.  

• Bluetooth virtual COM port for a client  
Virtual COM port used when your device is the client, and requests 
are sent to another device. 

• Bluetooth virtual COM port for a server  
Virtual COM port used when your device is the server, and requests 
are received from another device. 

 Creating a virtual COM 
port 

Bluetooth virtual COM ports are created according to the procedure below. 

 Procedure 
1. Click on the [Printers and Other Hardware] icon in the Control 

Panel  
 
 

 
 
 
The [Printers and Other Hardware] window appears. 

2. Double-click on the [Bluetooth Local COM] icon  
 
 



 
 
 
The main Bluetooth Local COM window will appear. 

 Note 

o Even when the Control Panel appears in Classic view, 
please simply click on the [Bluetooth Local COM] 
icon.  
 
 

 
o No such distinction between viewing formats exists in Windows 

2000. 
3. Click on the [Add...] button  

 
 



 
 
 
The [Bluetooth Local COM Wizard] window, from where you can create a virtual 
COM port, will appear.  
 
 

 
 
 
Start from this window when creating Bluetooth virtual COM ports for either 
servers or clients.  
 
 
Creating a Bluetooth virtual COM port for a client  
Creating a Bluetooth virtual COM port for a server 

 Deleting a virtual COM port 
Please follow the procedure below to delete a virtual COM port when it is no longer needed. 

 Note 
• You can only delete virtual COM ports created by the Bluetooth Local COM utility. 
1. Select the port you wish to delete from the [Bluetooth Local COM] window, 

and then click on the [Delete] button  



 
 

 
 
 
A message will appear asking you to confirm that you wish to delete the port. 

2. Click on the [Yes] button  
 
 

 
 
 
The port will be deleted. 

3. Click on the [OK] button  
 
 

 

 
 

 



 

 

 Bluetooth Settings 
This section provides detailed information on the [Bluetooth Settings] window.  

 Main 
window 

 

 Menu 
[Bluetooth] menu 

Category Description 
Add New 
Connection 

Opens the [Add New Connection Wizard] window, and then searches 
for new devices. 

Connect Connects to selected device. 
Disconnect Disconnects from selected device. 
Details Displays detailed information about selected device.  

 
 



 
Delete Deletes selected device. 
Create 
shortcut on 
Desktop 

Creates a shortcut icon for the selected device on the Desktop. 

Rename Changes the name of the device you have selected. 
Change Icon Changes the icon of the device you have selected. 
COM Auto 
Connect 
Settings 

Opens the [COM Auto Connect Settings] window, and allows you to 
enable/disable Auto Connect.  
Displays the device connection name and port used. Check the box to 
enable Auto Connect, and remove the check to disable Auto Connect. 
You will need to connect manually to use a device in the latter case.  
 
 

 
AV player 
selection 

Opens [Select AV Payer] window, and allows you to select the 
application to be used when you want to play sound files or CDs.  
 
 



 
Exit Closes the [Bluetooth Settings] window. 

[View] menu 

Category Description 
Large icons 
Small icons 
List 
Details 

Changes the way icons are displayed on a device. 

[Help] menu 

Category Description 
Help Opens the Bluetooth Utility User Guide. 
Version Displays the version information for Bluetooth Settings.  

 
 

 
 

 Device List 
Displays a list of devices that have been registered in [Bluetooth Settings].  



 Function buttons 
 

Category Description 
New 
Connection 

Opens [Add New Connection Wizard] window. 

Details... Shows details of selected device. 
Delete Deletes selected device. 
 
 

 
 

 

 One-touch connection to Bluetooth devices 
Creating a Shortcut 

If you have created a shortcut icon on the Desktop, you can easily establish a 
connection to a device that has been registered using Bluetooth Settings without 
having to open the Bluetooth Settings window. 

 Procedure 
 

1. Right-click on Bluetooth icon in task tray and click on [Bluetooth 
Settings]  
 
 

 

 Note 

o Alternatively, you can click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings]. 

The [Bluetooth Settings] screen will appear, from where you can create a 
Shortcut entitled "Bluetooth Mouse."  

2. Right-click on the [BT-Mouse-01] icon, and then click on [Create 
Shortcut on Desktop]  
 



 

 
A shortcut icon entitled "BT-Mouse-01" will appear on the Desktop.  
 
 

                        
Establishing a connection from the Shortcut 

1. Double-click on the "BT-Mouse-01" icon from the Desktop  
 
 
The [Bluetooth Settings] window will open.  

2. Turn on the mouse, set it to Bluetooth-connectable mode, and 
then click on the [OK] button in the [Bluetooth Settings] window.  
 
 

 
 
 
The mouse will be connected.  
 
 

 
 
 

 



 

 

 Manually connecting to a Bluetooth device 
After a keyboard or mouse (HID profile), printer (HCRP or SPP profiles), or other 
device has been set up for the first time, subsequent connections will be 
automatically restored whenever you operate the device, print out a document from 
the PC, or perform another similar activity.  
Should the connection not have been properly restored, please establish a manual 
connection to the device using the procedure below. 

 Procedure 
 

1. Right-click on Bluetooth icon in task tray and click on [Bluetooth 
Settings]  
 
 

 

 Note 

o Alternatively, click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings]. 

The [Bluetooth Settings] screen will appear, from where you can create a 
Shortcut entitled "BT Mouse."  

2. Right-click on the [BT-Mouse-01] icon, and then click on the 
[Connect] button  
 
 



 
 
 
The [Bluetooth Settings] window will open.  

3. Turn on the mouse, enable Bluetooth-connection mode, and click 
on the [OK] button in the [Bluetooth Settings] window.  
 
 

 
 
 
The mouse will be connected.  
 
 

 

 Note 

o If you wish to manually disconnect a device, right-
click on its icon and click [Disconnect].  
 
 



 
 
 
When the following message appears, click on the 
[Yes] button.  
 
 

 
 
 

 
 

 

 Changing a connection icon 
You can change a device icon that has been registered on the Bluetooth Settings 
screen. 

 Procedure 
 

1. Right-click on the Bluetooth icon in the task tray, and then click 
on [Bluetooth Settings]  
 



 

 

 Note 

o Alternatively, click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings]. 

The [Bluetooth Settings] window will appear. Now try to change the icon for 
"My Mobile."  

2. Right-click on the "My Mobile" icon, and then click on [Change 
Icon]  
 
 

 
 
 
A list of available icons will appear. 

3. Select the icon, and then click on the [OK] button  
 
 



 
 
 
The new icon will appear.  
 
 

 
 
 

 
 

 

 Changing a connection icon name 
You can change a the name of a device icon that has been registered on the 
Bluetooth Settings screen. 

 Procedure 
 



1. Right-click on the Bluetooth icon in the task tray, and then click 
on [Bluetooth Settings]  
 
 

 

 Note 

o Alternatively, click [Start]->[All Programs]-
>[Bluetooth]->[Bluetooth Settings]. 

The [Bluetooth Settings] window will appear. Now try to change the 
connection name for "My Mobile" to "Pocket PC." 

2. Right-click on "My Mobile", and then click on [Change Name]  
 
 

 
 
 
You will now be able to enter a name.  
 
 

 



3. Enter "Pocket PC", and then hit the [Enter] key  
 
 
The new name will appear.  
 
 

 
 
 

 
 
 

 

 Bluetooth Manager 
This section provides detailed information on the settings categories in Bluetooth 
Manager.  

 Main 
menu 

 

Category Description 
Bluetooth Settings Opens [Bluetooth Settings] window. 



Wireless File 
Transfer 

Open the [Wireless File Transfer] window. 

Remote Camera Open the [Remote Camera] window. 

Add New 
Connection 

Opens the [Add New Connection Wizard] window. 

Device 
Properties&Security 

Displays Bluetooth device information on your PC.  
 
 
[General] tab  
 
 
Allows you to confirm the name, address and other settings 
displayed for other devices.  
 
 

 
 Note 

• [Device Name] is the only category 
able to be changed. If you wish to 
change the name of a device, enter the 
new name, and then click on the [OK] 
or [Apply] button. 

• Click on the [Default] button to restore 
the initial settings. 

[Security] tab  
 
 
Security-related (user) settings can be configured under this tab.  
 
 



 

 Note 

• Click on the [Default] button to restore 
the initial settings. 

Category Description 
Non-
discoverable 
mode 

Other devices will not 
be able to detect yours. Discoverability 

mode 
Discoverable 
mode 

Other devices will be 
able to detect yours. 

Non-
connectable 
mode 

Other devices will not 
be able to connect to 
yours.1) Connectability 

mode 
Connectable 
mode 

Other devices will be 
able to connect to 
yours. 

Non-pairable 
mode2) 

You will not receive 
pairing requests 
initiated from remote 
devices. Pairing mode 

Pairable mode 
You will receive pairing 
requests initiated from 
remote devices. 

Non-secure 
mode 

No security will be 
enforced. Security mode 

Link Level 
Security 
Enforced3) 

Requires Bluetooth 
passkey (PIN code) to 
be entered on 
connection with another 



device. 

Encryption Encrypts data to be 
transmitted. 

 
 
1) Selecting Non-connectable mode will cause connection 
requests to be rejected from any device, including registered 
ones. Device detection will still be possible.  
 
 
2) Selecting Non-pairable mode will make it impossible to bond 
with another device in a new connection relationship. Connection 
will be possible when a request has been received from a 
registered device. Device detection will still be possible.  
 
 
3) Devices to which you have initially connected by entering a 
PIN code will not require you to do so for future connections. 
Connection will still be possible even if Link Level Security has 
been selected.  

Power off Turns off Bluetooth 

 
(Turned 
off) 

 
 Important 

• Communication using Bluetooth will be 
impossible once it has been turned off. When 
you next wish to use Bluetooth, please right-
click on the Bluetooth icon in the task tray, and 
then click on [Power ON]. 

 

  
(Turned 

on) 

 
Service Properties Ensures security against various kinds of access from remote 

devices. 
Here you can enable or disable the following four typical services 
that are accessed remotely. 



 

 Note 

• This function is designed to provide 
robust security against access from 
remote devices. The "enable/disable" 
controls only relate to access made 
from remote devices. You will still be 
able to access remote devices from your 
local device, regardless of the 
individual settings. 

• Remove the tick from each button to 
disable the related (server) function. 

Category Description 
Bluetooth Information 
Exchange Service 

Ticking the box enables a (server) 
function that allows files, images, 
and business cards to be transferred 
from a remote device using 
Bluetooth Information Exchanger. 

PAN Networking 
Service 

Ticking the box enables a (server) 
function that allows networking to 
be performed from a remote device 
using the PAN Networking Service. 

Bluetooth COM Port 
Service 

Ticking the box enables a (server) 
function that allows COM Service to 
be performed from a remote location 
using the Serial Port Service. 

AV Remote Control 
Service 

Ticking the box enables a (server) 
function that allows remote control 
to be performed from a remote 
device using the AV Remote Control 
Service.  

Help Displays the Bluetooth Utility User Guide. 



Exit Exits Bluetooth Manager.  
 Important 

• When you exit Bluetooth Manager, Bluetooth 
communications will be disabled. When you 
next wish to use Bluetooth, please click on 
[Start]->[All Programs]->[Bluetooth]-
>[Bluetooth Settings] (in Windows 2000, click 
on [Start]->[Programs]->[Bluetooth]-
>[Bluetooth Settings]). 

 
 

 
 

 

 Bluetooth Information Exchanger 
This section provides detailed information on the settings categories in Bluetooth 
Information Exchanger. 

 Main window 

 

 Bluetooth menu 
 

Category Description 
Device 
Discovery 

Detects Bluetooth devices. 

Configuration Allows detailed setting of categories related to Bluetooth Information 
Exchanger.  
 
 



 
-[General] tab  
-[Mode] tab  
-[Inbox/Business Card] tab  
-[Shared folder] tab  
-[Image box] tab  
-[Associate] tab  
-[Transfer mode] tab  
-[Service security] tab  
-[Service class] tab  
-[Information] tab  
-[Version] tab 

Help Displays Bluetooth Utility User Guide. 

  

 Data exchange folders 
Three folders are available for data exchange: "Image transfer", "File transfer" and 
"Object Push".  

Category Description 

 

Click on the icon to display a list of devices. "Image box" is a folder on your PC used for 
transferring images.  
 
 



 

 

Click on the icon to display a list of devices. "Shared folder" is a shared folder on your PC used 
for transferring files.  
 
 

 

 

Click on the icon to display a list of devices. "Inbox" is a folder on your PC used for 
exchanging business cards.  
 
 



 
 
 

 
 

 
 

 

 Remote Camera 
This section provides detailed information on the settings categories in Remote 
Camera. 

 Main window 

 

 Menu 



 
 
[Bluetooth] menu 

Category Description 
Device 
Search 

Searches for remote cameras. 

Properties [Filter for Search Devices]  
 
 

 
 
 
The program may discover devices other than digital cameras, 
depending on which profiles are supported by those devices.  
 
 
Adjusting the setting to "Loose filtering" will increase the likelihood 
that devices other than those intended will be detected.  
The further you slide the setting towards "Tight filtering", the stricter 
will be the criteria determining device detection, and the lower the 
likelihood will be that irrelevant devices will be included.  
 
 
Please adjust the filtration level according to the results of the search.  
 
 
 
 
 
 
[Multi Shot]  
 
 
Allows you to set the number of consecutive images captured by your 
digital camera in the dialog box below (between 2 and 16 inclusive).  
 
 

 
 
 



 
 
 
 
[Pixel Size]  
 
 
Images will be sent to your PC after having been automatically 
converted to the size specified in the dialog box below, regardless of the 
size of the original image data.  
 
 

 
 
 
 
 
 
 
[Inbox settings]  
 
 
Opens the "Browse folders..." dialog box and allows you to select the 
folder where you would like your captured images to be saved. 

Exit Exits Remote Camera. 

[Help] menu  

Category Description 
Image 
monitor 
version 
information 

Displays version information for the image monitor.  
 
 

 
 



 List of cameras 
A list of cameras that have been registered as remote cameras will be displayed. 

 [Camera Search...] button 
Clicking on this button will execute a search for remote cameras. 

 

 Display images 
Images transferred to the PC from a remote camera will be displayed. 

 [Explorer...] button 
Clicking on this button will display the folders on the hard drive where images that 
have been transferred to the PC have been stored.  
 
 

 

 Note 



• A folder for saving your images will be created automatically.  

 Camera operation window 

 
 Camera images 

Images as seen through the lens of your remote camera will be displayed.  
 

 Display magnification 
The size of the operating window display can be adjusted from 100% (1x) to 300% 
(3x). 

 Important 
• Increasing the size of the operating window will impede its ability to display images, 

and will have an adverse effect on other processes being performed by your PC. 
Please adjust the magnification as appropriate for your intended use. 

 

 [Explorer...] button 
Clicking on this button will display the folders on the hard drive where images that 
have been transferred to the PC have been stored.  



 

 

 Shutter button (consecutive images) 
Clicking this button will cause the camera to take the number of images specified in 
[Consecutive image settings] under the [Bluetooth] menu and then send those 
images to your PC. 

 Shutter button (single images) 
Clicking this button will cause the camera to take one picture and then send the 
image to your PC.  
 

 

 

 Bluetooth Local COM 
This section provides detailed information on the settings categories in Bluetooth 
Local COM. 

 Main window 



 

 Port 
Displays a list of configured ports.  

 Description 
Displays the function of each port.  
Ports displayed as "Toshiba BT Port (COMxx)" are TOSHIBA Bluetooth virtual 
COM ports.  

 Owner 
Displays the application used to create those COM ports.  
The following information will appear for ports created by Bluetooth Local COM.  

COM port for 
client Local COM - Client 

COM port for 
server 

Local COM - Server [(name of service supplied by 
port)] 

 

 Function buttons 
 

Category Description 
Add Starts the Add COM Port Wizard. 

 Note 
• There can be up to 64 ports. If COM ports 1 to 64 already exist, you 

will not be able to add another port. 

Delete Deletes selected port. 
 Note 

• You can only delete COM ports created by Bluetooth Local COM.  

OK Click on this button to confirm settings information, and close the Bluetooth Local COM 
window. 

 
 



 

 

 
Wireless File 
Transfer 

This section provides detailed information on the settings categories in Wireless File 
Transfer. 

 Main window 

 

 Files/folders 
Displays a list of files/folders to be sent. 

 Devices to which data can be sent 
Displays other devices to which you are able to send files. Files will be sent to those 
devices that have been checked.  
Name   
Displays name of destination devices.  
 
Connection method  
Displays method used to connect to other devices. 

 Note 

• If a device to which you would like to send data is not listed, you can 
click on the [Search] button to search for other devices. 

 Function buttons 
 



Category Description 
Add Displays the window below, from where you can add files and/or folders you 

would like to send.  
 
 

 
Delete By selecting a file from the list and clicking on the "Delete" button, you can 

remove that file (i.e., the file will not be sent). 
Search Searches for Bluetooth devices. 
Cancel Closes the "Wireless File Transfer" window.  
Send Sends a file. 
 

 
 
 
 

 

 Troubleshooting 
This section describes possible causes and countermeasures to be considered when 
your Bluetooth device cannot be configured properly, functions abnormally or 
presents other problems related to its operation. 

 Basic 
understanding 

The section "What you need to know about using Bluetooth" describes the basic 
concepts to be aware of when using Bluetooth. Should you still encounter problems 
after having read through this information, please refer to the following list, which 
has been arranged according to application.  

 Troubleshooting by 
application 



• General operation of the Bluetooth Utility 
• Using a wireless modem station 
• Using an access point 
• Using a printer 
• Using a Bluetooth headset  
• Using a keyboard or mouse  
• Using a camera   
• Using a PDA  
• Using a mobile telephone  

 
 

 
 

 

 General operation of the Bluetooth Utility 
 

 Important 
• Please refer to "What you need to know about using Bluetooth" for an 

understanding of the basic concepts to be aware of when using 
Bluetooth. 

 Bluetooth Manager 
 

 
Bluetooth icon does not appear in task 
tray 

• If the Bluetooth icon does not appear in the task tray, Bluetooth 
Manager will not be active, which will prevent you from being able 
to use any of the functions of the Bluetooth Utility.  
Start the utilities as instructed below to enable Bluetooth Manager to 
start automatically and allow all functions to be utilized.  
 
 
Bluetooth Settings  
(from Windows XP)  
[Start] > [All Programs] > [Bluetooth] > [Bluetooth Settings]  
(from Windows 2000)  
[Start] > [Programs] > [Bluetooth] > [Bluetooth Settings]  
 
 
Remote Camera  
(from Windows XP)  
[Start] > [All Programs] > [Bluetooth] > [Remote Camera]  
(from Windows 2000)  



[Start] > [Programs] > [Bluetooth] > [Remote Camera]  
 
 
Wireless File Transfer  
(from Windows XP)  
[Start] > [All Programs] > [Bluetooth] > [Wireless File Transfer]  
(from Windows 2000)  
[Start] > [Programs] > [Bluetooth] > [Wireless File Transfer] 

 Bluetooth Settings 
 

 
Clicking on the [New Connection] button brings up the message "Unable to prepare 
Bluetooth." 

• The wireless communication switch is turned off.  
Please switch it on. 

 
Remote device(s) cannot be 
detected 

• The other device(s) may have been set to Non-discoverable mode.  
Please check the mode settings on the device. 

 
Services on a remote device are 
undiscoverable 

• The other device may be using a profile that is not supported by the 
Bluetooth Utility  
Please check the profile being used on the other device. 

• The following profiles are compatible with Bluetooth Settings. 
DUN, FAX, LAP, SPP, HID, HCRP, FTP, OPP, HSP, PAN and BIP 
Devices running profiles other than those above will not be able to be 
registered with Bluetooth Settings.  

 Bluetooth Information Exchanger 
 

 An error occurs when you try to send a file using the right-click menu. 

• Select and right-click on a file, and then you can choose either the 
FTP or OPP profile to use when you click on [Send to Bluetooth 
Device].  
If neither profile is supported by the destination device, the file will 
not be able to be sent from the right-click menu.  
 
 
The transmission will also fail if you use FTP to send a file to a 
device that only supports the OPP profile.  
Should this occur, please click on [Bluetooth]->[Profiles] under 
[Bluetooth Information Exchanger] to configure the Transfer mode.  



 Cannot open shared folder on remote device using [File Transfer]. 

• The other device may have a certain security level enforced (Non-
connectable mode etc). Please confirm the security settings of the 
other device.  
Please enter the correct password if you are asked to enter one.  

 Remote Camera 
• See "Using a camera" 

 Bluetooth Local COM 
 

 Cannot add port 

• A maximum of 64 virtual COM ports can be added. You will be 
unable to add another port if 64 ports have already been configured. 

 

 

 

 

 
Using a wireless modem 
station 

 

 Important 
• Please refer to "What you need to know about using Bluetooth" for an 

understanding of the basic concepts to be aware of when using 
Bluetooth. 

 Modem station cannot be detected 

• If the modem station is connected to and is being used by another 
device, the modem station will be undetectable even if you search for 
it.  

 Cannot connect to modem station 

• If the modem station is connected to and is being used by another 
device, no other device will be able to connect to the modem station. 

 Bluetooth passkey entry failed 

• The Bluetooth passkey (PIN code) comprises a sequence of 
alphanumeric characters, with the letters able to be rendered in upper 
and lower case.  
If [Caps Lock] is on, the Bluetooth passkey may not be able to be 
entered correctly.  



 Cannot connect to telephone line 

• Please ensure that the telephone cable is connected from the socket to 
the "LINE" terminal on the modem station.  

 Note 

o If the telephone cable has come loose because it has 
not been fully inserted into the socket, the resulting 
poor contact may prevent data from being transmitted 
accurately. 

o Communication will be impossible if the interior of the 
cable has been broken. Please replace the cable with 
another one. 

• Please ensure that the two slide switches on the underside of the main 
unit have been set to the "NORMAL" and "MODEM" positions 
respectively. 

 

 Cannot connect to the Internet 

• The telephone number of the connection (i.e., the telephone number 
for the access point of your Internet service provider) may not be 
correct. Please check the telephone number. 

• The user ID and/or password for the provider with whom you have 
signed up may have been entered incorrectly. Please check the user 
ID and password. 

• The default connection may have been configured with different 
settings. Please set the connection configured for mobile telephone 
use as the default connection. 

• When you place a call using a company switchboard or other 
exchange, the system may require you to enter a "0" before the 
telephone number itself. Please check the type of telephone line you 
are using. 

 Cannot send or receive faxes 

• Once you have registered a wireless modem station as your fax server, 
you will need to enter the fax settings from the [Printer and Faxes] 
window in the Control Panel.  
Please refer to "Using a modem station for fax transmissions" for 
information on the configuration procedure. 

• The telephone number of the fax destination may have been entered 
incorrectly. Please check the telephone number. 



• If the setting under COM Auto Connect Settings has been set to "Off", 
a connection will not automatically be established with the modem. 
Please connect to the modem manually. 

• When you place a call using a company switchboard or other 
exchange, the system may require you to enter a "0" before the 
telephone number itself. Please check the type of telephone line you 
are using. 

• The fax service may not have been enabled for sending (or receiving).  
Please check the settings by following the procedure below. 

1. Open [Printers and Faxes] from the Control Panel, 
right-click on the [Fax] icon, and then click on 
[Properties]  
 
 

 
 
 
The [Fax properties] window will appear. 

2. Select the [Device] tab, right-click on the modem 
you wish to use, and then click on [Properties]  
 



 

 

3. Select the [Send] tab, and then confirm that 
"Enable device to send" has been checked.  
 
 

 

4. Select the [Receive] tab, and then confirm that 
"Enable device to receive" has been checked (when 
you wish to receive faxes)  



 
 

 

5. Click on the [OK] button 
 
 

 
 

 

 
Using an access 
point 

 

 Important 
• Please refer to "What you need to know about using Bluetooth" for an 

understanding of the basic concepts to be aware of when using 
Bluetooth. 

 Access point cannot be detected 

• If the access point is connected to and is being used by another device, 
the access point will be undetectable even if you search for it. 

 Cannot connect to access point 

• If the access point is connected to and is being used by another device, 
no other device will be able to connect to the access point. 



 Cannot connect to LAN 

• The LAN cable may not be properly connected to the access point. 
Please check the connection status. 

 Note 

o If the LAN cable has come loose because it has not 
been fully inserted into the socket, the resulting poor 
contact may prevent data from being transmitted 
accurately. 

o Communication will be impossible if the interior of the 
LAN cable has been broken. Please replace the cable 
with another one. 

• The access point may not have been configured correctly, and may not 
be able to maintain the connection to the LAN.  
Please refer to the product instruction manual for information on how 
to configure your access point. 

 Cannot connect to the Internet 

• If you are using a LAN to connect to the Internet, the LAN 
environment of the company or location where you are trying to 
establish the connection may require you to connect via a proxy 
server .  
Please click here for information on configuring a proxy server. 

 
 

 

 

 Using a printer 
 

 Important 
• Please refer to "What you need to know about using Bluetooth" for an 

understanding of the basic concepts to be aware of when using 
Bluetooth. 

 Printer cannot be detected 

• If the printer is connected to and is being used by another device, the 
printer will be undetectable even if you search for it. 

 Cannot connect to printer 

• If the printer is connected to and is being used by another device, no 
other device will be able to connect to the printer. 



 Cannot print/garbled print output 

• The printer driver of the printer you are using may not have been 
installed correctly. Please refer to your product instruction manual 
and re-install the driver. 

• Please check to see if the printer has run out of paper, ink or other 
consumable item. 

• If you are using a printer while several Bluetooth devices are 
connected to the PC, the devices may not functional normally. Please 
disconnect the other devices and try to print again. 

 
 

 
 

 
 
 

 

 Using a Bluetooth Headset 
 

 Important 
• Please refer to "What you need to know about using Bluetooth" for an 

understanding of the basic concepts to be aware of when using 
Bluetooth. 

 Bluetooth Headset cannot be detected 

• If the Bluetooth Headset is connected to and is being used by another 
device, the Bluetooth Headset will be undetectable even if you search 
for it. 

 Cannot connect to Bluetooth Headset 

• If the Bluetooth Headset is connected to and is being used by another 
device, no other device will be able to connect to the Bluetooth 
Headset. 

• A Bluetooth connection will be impossible if the Bluetooth Headset is 
connected to a power adaptor.  
Please remove the power adaptor and re-connect. 

 Sound cuts out/cannot hear anything 

• Using a Bluetooth headset with other Bluetooth devices may cause 
problems such as interruptions in sound, reduced transfer speed or 
failure during file transfer, and disconnection of the other Bluetooth 



devices. We strongly recommend using a Bluetooth headset on its 
own, not in connection with other Bluetooth devices. 

• Please confirm that the Bluetooth Headset is being operated correctly 
(for example, ensure that the correct mode (audio or communications) 
mode has been selected). 

• Please confirm that the voice file or CD is being played back normally 
on your PC. 

• Please check the volume settings on your Bluetooth Headset and PC. 

• If Windows Media Player or another audio-related application is 
active when you try to connect your Bluetooth Headset, you may find 
it impossible to connect properly to the Bluetooth Headset, or even to 
use it at all.  
Please start such applications after you have connected to the 
Bluetooth Headset. 

 
 

 
 

 

 Using a keyboard or mouse 
 

 Important 
• Please refer to "What you need to know about using Bluetooth" for an 

understanding of the basic concepts to be aware of when using 
Bluetooth. 

 Keyboard or mouse cannot be detected 

• If the keyboard or mouse is connected to and is being used by another 
device, the keyboard or mouse will be undetectable even if you 
search for it. 

 Cannot connect to keyboard or mouse 

• If the keyboard or mouse is connected to and is being used by another 
device, no other device will be able to connect to the keyboard or 
mouse. 

 
 

 
 

 



 

 

 Using a camera 
 

 Important 
• Please refer to "What you need to know about using Bluetooth" for an 

understanding of the basic concepts to be aware of when using 
Bluetooth. 

 Camera cannot be detected 

• If the camera is connected to and is being used by another device, the 
camera will be undetectable even if you search for it.  

 Cannot connect to camera 

• If the camera is connected to and is being used by another device, no 
other device will be able to connect to the camera. 

 Images from the camera can be displayed, but no pictures can be taken 

• The memory card in the camera may be full.  
Please make a backup of all your necessary data on alternative media, 
then delete the images from the memory card, and ascertain how 
much free space remains. 

 Camera images do not appear in window 

• The camera may not have been set to remote camera mode (image 
browse mode, configuration mode, etc).  
 
 
Certain cameras will end the Bluetooth connection automatically if 
you change the settings in a mode other than remote camera mode. 
Please re-connect to the camera when you next wish to use the device 
in remote camera mode.  

 
 

 
 

 
 

 

 
Using a 
PDA 

 



 Important 
• Please refer to "What you need to know about using Bluetooth" for an 

understanding of the basic concepts to be aware of when using 
Bluetooth. 

 Cannot make an ActiveSync connection 

• Please confirm that you have installed ActiveSync v3.7 or higher on 
your PC. 

• ActiveSync is installed to COM7 as a default. Please refer to 
"Synchronising information using ActiveSync" and re-configure your 
ActiveSync connection.  
If a port other than COM7 has been used, please amend the 
ActiveSync connection settings accordingly. 

 Cannot locate a saved file 

• The type of file sent to your PDA, as well as the profile used to send 
the file, may affect where folders saved on your PDA are located.  
 
 
Examples:  
Images transferred to your PDA using "Image transfer" > saved in the 
"Image transfer" folder  
Images transferred to your PDA using "File transfer" > saved in the 
"Shared folder" 

 
 

 
 

 
 

 

 Using a mobile telephone 
 

 Important 
• Please refer to "What you need to know about using Bluetooth" for an 

understanding of the basic concepts to be aware of when using 
Bluetooth. 

 Mobile telephone cannot be detected 

• If the mobile telephone is connected to and is being used by another 
device, the mobile telephone will be undetectable even if you search 
for it.  



 Cannot connect to mobile telephone 

• If the mobile telephone is connected to and is being used by another 
device, no other device will be able to connect to the mobile 
telephone. 

 Cannot send images to mobile telephone 

• Please use the appropriate transfer method, according to the profiles 
supported by your mobile telephone.  
 
 
If OPP is supported: right-click on a file to send it  
 
 
If BIP is supported: use "Image transfer" under Bluetooth 
Information Exchanger to send images 

 Cannot connect to the Internet 

• The telephone number of the connection (i.e., the telephone number 
for the access point of your Internet service provider) may not be 
correct. Please check the telephone number. 

• The user ID and/or password for the provider with whom you have 
signed up may have been entered incorrectly. Please check the user 
ID and password. 

• The default connection may have been configured with different 
settings. Please set the connection configured for mobile telephone 
use as the default connection. 

 Cannot send or receive faxes 

• Once you have registered a mobile telephone as your fax server, you 
will need to enter the fax settings from the [Printer and Faxes] 
window in the Control Panel.  
Please refer to "Using a modem station for fax transmissions" for 
information on the configuration procedure. 

• The telephone number of the fax destination may have been entered 
incorrectly. Please check the telephone number. 

• If the setting under COM Auto Connect Settings has been set to "Off", 
a connection will not automatically be established with the modem. 
Please connect to the mobile telephone manually. 

• The fax service may not have been enabled for sending (or receiving).  
Please check the settings by following the procedure below. 

1. Open [Printers and Faxes] from the Control Panel, 
right-click on the [Fax] icon, and then click on 



[Properties]  
 
 

 
 
 
The [Fax properties] window will appear. 

2. Select the [Device] tab, right-click on the modem 
you wish to use, and then click on [Properties]  
 
 

 

3. Select the [Send] tab, and then confirm that 
"Enable device to send" has been checked.  
 



 

 

4. Select the [Receive] tab, and then confirm that 
"Enable device to receive" has been checked when 
you wish to receive faxes)  
 
 

 

5. Click on the [OK] button 



 
 

 
 
 

 

 Glossary 
This glossary provides definitions for Bluetooth-related terminology.  
You will be able to look up the meanings of any uncertain terms here.  
 
 

 
A2DP Profile  
Abbreviation of Advanced Audio Distribution.  
A Bluetooth profile allowing you to adjust the sound quality of wireless headsets 
and other audio devices.  

AVRCP Profile  
Abbreviation of Audio/Video Remote Control Profile. A Bluetooth profile enabling 
remote control functions to be sent and received. Remote control commands can be 
received by the Bluetooth Utility.  

 
Bluetooth Profile  
A specification that guarantees the connection to the service function of a remote 
Bluetooth device.  
For a Bluetooth device to send and receive information to and from another device, 
both devices must support shared profiles designated for each function, such as dial-
up networking, faxing, printing and human interface devices.  

 
DHCP  
Abbreviation of Dynamic Host Configuration Protocol  
DHCP is a function that automatically sets up IP addresses. This function will allow 
you to avoid having to set up IP addresses on each computer.   

DUN Profile  
A Bluetooth profile for Dial-up Networking.  
This profile enables you to establish a dial-up Bluetooth connection with a wireless 
modem station, mobile telephone, or similar device. 

 



FAX Profile  
A Bluetooth profile that enables you to establish a Bluetooth connection with a 
wireless modem station, mobile telephone, or similar device to send or receive a fax.  

FTP  
Abbreviation of File Transfer Profile.  
A Bluetooth profile that enables you to browse folders on a wireless device and 
transfer files to and from the local device.  

 
GAVDP Profile  
Abbreviation of Generic Audio-Video Distribution Profile. This is a Bluetooth 
profile. 

 
HCRP  
Abbreviation of Hardcopy Cable Replacement Profile. A Bluetooth profile that 
establishes a connection to a device only when you print, unlike SPP (Serial Port 
Profile).  

HID Profile  
Abbreviation of Human Interface Device Profile.  
A Bluetooth profile that enables you to connect to a wireless mouse, keyboard or 
other input device.  

 
LAP  
Abbreviation of LAN Access Profile.  
A Bluetooth profile that enables you to establish a Bluetooth connection to a LAN 
access point to access a LAN via PPP.   

 
OPP  
Abbreviation of Object Push Profile.  
A Bluetooth profile that enables you to exchange business cards with a wireless 
device.  

 
Passkey 
Also known as a PIN code  
This is a password consisting of up to 16 alphanumeric characters that enables a 



connection to be established to a wireless device. You need to know the passkey in 
order to connect to a device that requires authentication.  
Even when the authentication setting has been disabled in the User Mode Properties 
of the Bluetooth Utility, the passkey entry dialog box will appear automatically if 
authentication is required, enabling you to authenticate a device. A link key will be 
created once you have authenticated a device, eliminating the need for a passkey to 
connect to that device in the future. 

Pairing 
A security function. In order for Bluetooth devices to authenticate each other, a 
passkey (PIN code) is entered in each terminal when they are connected for the first 
time, and a secret 128-bit link key is generated. This action is known as "pairing." 

 
SPP  
Abbreviation of Serial Port Profile.  
A Bluetooth profile that enables communication with a device through a virtual 
serial port configured for a Bluetooth connection. This can be used for printers and 
printer adapters with PDAs, using a method different from HCRP or ActiveSync.  

 
TCP/IP  
Abbreviation of Transmission Control Protocol/Internet Protocol.  
Standard communications protocol (convention for enabling data communication) 
used by the Internet. Using the same protocol enables computers to exchange data 
with each other.  

  

 
vCARD  
Common standard for electronic business cards.  
Names, (e)mail addresses, telephone numbers and other information are exchanged 
in the form of electronic business cards (in *.vcf format), allowing all parties to 
easily register each other's data in their address books.  
The standard is extensively compatible with Microsoft Outlook, Lotus Organizer 
and other mail/schedule management software.  

 


